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Distorsión Error de deformación que tienen todas las 

proyecciones cartográficas. 

 

Ecuador  El único círculo máximo perpendicular al eje de la 

Tierra, dividiéndola en los hemisferios norte y sur. 

 

Esferoide Representación sólida obtenida por la rotación de 

una elipse en su eje menor. Debido a la forma 

irregular del planeta, la mejor aproximación es tomar 

el nivel medio de la marea como superficie de partida 

y proyectarlo a toda la superficie de la Tierra. 
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Geoide Superficie donde la dirección de la gravedad es 

perpendicular en todos los lugares y se corresponde 

con el valor de la gravedad que se experimenta en el 

nivel medio del mar. 

 

Gravímetro Instrumento utilizado para obtener la medición de 

diferencias muy pequeñas en la gravedad terrestre, 

mediciones en las variaciones de la fuerza de  

gravedad y detectan anomalías de gravedad que se 

traducen en diferencias de densidad del terreno.  

 

GPS Global Positioning System que significa Sistema de 

Posicionamiento Global, se utiliza para determinar la 

posición con coordenadas de latitud, longitud y 

altura. 

 

Huso Posición geográfica que ocupan todos los puntos 

comprendidos entre dos meridianos. 

 

Mapa temático Mapa que se utiliza para representar diferentes 

aspectos de la vida económica, social, ambiental, la 

historia y otros aspectos de una región, país o 

continente. 

 

Metadatos Datos sobre los datos. Información acerca de los 

datos que describe detalladamente sus 

características en términos de contenido, calidad, 

proyección sistema de coordenadas y forma de 

distribución. 
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Modelo Representación simplificada de la realidad en que 

aparecen algunas de sus propiedades. 

 

Ortorectificación Proceso computacional por el que se eliminan de las 

imágenes las distorsiones horizontales y verticales 

principalmente debidas al relieve, mejorando de 

forma espectacular la calidad y utilidad de la imagen 

porque le otorga las mismas cualidades que posee 

un mapa. 

 

Píxel Elemento bidimensional, normalmente con forma 

cuadrada y que corresponde al tamaño de la mínima 

unidad de información incluida en la imagen, al que 

se le asocia un valor temático y una posición 

espacial. 

 

Resolución Dimensión lineal mínima de la unidad más pequeña 

del espacio geográfico para la que se recogen datos. 

 

Satélite artificial Objetos puestos en órbita alrededor de la Tierra con 

distintos fines, científicos, tecnológicos, militares, 

entre otros. 

 

SEGEPLAN Secretaría General de la Presidencia de Guatemala. 

 

Sensores Instrumentos que transforman la radiación 

electromagnética en información perceptible y 

analizable. 
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RESUMEN 

 

 

 

El trabajo de investigación fue desarrollado con el fin de incentivar al 

estudiante para que se introduzca en el manejo de los Sistemas de Información 

Geográfica por medio de los conceptos básicos, tomando como ejemplo los 

ejercicios desarrollados en el laboratorio de Cartografía Digital dentro del 

programa del curso de Topografía 3. 

 

Cada una de las prácticas descritas tiene la finalidad de conocer y 

familiarizarse con las distintas barras, herramientas y comandos que se utilizan 

en ArcGis para lograr un manejo adecuado de la información digital obteniendo 

los resultados deseados descritos en la solución.  

 

Se determinó que la forma adecuada para el aprendizaje de un software 

es la interacción que el usuario tiene con éste, razón por la que se creó una 

página web de libre acceso, para las personas que estén interesadas en 

descargar las capas de información necesarias para realizar cada una de las 

prácticas, así mismo se presenta el resultado final que el usuario debería 

obtener en formato .mxd, para tener un punto de comparación en caso de 

cometer algún error en el manejo de las herramientas de ArcGis. 

 

Se considera de vital importancia contar con conocimientos generales del 

software ArcGis para las distintas aplicaciones en ingeniería civil, tal es el caso 

de ordenamiento territorial, catastro, medio ambiente, entre otras; muestra de 

ello son las distintas instituciones gubernamentales de Guatemala que utilizan 

esta herramienta para la toma de decisiones, así como para la elaboración de 

planes y proyectos destinados al cumplimiento de distintas políticas nacionales. 
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OBJETIVOS 

 

 

 

General 

 

Proveer al estudiante de conocimientos básicos para el manejo de datos 

espaciales, por medio del software ArcGis versión 9.1, como una herramienta 

de apoyo para actividades laborales. 

 

Específicos 

 

1. Servir como referencia para estudiantes del Laboratorio de Cartografía 

Digital del curso de Topografía 3. 

 

2. Brindar conocimientos sobre el proceso de la captura, almacenamiento, 

procesamiento y recuperación de la información utilizando Sistemas de 

Información Geográfica. 

 

3. Considerar la relevancia del conocimiento de Sistemas de Información 

Geográfica en lo concerniente a catastro, medio ambiente y 

ordenamiento territorial. 

 

4. Interactuar el software-usuario de manera flexible a fin de contribuir en el 

aprendizaje, así como en la gestión de diversas actividades y la 

correspondiente toma de decisiones. 

 

5. Adquirir experiencia práctica en el manejo de software de Sistema de 

Información Geográfica. 
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6. Introducir al estudiante en los conceptos de sociedad de la información, 

gobierno electrónico, infraestructura de datos espaciales y tecnologías de 

la información geográfica e introducción a teledetección por información 

satelital. 
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INTRODUCCIÓN 

 

 

 

La importancia de estar al tanto de los conceptos generales relacionados 

con Sistemas de Información Geográfica, previo al manejo de un software 

específico, está basada en la importancia del aprendizaje que el estudiante 

universitario o profesional tiene en conocer las tecnologías modernas que 

permiten almacenar y manipular información con el interés de contribuir a la 

toma de mejores decisiones aplicadas en la rama de ingeniería civil. 

 

Las fotografías aéreas y las imágenes de satélite son herramientas que se 

utilizan para el estudio de la superficie terrestre; ambas se corrigen por medio 

de diversos procesos para cumplir con especificaciones geométricas y 

geográficas necesarias para mostrar información cartográfica. De estos 

procedimientos resultan imágenes satélite corregidas y ortofotos digitales que 

tienen innumerables aplicaciones. 

 

Los Sistemas de Información Geográfica tienen un rango de aplicación 

muy amplio, lo que permite que se utilicen en distintas instituciones 

gubernamentales del país. Su importancia radica en contar con una herramienta 

que permite la recolección, análisis, almacenamiento, transformación y 

visualización de la información geográfica, con el fin de permitir desarrollar con 

mayor facilidad la toma de decisiones que se presenten, con el fin de focalizar 

esfuerzos y realizar inversiones efectivas. Algunas instituciones que utilizan 

estos sistemas en Guatemala son el IGN, la CONRED, el MAGA, el 

INSIVUMEH, entre otros. 
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ArcGis 9.1 está conformado por aplicaciones como ArcMap, ArcCatalog y 

ArcToolbox; aunque es en la primera en la que se realizaron la mayor parte de 

los ejercicios contenidos en el presente trabajo, se hace necesario detallar las 

distintas funciones que desempeñan las tres aplicaciones y sus respectivas 

interfaces.  

 

Con la presente investigación se pretende brindar una herramienta útil, 

tanto teórica como práctica, complementada con acceso a la información digital 

necesaria por medio de una página web creada con ese fin, para realizar de 

forma asistida los ejercicios resueltos paso a paso, identificando y analizando 

cada uno de los procesos asociados a las distintas operaciones que se llevan a 

cabo habitualmente con el software ArcGis 9.1 y versiones posteriores.
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1.  CARTOGRAFÍA DIGITAL, CONCEPTOS BÁSICOS 

 

 

 

La cartografía digital se ha desarrollado por medio de la tecnología y se 

refiere a los mapas automatizados y almacenados de forma digital, a diferencia 

de la cartografía que se realizaba en los tradicionales mapas de papel. Un 

Sistema de Información Geográfica (SIG) se diferencia de la cartografía digital 

por las características de análisis que facilita el procesamiento de datos en éste, 

de forma que pueda generarse nueva información a partir de la cartografía 

digital y modernizarla con el fin de obtener un mapa para toma de decisiones 

sobre un territorio. 

 

1.1. Topografía 

 

Es la ciencia y la técnica de realizar mediciones de ángulos y distancias en 

extensiones de terreno reducidas lo suficiente como para poder despreciar el 

efecto de la curvatura terrestre, para después procesarlas y obtener así 

coordenadas de puntos, direcciones, elevaciones, áreas o volúmenes, en forma 

gráfica y/o numérica, según los requerimientos del trabajo. 

 

1.2. Ciencias afines 

 

Las distintas aplicaciones de la topografía están presentes en la mayoría 

de las actividades humanas que requieren tener conocimiento de la superficie 

del terreno, como por ejemplo, en la realización de distintas obras civiles, en el 

catastro, y en otros campos. La topografía constituye un elemento 

indispensable, pues comparte métodos e instrumentos con otras ciencias y 
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también cuenta con los propios, teniendo las ciencias afines  objetivos similares 

o complementarios a los de la topografía. 

 

La aplicación racional de los métodos topográficos y el empleo de los 

instrumentos topográficos deben permitir cubrir los objetivos de esta ciencia que 

es facilitar al ingeniero y a la sociedad la base cartográfica para la elaboración 

de cualquier proyecto, con errores que no superen en ningún momento las 

tolerancias fijadas. 

 

1.2.1. Fotogrametría, cartografía, geodesia 

 

Estas ciencias están directamente relacionadas con la topografía. La 

cartografía representa parte de la superficie terrestre por medio de un mapa, la 

fotogrametría obtiene medidas a partir de imágenes fotográficas y la geodesia 

se preocupa de la forma y dimensiones de la Tierra. 

 

 Cartografía  

 

Esta ciencia proporciona los métodos y los criterios para representar la 

superficie terrestre, o una parte de ella, en un mapa. El elipsoide de revolución 

no es una superficie desarrollable, por lo que se hace necesaria una 

transformación para poder representarlo en una superficie plana.  

 

 Fotogrametría 

 

Es la ciencia que se ocupa de la obtención de medidas sobre la forma, 

dimensiones y posición de los objetos, a partir de imágenes fotográficas de los 

mismos. Ambas ciencias no son antagónicas, sino más bien complementarias. 

La fotogrametría libera a la topografía de algunas de sus tareas más tediosas y 



3 
 

la topografía, por su parte, proporciona a la fotogrametría un apoyo 

imprescindible para el desarrollo de sus trabajos. 

 

 Geodesia 

 

Se ocupa de la forma y dimensiones de la Tierra. La forma real de la 

superficie terrestre, que no es una figura regular, se sustituye por un elipsoide 

de revolución. 

 

El límite de actuación de la topografía, o frontera entre esta y la geodesia, 

será aquella dimensión para la cual los errores debidos a la simplificación 

consisten en no considerar la curvatura terrestre. La topografía opera sobre 

porciones pequeñas de terreno, no teniendo en cuenta la verdadera forma de la 

Tierra, sino considerando la superficie terrestre como plana.  

 

Cuando se trata de medir grandes extensiones de tierra, como por 

ejemplo, para confeccionar el mapa de un país, de un departamento o de una 

ciudad grande, no se puede aceptar la aproximación que da la topografía, 

teniéndose entonces que considerar la verdadera forma de la Tierra y por 

consiguiente su superficie ya no se considera plana sino se toma como parte de 

la superficie de un elipsoide y se acude a la geodesia. 

 

1.3. Mapas 

 

El mapa es el lenguaje gráfico de la geografía y es una representación 

plana de la superficie terrestre o de una parte de ella cuya gran extensión 

requiere el empleo de métodos cartográficos, ya que se debe tener en cuenta la 

curvatura terrestre.  
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Se utilizan para representar espacialmente fenómenos concretos o 

abstractos localizables en el espacio y los análisis, como por ejemplo resultados 

de los estudios que combinan hechos y fenómenos ambientales, sociales y 

económicos. Deben ser claros y precisos para que le permita al usuario su 

lectura por medio de sus elementos explicativos como la escala, las 

coordenadas o red de paralelos y meridianos, y la simbología. Los mapas 

tienen dos funciones: 

 

 Localizar hechos, cosas y fenómenos. 

 Representar informaciones cuantitativas, ordenadas y cualitativas, de ese 

modo, los documentos pueden generar razonamientos, sugiriendo y 

respondiendo diversas preguntas. 

 

Los mapas son de diversos tipos de acuerdo a su contenido: 

 

 Especiales o temáticos: cuando representan fenómenos especiales, se 

ocupan de un único tema, aunque cada uno de ellos puede mostrar 

varias subcategorías del tema en cuestión; por ejemplo, tipo de suelos, 

población, uso de los suelos y toda aquella temática que sea objeto de 

estudio de la geografía. 

 

 Generales: cuando se representan diversos tipos de fenómenos; por 

ejemplo, físicos, políticos, económicos, entre otros. 

 

 Topográficos: cuando su función principal es identificar las características 

de la Tierra lo más fielmente posible dentro de los límites que impone la 

escala escogida. Son los productos típicos de la mayoría de los 

organismos nacionales de cartografía, y normalmente se producen en 
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series consistentes en todas las láminas necesarias para cubrir una 

región a una determinada escala. 

 

1.3.1. Características de los mapas 

 

Las características de un mapa no dependen de su tipo, debido a que la 

representación cartográfica es uniforme para todos los mapas y las principales 

se enlistan a continuación. 

 

1.3.1.1. Sistemas de coordenadas 

 

El movimiento de rotación de la Tierra girando sobre su propio eje 

proporciona dos puntos naturales que son los polos, y es sobre estos puntos en 

los que se basan los sistemas de coordenadas.  Estos sistemas son redes de 

líneas entrelazadas llamadas retículas, rotuladas sobre el globo, para permitir la 

ubicación precisa de rasgos de la superficie.  

 

Existen dos tipos de sistemas de coordenadas de uso general para la 

cartografía, un sistema de coordenadas rectangulares planas y un sistema de 

coordenadas geográficas. 

 

1.3.1.1.1. Coordenadas rectangulares 

planas 

 

Es un sistema constituido por una serie de líneas rectas verticales y 

horizontales denominadas ordenadas y abscisas, respectivamente. La unidad 

de medida se determina mediante el sistema métrico decimal y los valores de 

los ejes se utilizan como sistemas de tipo local en mapas de escala grande 

debido a su gran precisión para ubicar puntos.  
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 Coordenadas UTM 

 

El sistema de coordenadas Universal Transversal de Mercator (UTM) es 

un sistema internacional que proporciona zonas de retículas rectangulares entre 

las latitudes 80 grados sur y 80 grados norte. Consiste en 60 zonas 

rectangulares denominadas husos y es indispensable indicar a que zona UTM 

pertenece el punto a ubicar, ya que hay 60 sitios en la Tierra, que tienen 

coordenadas X y Y UTM similares, uno por cada zona. Su distribución se 

muestra en la figura 1.  

 

Figura 1. Distribución de las zonas del sistema de coordenadas UTM  

   en todo  el mundo 

 

 

 

Fuente: BOTELLALA, Albert; MUÑOZ, Anna. Introducción a los sistemas de información  

                     geográfica y geo telemática. p. 52. 
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Cada huso o zona es de 6 grados de longitud y en cada uno se genera un 

meridiano central equidistante 3 grados de longitud de los extremos de cada 

huso. El origen (0 grados) de la cuadrícula es la intersección entre el meridiano 

central y el Ecuador ambos en línea recta.  

 

Cada zona UTM está dividida en 20 bandas, desde la C hasta la X. Las 

bandas C a M están en el hemisferio sur y las bandas N a X están en el 

hemisferio norte. Las primeras 19 bandas (C a W) tienen una altura de 8 grados 

cada una y la banda 20 (banda X)  tiene una altura de 12 grados. Las 

coordenadas UTM tienen el siguiente formato: 

 

X = 560,12 Y = 5 604,15 

 

o Coordenada X: se mide a partir del Meridiano Central (MC) de 

cada zona UTM, al cual se le asigna el valor de 500 000. Hacia el 

este del MC, a la distancia medida a partir de dicho meridiano, se 

le suman 500 000, y hacia el oeste, a la distancia medida a partir 

de dicho meridiano, se le resta el valor 500 000. Por lo que hacia 

el este del MC, los valores de X son mayores a 500 000, y hacia el 

oeste del MC, los valores son menores a 500 000. 

 

o Coordenada Y: se mide en metros a partir del Ecuador. Hacia el 

norte, se mide de forma directa a partir de 0, y hacia el sur, el valor 

origen en el Ecuador es 10 000 000 y se le va restando. 

 

 Coordenadas GTM 

 

El territorio guatemalteco está ubicado en dos zonas UTM, la 15 norte y la 

16 norte, razón por la cual se creó una proyección única para Guatemala, 
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Guatemala Transverse Mercator (GTM) en donde el territorio nacional se 

encuentra ubicado dentro de una sola zona. La proyección GTM es una 

adaptación de la proyección UTM en la cual se modificó únicamente el origen 

de las coordenadas X (meridiano central) y el factor de escala en el mismo 

meridiano, de manera que se mejore la precisión para todo tipo de 

levantamientos topográficos, geodésicos, catastrales así como para toda la 

cartografía en general.  

 

En 1998, salió la primera normativa del IGN regulando el uso interno de la 

proyección GTM, sin embargo su difusión ha sido más lenta que el crecimiento 

de producción de información geográfica. La norma COGUANOR NTG 211001 

fija los parámetros del sistema de referencia de coordenadas planas oficial 

Guatemala Transversa Mercator (GTM), con base en los requerimientos de la 

norma internacional ISO19111:2007(E). En la tabla I se presentan los 

parámetros que definen la proyección GTM. 

 

Tabla I. Parámetros que definen la proyección Guatemala Transversa 

  de Mercator 

 

Nombre del Elemento Entrada Comentario 

Código de la clase del 
sistema dereferencia de 

coordenadas 
 

1 

El número 1 se refiere a un 
sistema de referenciade 

coordenadas contodos los 
datos dedefinición dados 

alcompleto 

Identificador del sistema 
dereferencia de 

coordenadas 
GTM  

Identificador del Datum WGS84  

Tipo de Datum Geodésico  

Punto de Anclaje del 
Datum 

Centro de la Tierra  

Notas sobre el Datum   

Identificador del Elipsoide WGS84  
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Continuación de la tabla I. 

Semieje mayor del 
elipsoide 

6 378 137,0 m  

Forma del elipsoide Verdadera  

Achatamiento 1/298,257223563  

Identificador del sistema de 
Coordenadas 

Mercator 
Transverso 

 

Tipo del sistema de 
coordenadas 

Proyectadas  

Dimensión del sistema de 
coordenadas 

2  

Nombre del eje del sistema 
de coordenadas 

N 

Estos parámetros se 
refieren al valor y de las 

coordenadas proyectadas 
 

Dirección del eje del 
sistema de coordenadas 

Norte 

Identificador de unidades 
del eje del sistema de 

coordenadas 
M 

Nombre del eje del sistema 
de Coordenadas 

E 

Estos parámetros se 
refieren al valor x de las 

coordenadas proyectadas 
 

Dirección del eje del 
sistema de coordenadas 

Este 

Identificador de unidades 
del eje del sistema de 

coordenadas 
M 

Identificador de la 
operación de coordenadas 

Mercator 
Transversa 

 

Número de parámetros del 
método de operación de 

coordenadas 
5 

Estos parámetros son los 
valores que se deben usar 
para definir la proyección 

GTM en los distintos 
programas de cálculo 

usados para la 
transformación. 

 

1 
Nombre del parámetro de 
operación de coordenadas 

de coordenadas 

Latitud de origen 
 

Valor del parámetro de 
operación 

0 grados 
 

2 
Nombre del parámetro de 
operación de coordenadas 

Longitud de Origen 

Valor del parámetro de 
operación de coordenadas 

-90,5 grados 
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Continuación de la tabla I. 

 
3 

Nombre del parámetro de 
operación de coordenadas 

 
Factor de escala 
en el meridiano 

central 

Estos parámetros son los 
valores que se deben usar 
para definir la proyección 

GTM en los distintos 
programas de cálculo usados 

para la transformación. 
 

Valor del parámetro de 
operación de coordenadas 

0,9998 

4 
Nombre del parámetro de 
operación de coordenadas 

Falso norte 
 

Valor del parámetro de 
operación de coordenadas 

0 metros 
 

5 
Nombre del parámetro de 
operación de coordenadas 

Falso este 
 

Valor del parámetro de 
operación de coordenadas 

500000 metros 
 

 

Fuente: COGUANOR NTG 211001, Norma nacional para sistemas de proyección para  

        información geoespacial para Guatemala GTM. p. 6. 

 

1.3.1.1.2. Coordenadas geográficas 

 

Es un sistema que representa la ubicación de cualquier punto sobre la 

superficie de la Tierra con base en un par de coordenadas representadas en 

medidas angulares, latitud y longitud, como se muestra en la figura 2.  
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Figura 2. Sistema tridimensional de coordenadas geográficas 

 

 

 

Fuente: FERNÁNDEZ, Ignacio. Las Coordenadas Geográficas y la proyección UTM. p. 10. 

 

Las coordenadas geográficas se expresan en grados sexagesimales y 

tienen el siguiente formato: 

 

3º14‟26” W 42º52‟21”N 

 

 Meridianos: son las líneas de intersección con la superficie terrestre, de 

los infinitos planos que contienen el eje de la Tierra. El origen del sistema 

es un meridiano denominado meridiano 0 grados o meridiano de 

Greenwich, denominado así por la ciudad de Inglaterra por la que pasa. 

El meridiano de Greenwich divide el globo terráqueo en dos zonas, la 

situada al oeste (W) del meridiano hasta el antemeridiano y la situada al 

este (E) del meridiano hasta el antemeridiano. 

 

 Paralelos: son las líneas de intersección de los infinitos planos 

perpendiculares al eje terrestre con la superficie de la Tierra. El paralelo 
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principal es el que se encuentra a la máxima distancia del centro de la 

Tierra, es decir, el que tiene mayor radio y se le llama Ecuador. 

 

Cuando se define la red de meridianos y paralelos, la situación geográfica 

de un punto está definida por la latitud y longitud respectiva para ese punto, con 

referencia a la red creada. 

 

 Latitud: la latitud (β) de un punto P es la magnitud representada por el 

ángulo formado por la línea del Ecuador y la línea vertical que pasa sobre 

el meridiano del punto que se va a medir, como se muestra en la figura 3.  

La latitud presenta un mínimo posible de 0 grados hasta un máximo de 

90 grados. Estos últimos coinciden con los polos norte y sur (0 a 90 

grados norte, 0 a 90 grados sur). 

 

Figura 3. Latitud de un punto P 

 

 

 

Fuente: FERNÁNDEZ, Ignacio. Las Coordenadas Geográficas y la proyección UTM. p 10. 

 

 Longitud: la longitud (λ) de un punto P es la magnitud representada por el 

ángulo que se forma entre el plano meridiano que pasa por el punto P y 
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el meridiano de Greenwich, como se muestra en la figura 4. Se le 

designa oeste (W) cuando está a la izquierda del meridiano de 

Greenwich y este (E) cuando está a la derecha del meridiano de 

Greenwich. La latitud presenta un mínimo posible de 0 grados hasta un 

máximo de 180 grados (0 a 180 grados este, 0 a 180 grados oeste). 

 

Figura 4. Longitud de un punto P 

 

 

 

Fuente: FERNÁNDEZ, Ignacio. Las Coordenadas Geográficas y la proyección UTM. p 10. 

 

La Tierra se puede considerar de volumen esférico  no uniforme, aunque 

se puede aproximar a una figura geométrica, a la que se denomina 

Geoide,  para su mejor concepción se intenta adaptar a una figura más 

uniforme como es la de un  elipsoide. Dependiendo del elipsoide de referencia 

escogido, el sistema de coordenadas geográficas varía para un mismo punto 

terrestre,  ya que el tamaño y  el  centro de origen de cada uno de ellos no son 

coincidentes. 
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1.3.1.2. Elipsoide de referencia 

 

Es una representación de tipo matemática de la forma de la Tierra como 

producto de la rotación alrededor de su eje menor, lo más aproximado posible al 

Geoide, usado como dato de comparación en levantamientos geodésicos del 

globo terrestre. Los parámetros mínimos para definir un elipsoide son: 

 

 Radio ecuatorial = a 

 Radio polar = b 

 Achatamiento = f = (a - b)/a  

 

En la tabla II se muestran los parámetros de los elipsoides de referencia 

más comunes. 

 

Tabla II. Parámetros de algunos elipsoides de referencia 

 

Elipsoide A F 

Clarke 1866 6 378 206,40 294,978698200 

GRS80 6 378 137,00 298,257222101 

Internacional o de 
Hayford 

6 378 388,00 297,000000000 

WGS84 6 378 137,00 298,257223563 

 

Fuente: QUIRÓS, Manuel. Tecnologías de la Información Geográfica (TIG). p. 52. 

 

El GRS80 (Geodetic Reference System, 1980) fue adoptado por la 

International Union of Geodesy and Geophysics - IUGG - en 1980; se usa en el 

sistema NAD83, pensado para reemplazar al NAD27. Este mismo elipsoide, 

diseñado como geocéntrico con datos de satélite y datos de campo, con 

pequeñas modificaciones sirve de base para el sistema WGS84 que utiliza el 
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sistema GPS desarrollado y mantenido por las mismas agencias militares de 

Estados Unidos. 

 

1.3.1.3. Datum 

 

El datum está dado por un elipsoide de referencia y por un punto 

fundamental, como se observa en la figura 5, en el que se establece la 

condición de tangencia entre el geoide y el elipsoide, permitiendo fijar un punto 

en un espacio tridimensional. 

 

Figura 5. Elementos que conforman un datum geodésico: el elipsoide  

  y el punto fundamental 

 

 

 

Fuente: BOTELLALA, Albert; MUÑOZ, Anna. Introducción a los sistemas de información  

         geográfica y geo telemática. p. 52. 

 

Algunos Datums se describen a continuación: 

 

 ED50 (European Datum 1950): este sistema se definió en 1950, el 

elipsoide de referencia es el Internacional o de Hayford y el punto 
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fundamental es la Torre de Helmert situada en las inmediaciones del 

observatorio astronómico de Postdam, Alemania. Su área de influencia 

es Europa. 

 

 NAD27 (North American Datum 1927): el punto inicial de este datum, se 

localiza en Meades Ranch, Kansas, con base en el elipsoide Clarke 

1866. Datum al que estaban referenciados todos los puntos 

pertenecientes a los levantamientos geodésicos horizontales los países 

de Norteamérica. 

 

 NAD83 (North American Datum 1983): definición del NAD27 en un 

Sistema Geodésico de Referencia (SGR) global basado en el elipsoide 

GRS80. 

 

 WGS60, WGS66 y WGS72 (World Geodetic System 1960, 1966 y 1972): 

el departamento de defensa estadounidense produjo estos sistemas 

debido ala necesidad de encontrar un sistema de referencia único para 

todo el globo para crear una aproximación medianamente buena para 

cada parte; se culminó con la creación del WGS84. 

 

 WGS84 (World Geodetic System 1984): Datum universal con cobertura 

en toda la superficie terrestre, evitando la territorialidad del resto de 

datums existentes, basado en el elipsoide WGS84. 

 

1.3.1.4. Escala 

 

La escala de un mapa indica la relación matemática entre la distancia en 

el documento cartográfico y la medida real representada, es la proporción 

indispensable para comprender cómo una superficie mayor puede 
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representarse en una hoja de papel. La mención de la escala en un mapa es 

obligatoria y cada mapa está hecho a una escala determinada que permite 

conocer la distancia real entre distintos puntos del terreno realizando las 

medidas sobre el mapa.  

 

La escala numérica es una fracción donde el numerador representa una 

distancia medida en el mapa y el denominador la misma distancia en el terreno: 

 

 

 

Normalmente tiene la apariencia de 1:50 000 o 1/50 000 que, en este 

caso, quiere decir que 50 000 unidades de la realidad están representadas en el 

mapa como una unidad.   

 

La escala gráfica es un pequeño dibujo lineal, semejante a una regla 

graduada, con la equivalencia en metros o kilómetros de la realidad, se utiliza 

como complemento de la escala numérica. La importancia de la escala gráfica 

es por la facilidad para hallar la equivalencia de lo representado en el mapa y su 

correspondiente valor en la realidad. La relación de la escala gráfica con la 

numérica se observa en la figura 6. 
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Figura 6. Escala gráfica y numérica 

 

 

 

Fuente: MENDIETA, Jorge; VALENCIA, Ramón. Cartografía básica aplicada. p. 19. 

 

Los mapas se pueden dividir según su escala, como se muestra en la 

tabla III y haciendo la precisión siguiente: 

 

 Escala pequeña, los menores de 1:100 000 

 Escala intermedia, comprendidos entre 1:100 000 y 1:20 000 

 Escalas grandes, los mayores a 1:20 000 (números inferiores a 20 000) 

 

Tabla III. Algunas escalas y su precisión 

 

Escalas 
Precisión lograda 

(en metros) 

Escalas grandes 

1:50 0,0125 

1:100 0,025 

1:200 0,050 

1:500 0,125 

1:1 000 0,250 

Escalas intermedias 

1:2 000 0,500 

1:2 500 0,625 

1:4 000 1,000 
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Continuación de la tabla III. 

Escalas intermedias 
1:5 000 1,250 

1:10 000 2,500 

Escalas pequeñas 
1:20 000 5,000 

1:25 000 6,250 

 

Fuente: CASANOVA, Leonardo.Presentación de planos. p. 83. 

 

1.3.1.5. Georeferencia 

 

Es una técnica geográfica, que  consiste en la ubicación de objetos en 

espacios de coordenadas, es decir, dotar de coordenadas un mapa escaneado, 

una ortofotografía digital o una capa raster mal georeferenciada.  

 

Estas coordenadas geográficas reemplazarán a las coordenadas gráficas 

propias de una imagen digital en cada píxel, sin alterar ningún otro atributo de la 

imagen original, cada  serie de píxeles serán fácilmente reconocibles, en ambas 

imágenes  y pueden tener un origen  antrópico (cruces de carreteras, caminos, 

construcciones, vértices geodésicos), o naturales normalmente de carácter 

fisiográficos y topográficos, y que no sean demasiado  dinámicos en el espacio 

ni en el tiempo, por ejemplo, desembocaduras de ríos, línea de costa,  entre 

otros. 

 

 El nivel de precisión alcanzado en la georeferencia depende en gran 

medida de la fuente de información geográfica utilizada (mapas temáticos, 

cartografía oficial, puntos de GPS, entre otros) y de la escala a la cual se vaya a 

realizar el trabajo. Como regla general de precisión se puede decir que el error 

medio cuadrático de los puntos debe ser inferior a tres.  
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1.4. Plano 

 

Es una representación cartográfica a gran escala de todos los elementos 

que plantea un proyecto como los planos de una ciudad, de una vivienda, 

topográficos, de localización, entre otros. El plano, a diferencia del mapa no 

requiere el uso de proyecciones cartográficas debido a que la superficie 

representada es lo suficientemente pequeña como para considerar la curvatura 

de la Tierra. Cabe señalar que en los planos de localización si es importante 

colocar la proyección. 

 

1.4.1. Características de los planos 

 

Cualquier persona que desee trabajar con un plano, debe tener la 

capacidad de tomar de él cualquier tipo de información necesaria mediante la 

medición directa o analíticamente. Para lograr esto es importante que un plano 

contenga los siguientes elementos: 

 

 Símbolo del norte: es indispensable, se recomienda que se coloque en 

un lugar visible.  

 

 Leyenda: se utilizan los símbolos convencionales y la descripción de los 

mismos para representar las características más importantes de lo 

contenido en el plano. 

 

 Recuadro de identificación: conocido como cajetín, se coloca en la 

esquina inferior derecha y brinda información de quien realiza el proyecto 

y del contenido o información del trabajo. Debe contener lo siguiente: 
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o Número de plano: todos los planos de un proyecto deben tener 

una numeración distinta y consecutiva. 

 

o Título del proyecto: debe ser el mismo para todos los planos. 

 

o Título del plano: título del contenido cartográfico existente en el 

plano que identifica a todo el contenido.  

 

o Nombre de la persona o institución que encarga el proyecto o 

estudio. 

 

o Fecha de realización. 

 

o Escala numérica: escala que relaciona las magnitudes existentes 

en el plano y las existentes en la realidad. 

 

 Recuadro para modificaciones: destinado para dejar registro de las 

correcciones o modificaciones de los dibujos. 

 

 Formato de la hoja: es el recuadro dentro del cual se realiza el mapa. El 

tamaño de la hoja está normalizado por diferentes organismos 

internacionales como DIN de la Deutsche Industrie-Normen (Normas 

Industriales Alemanas) o la International Standars Organization ISO. 

Algunos tamaños de hoja se muestran en la tabla IV. 
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Tabla IV. Tamaños normales de papel según Normas ISO 

 

Denominación 
Longitud de papel 

(mm) 
Longitud del borde 

(mm) 

A4 210 x 297 195 x 282 

A3 297 x 420 277 x 400 

A2 420 x 594 400 x 574 

A1 594 x 841 574 x 821 

A0 841 x 1189 811 x 1159 
 

Fuente: CASANOVA, Leonardo.Presentación de planos. p. 83. 
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2.  MATERIAL CARTOGRÁFICO 

 

 

 

2.1. Fotografía aérea 

 

Es una fotografía tomada desde un vehículo en el aire, ya sea que éste se 

encuentre en movimiento o no, por ejemplo un avión o un globo, 

respectivamente, en vez de satélites. Es utilizada para extraer información y 

conocer los usos del terreno y en este tipo de fotografías se puede calcular la 

escala pues está tomada a una distancia determinada.   

 

Cuando la fotografía es tomada desde un avión, este tiene que tomar un 

rumbo calculado y predeterminado que por lo general debe ser a lo largo de las 

líneas longitudinales o latitudinales del sistema de coordenadas. Las ventajas y 

desventajas del uso de las fotografías aéreas se muestran en la tabla V. 

 

Tabla V. Ventajas y desventajas del uso de las fotografías aéreas 

 

Uso de las fotografías aéreas 

Ventajas Desventajas 

Proporcionan una perspectiva total y 
exacta de un área, incluyendo la 
topografía y la ubicación de ríos, 

cadenas de montañas, los diferentes 
usos de suelo y otras características 

naturales y artificiales del terreno. 

Son más difíciles y costosas de 
obtener. 

Pueden ser muy antiguas 
Requieren de capacitación para 
comprenderlas e interpretarlas 

Pueden estar distorsionadas por los 
bordes debido al lente de la cámara, 
aunque los equipos modernos suelen 

corregir esta distorsión. 
 

Fuente: STOCKDALE, M.C. y CORBETT, J.M.S. Inventario forestal participativo, manual de  

                 campo. p. 279. 
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2.2. Ortofoto 

 

Es una imagen fotográfica de una zona de la superficie terrestre, generada 

del proceso de ortorectificar la fotografía aérea, es decir, corregir digitalmente 

sus deformaciones geométricas, tales como el desplazamiento por relieve, 

consecuencia de lo producido por las distintas escalas, inclinación de la cámara 

aérea y distorsión de la lente, la altura de la toma, la velocidad a la que se 

mueve la cámara, entre otros, con el objeto de llevar la imagen a una 

proyección ortogonal libre de errores, y en la que es posible realizar mediciones 

precisas utilizando un plano de referencia local. 

 

Para la elaboración de una ortofoto es necesario seguir un flujo de trabajo 

que comienza con la obtención de las fotografías seguido de los procesos de 

fotocontrol, aerotriangulación, restitución, correlación, generación y edición del 

modelo digital de terreno, ortorectificación y edición de las mismas.  

 

Al utilizar una ortofoto es posible obtener las características métricas de un 

mapa y se utiliza como una herramienta bastante útil para desarrollar trabajos 

de ingeniería, planeación, censos agropecuarios, de población, catastro, entre 

otros, debido a que la ortofoto se obtiene de una forma más rápida y económica 

en comparación a un mapa convencional y permiten fácilmente su procesado 

informático y su posterior almacenamiento en una base de datos gráfica. 

 

Se pueden obtener ortofotos por dos técnicas: 

 

 Fotogrametría digital: ortofoto digital (en la tabla VI se establecen los 

valores mínimos que deben caracterizar las ortofotos digitales). 

 

 Rectificación diferencial: ortofotos analógicos. 
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Tabla VI. Especificaciones técnicas de las ortofotos digitales 

 

Escala de 
la 

fotografía 

Tamaño 
del píxel 

(m) 

Escala de 
ortofotos 

Tamaño 
del píxel 

(m) 

Precisión 
horizontal 

(m) 

Precisión 
vertical 

(m) 

1:5 000 0,07 1:1 000 0,10 0,30 0,25 

1:10 000 0,14 1:2 000 0,20 0,60 0,50 

1:20 000 0,28 1:2 500 0,25 0,80 0,60 

1:30 000 0,42 1:5 000 0,50 1,50 1,25 

1:60 000 0,84 1:10 000 1,00 3,00 2,50 

1:60 000 0,84 1:20 000 1,00 6,00 2,50 

1:60 000 0,84 1:25 000 1,00 7,50 5,00 

1:60 000 0,84 1:50 000 1,00     15,00     10,00 
 

Fuente: Norma técnica NTG-014-2006. Ortofotos digitales. p. 9. 

 

La precisión de una ortofoto depende de la calidad de los insumos, 

comenzando por la calidad de las fotografías aéreas y de los resultados del 

proceso de aerotriangulación, un buen modelo digital de terreno permite mejorar 

las ortorectificaciones para llevar los elementos desplazados a su verdadera 

posición, este proceso se realiza utilizando ya sea modelo digital de terreno 

(DTM), de elevaciones (DEM), de superficie (MDS) o modelo digital de edificios 

(MDEd); el cual se utiliza para elaborar una ortofoto verdadera. Las ortofotos 

pueden ser de cuatro órdenes distintos: 

 

 Primer orden (ortofoto verdadera): se obtiene con base en un modelo 

digital de la superficie verdadera del terreno más el MDEd. Se corrigen 

adicionalmente la situación de los objetos que sobresalen de la superficie 

del terreno (edificios, puentes, vegetación y otros), brinda información 

más completa, desde el punto de vista del paisaje, que la obtenida con 

cartografía convencional. Los edificios conservan una proyección 

perfectamente ortogonal. 
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 Segundo orden (elaborada con base en un DTM): la proyección de los 

elementos sobresalientes del suelo no se logra corregir completamente. 

Debido a ello los edificios presentan distorsiones y se mueven de su 

localización verdadera. Adicionalmente se presentan ocultamientos de 

zonas que dificultan la superposición de información vectorial con 

propósitos de actualización cartográfica y/o aplicaciones catastrales.  

 

 Tercer orden (ortofoto preliminar): ortofoto generada a partir de un MDS 

obtenido por procesos de correlación automática, al cual se le realiza una 

edición general. No es adecuada para realizar mediciones confiables de 

las dimensiones y orientación de los objetos. Sin embargo se puede 

utilizar para medir elementos o detalles que no requieran precisiones o 

estimar áreas de estudios globales. 

 

 Cuarto orden (ortofoto express): generada utilizando un MDS obtenido 

por procesos de correlación automática. En zonas de relieve montañoso 

o quebrado se presentan grandes deformaciones. Esta ortofoto permite 

realizar análisis visuales generales, no se recomienda realizar 

mediciones de dimensiones de objetos, ni áreas.Los usos adecuados 

según el orden de la ortofoto se describen en el anexo. 

 

2.3. Imagen satélite 

 

Es la representación visual de la información capturada por un sensor 

montado en un satélite artificial y es con frecuencia el medio más práctico para 

adquirir información geográfica aprovechable. Es proporcionada en formato 

digital y se utiliza como fuente básica de información en la creación de mapas 

temáticos, en la realización de estudios medioambientales, entre otras 

http://es.wikipedia.org/wiki/Sensor
http://es.wikipedia.org/wiki/Sat%C3%A9lite_artificial
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aplicaciones. Las principales ventajas de las imágenes de satélite son las 

siguientes: 

 

 Para zonas extensas resultan normalmente más económicas que la 

fotografía aérea. 

 

 Pueden abarcar áreas más grandes dentro de cada imagen que una 

fotografía aérea, utilizando la misma resolución de imagen. 

 

 Casi todas las imágenes procedentes de satélite se adquieren 

digitalmente, con una preparación mínima, las imágenes quedan listas 

para ser cargadas directamente y utilizadas inmediatamente con su 

sistema SIG. 

 

 Son más confiables para la medición de áreas, porque por la altura en 

que se toma la foto, las distorsiones horizontales son menores. 

 

 Raramente tardan más de una semana en adquirir imágenes de la zona 

que le interesa. 

 

2.4. Teledetección o percepción remota 

 

Es una técnica por medio de la cual se obtiene información útil de un 

objeto, área o fenómeno, a través del análisis e interpretación de datos de 

imágenes adquiridas por un equipo que no está en contacto físico con el objeto, 

área o fenómeno bajo investigación. Las tres formas de adquirir información a 

partir de un sensor remoto son por reflexión, por emisión y por emisión-

reflexión. 
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Figura 7. Componentes de un sistema de teledetección 

 

 

 

Fuente: Instituto Geográfico Agustín Codazzi. Mejora de los sistemas de cartografía del territorio  

             colombiano. p. 7. 

 

Un sistema de teledetección está compuesto por los siguientes elementos 

que se muestran en la figura 7: 

 

 a - Fuente de energía: es el emisor de la radiación electromagnética que 

llegara a la superficie terrestre y que posteriormente será detectada por 

el sensor. Puede ser el sol (como fuente natural) o el mismo sensor 

(como fuente artificial). 
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 b - Cubierta terrestre: formada por distintas masas de vegetación, suelo, 

agua o infraestructura. Esta recibe la radiación electromagnética 

proveniente de la fuente de energía (a), y la refleja o emite de acuerdo a 

sus características físicas. 

 

 c - Sistema sensor: constituido por el sensor mismo y la plataforma que 

lo sustenta. El sistema tiene como función captar la energía emitida por 

la cubierta terrestre, codificarla y grabarla o enviarla directamente al 

sistema de recepción. 

 

 d - Sistema de recepción y comercialización: este sistema recibe la 

información transmitida por la plataforma y la guarda en un formato 

específico y apropiado. Posterior a las correcciones necesarias, se 

distribuye a los interesados. 

 

 e - Intérprete o analista: es la persona encargada de clasificar y analizar 

la información contenida en la imagen para generar información temática. 

 

 f - Usuario final: es quien finalmente recibirá y utilizará la información ya 

procesada por el analista para fines específicos. 

 

Algunos ejemplos de aplicaciones de teledetección son anticipar el 

fenómeno del niño, el avance o reducción del deterioro de la capa de ozono, el 

estudio del avance de la desertificación o de la deforestación tropical, la 

generación y actualización catastral, inventarios forestales o agrícolas y 

prevención de desastres. 
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2.4.1. Tipos de resolución 

 

Los sistemas de percepción remota difieren en la resolución, es decir, para 

cada problema existe una resolución espacial más apropiada, esto está 

relacionado con el nivel de detalle con que pueden capturar las imágenes, su 

frecuencia temporal, finura espectral, entre otros. Se consideran cuatro 

diferentes tipos de resolución: espacial, espectral, radiométrica y temporal. 

 

2.4.1.1. Resolución espacial 

 

La resolución espacial está determinada por el tamaño del píxel, medido 

en metros sobre el terreno, esto depende de la altura del sensor con respecto a 

la Tierra, el ángulo de visión, la velocidad de escaneo y las características 

ópticas del sensor. Cuanto menor es el tamaño del píxel, mejor resolución tiene 

la imagen. 

 

La resolución espacial es una de las características más importantes que 

hay que considerar a la hora de elegir imágenes, porque determina de forma 

directa qué rasgos del terreno pueden cartografiarse. En la tabla VII se observa 

la resolución espacial para diferentes satélites, esto es muy importante para 

evaluar los costos del proyecto pues generalmente cuanto más detallada es una 

imagen más cara resulta por unidad de superficie. 

 

Tabla VII. Resolución espacial de algunos sensores 

 

Satélite Sensor 
Resolución espacial 

(m) 

QUICKBIRD  0,61 

IKONOS  1,00 

ORBVIEW 3  1,00 

SPOT 5  2,50 
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Continuación de la tabla VII. 

SPOT 3 HRV pan 10,00 

LANDSAT 7 ETM+ pan 15,00 

LANDSAT 5 TM pan 30,00 

MOS VTIR 900,00 

NOAA AVHRR 1 100,00 

METEOSAT VISSR 5 000,00 

 

Fuente: PÉREZ, Carlos y MUÑOZ, Luis. Teledetección: Nociones y aplicaciones. p. 8. 

 

Es importante comprender que, a medida que mejora la resolución 

espacial, el tamaño de los archivos digitales aumenta y exige, para su 

tratamiento, un espacio de almacenamiento considerable en la computadora. 

Por ejemplo, una imagen pancromática SPOT (60 x 60 kilómetros) de 10 metros 

de resolución, ocupa 36 Megabytes, en tanto que otra de la misma zona con las 

mismas características pero con una resolución de un metro, exige de 3 000 a  

4 000 Megabytes (3 - 4 Gigabytes). Para elegir la resolución espacial adecuada 

se debe tomar en cuenta lo siguiente: 

 

 1 metro 

 

o Identifica y cartografía rasgos a escala humana superiores a un 

metro cuadrado, por ejemplo, tapas de alcantarilla, automóviles, 

carriles de autopista, aceras, equipamiento de servicios públicos, 

cercas, árboles y arbustos. 

o Identifica características de muchos de los objetos mencionados. 

o Localiza y cartografía ampliaciones de casas, carreteras, edificios, 

patios y pequeñas explotaciones agrícolas y ganaderas. 

o Diferencia distintos tipos de edificios y casas. 
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 10 metros 

 

o Ubica y cartografía edificios, predios, carreteras, límites de 

propiedad, campos de deporte, granjas y calles laterales. 

o Diferencia entre parcelas cultivadas y sin cultivar en función de la 

salud vegetativa relativa. 

o Facilita tipificaciones de la cubierta del suelo en pequeñas áreas. 

 

 20 a 30 metros 

 

o Ubica aeropuertos, cascos urbanos, centros comerciales, 

complejos deportivos, grandes fábricas, extensos bosques y 

explotaciones agrícolas de gran amplitud. 

o Realiza clasificaciones generalizadas de la superficie del terreno. 

 

 80 metros 

 

o Cartografía estructuras geológicas regionales. 

o Evalúa la salud vegetativa en una región relativamente extensa. 

 

 1 kilómetro 

 

o Valora la salud vegetativa en países enteros. 

o Sigue eventos regionales como plagas de insectos, sequía y 

desertificación. 
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2.4.1.2. Resolución espectral 

 

La resolución espectral indica el número de bandas espectrales que puede 

discriminar el sensor y la anchura de las mismas. En este sentido, un sensor 

tendrá una resolución espectral más grande cuanto mayor sea el número de 

bandas que proporcione, ya que facilita la caracterización espectral de las 

distintas cubiertas. A la vez, conviene que esas bandas sean suficientemente 

estrechas con el objeto de recoger la señal sobre regiones coherentes del 

espectro. Por tanto podría decirse que a menor ancho espectral mayor 

resolución. El problema que surge es que también se reduce la relación S/N 

(Signal/Noise) por lo que es necesario llegar a una solución de compromiso 

entre ambas magnitudes. 

 

Dependiendo del propósito del sensor, este factor tendrá más o menos 

importancia. La elección de un número apropiado de bandas y la correcta 

selección de su anchura, puede proporcionar ventajas a la hora de realizar 

clasificaciones entre cubiertas de respuesta espectral semejante. Por ejemplo el 

índice de vegetación procede de la relación entre las reflectividades en el 

infrarrojo cercano y en el rojo, y brinda una medida del vigor de la cubierta 

vegetal. Un ancho de banda inadecuada o la elección incorrecta del número y 

posición de las bandas, conduce a pobres resultados. 

 

2.4.1.3. Resolución radiométrica 

 

La resolución radiométrica hace referencia al rango dinámico o número de 

niveles digitales usados al digitalizar la información procedente de la energía 

electromagnética recibida por el sensor (bits por píxel).  
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La energía electromagnética recibida por el sensor, cuando se convierte a 

nivel digital, necesita un formato binario (número de bits) para codificarse. A 

mayor número de bits reservados para almacenar la reflectividad de un píxel, 

mayor resolución radiométrica. En general, mayor número de niveles mayor 

detalle de la información. Al igual que ocurría en la resolución espectral existe 

una relación directa entre la resolución radiométrica y la relación Signal/Noise. 

 

La resolución radiométrica es variable según la banda espectral bajo 

análisis. El valor elegido es una decisión de compromiso entre la fidelidad con la 

que se quiere captar un fenómeno y la cantidad de información que hay que 

transmitir pues toda la información que se genera debe ser tratada y transmitida 

a Tierra. Valores de 64, 128 y 256 e incluso 1 024 niveles son valores 

habituales.  

 

2.4.1.4. Resolución temporal 

 

Este tipo de resolución se refiere al intervalo de tiempo entre adquisición 

de imágenes sucesivas de la misma zona de la cobertura terrestre, lo cual es de 

vital importancia a la hora de realizar estudios evolutivos. El ciclo de cobertura 

depende de las características de la órbita del satélite, el ángulo de barrido, 

velocidad del satélite, así como del diseño del sensor. 

 

2.4.2. Plataformas 

 

Se entiende por plataforma a los elementos que transportan los aparatos 

necesarios para captar, almacenar y transmitir imágenes a distancia. Cada 

técnica de teledetección se puede aplicar desde diferentes plataformas de 

observación y cada una de ellas tiene sus propias características, en la figura 8 

se observan algunos niveles y plataformas de teledetección.  
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Figura 8. Niveles y plataformas de teledetección 

 

 

 

Fuente: SEGADO VÁSQUEZ, Francisco. Principios de teledetección. p. 11. 

 

Las plataformas se puede clasificar en: 

 

 Suelo (o a pocos metros de altura): se utiliza principalmente para el 

diseño de las experiencias que después se llevarán a cabo desde otras 

plataformas. Mediante este tipo de observación se han construido las 

curvas de respuesta espectral de los distintos suelos y coberturas 

vegetales. En las investigaciones de campo se utilizan radiómetros de 

mano y también situados sobre móviles portátiles (plataformas diseñadas 

para llevar a cabo las medidas). Ejemplo: camión, grúas o vehículos que 

transportan los radiómetros o aparatos fotográficos - 20 metros. 

 

 Globos: la ventaja de este sistema es que son de bajo costo, lo que 

permite realizar programas científicas que no pueden embarcarse en 

satélites. Estas plataformas son de dos tipos: cautivos y libres. Los 

cautivos se utilizan para llevar a cabo estudios de conservación de 
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playas o como trazadores para observar el movimiento de masas de aire. 

Ejemplo: globo cautivo - 200 metros, globo estratosférico 20 - 50 

kilómetros. 

 

 Aviones: las medidas realizadas por estos sistemas son apropiadas para 

estudios locales o regionales. Entre las ventajas de su uso destaca la 

posibilidad de embarcar en el avión dispositivos de mayor peso que en 

un satélite, el control más preciso de los captadores en vuelo y la 

obtención de datos de mejor resolución espacial. Entre las desventajas 

destaca las dimensiones de la zona explorada son reducidas y el coste 

de obtención de los datos es más elevado que con los satélites. Ejemplo: 

avión ligero de baja altitud - 500 metros, avión normal de foto aérea 0,6 - 

10 kilómetros. 

 

 Cohetes: anteriormente eran utilizados como plataformas para sistemas 

fotográficos y en la década de los 70 fueron utilizados como plataformas 

de observación para realizar estudios sobre los continentes australiano y 

sudamericano. Trabajan a alturas comprendidas entre 90 y 2 500 

kilómetros. 

 

 Satélites artificiales: su uso se conoce como teledetección espacial, son 

las plataformas más adecuadas para obtener una visión de regiones de 

gran extensión. Constituyen un objeto artificial en el espacio que da 

vueltas alrededor de la Tierra siguiendo una órbita específica, pueden 

permanecer mucho tiempo en órbita, lo que a diferencia de los cohetes, 

permite una visión constante de la Tierra. Trabajan a alturas 

comprendidas entre 300 y 1 000 kilómetros. 
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2.4.3. Tipos de sensores 

 

Los sensores de teledetección son instrumentos que transforman la 

radiación electromagnética en información perceptible y analizable. Los 

sensores se pueden clasificar según la señal captada y pueden ser pasivos y 

activos, como se observa en la figura 9. 

 

Figura 9. Tipos de sensores según la señal captada 

 

 

 

Fuente: PINILLA RUIZ, Carlos. Teledetección: Ingeniería técnica en topografía. p. 3. 

 

 Sensores pasivos 

 

Estos sensores detectan la radiación electromagnética emitida o reflejada 

de fuentes naturales por la superficie terrestre y se subdividen en escáneres y 

no escáneres, los cuales a su vez tienen algunas ramificaciones que se detallan 

en la tabla VIII.  
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Tabla VIII. Tipos de sensores pasivos 

 

Sensores pasivos 

No escáneres 

No formadores de 
imagen 

Radiómetros de microondas 

Sensores magnéticos 

Gravímetros 

Espectrómetros de Fourier 

Otros 

Formadores de 
imagen 

Cámaras 

Monocromas 

Color natural 

Infrarrojo 

Infrarrojo color 

Otras 

Escáneres 
Formadores de 

imagen 

Escáner del plano 
imagen 

Cámaras de TV 

Escáneres sólidos 

Escáner del plano 
objeto 

Escáneres óptico-
mecánicos 

Radiómetros de 
microondas 

 

Fuente: PINILLA RUIZ, Carlos. Teledetección: Ingeniería técnica en topografía. p. 4. 

 

 Sensores activos 

 

Estos sensores poseen fuentes internas que generan artificialmente la 

radiación que miden tras ser reflejada y se subdividen en escáneres y no 

escáneres, los cuales a su vez tienen algunas ramificaciones que se detallan en 

la tabla IX.  

 

Tabla IX. Tipos de sensores activos 

 

Sensores activos 

No escáneres 
No formadores de 

imagen 

Radiómetros de microondas 

Altímetros de microondas 

Batímetros láser 

Distanciómetros láser  
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Continuación de la tabla IX. 

Escáneres 
Formadores de 

imagen 

Escáner del plano 
imagen 

Radar pasivo 
phased array 

Escáner del plano 
objeto 

Radar de apertura 
real 

Radar de apertura 
sintética (SAR) 

 

Fuente: PINILLA RUIZ, Carlos. Teledetección: Ingeniería técnica en topografía. p.11. 

 

2.4.4. Satélites para cartografía 

 

Actualmente existen satélites de varios países que capturan imágenes 

multiespectrales con diferente grado de resolución. Es de importancia conocer 

sus sensores y el uso potencial para distintos estudios, como se describe a 

continuación. 

 

 IKONOS – 2 

 

Fue lanzado el 24 de septiembre de 1999 en Vandenberg Air Force Base, 

California, Estados Unidos. Anteriormente, ningún satélite comercial había 

logrado conseguir tan alta resolución espacial, pesa unos 720 kilogramos y 

órbita la Tierra cada 98 minutos a una altitud de casi 680 kilómetros en forma 

sincronizada con el Sol, con una inclinación de 98,1 grados. Colecta 

información de cualquier área en promedio dos veces al día, cubriendo áreas de 

20 000 kilómetros cuadrados en una misma pasada y produciendo como 

resultado imágenes de 1 metro de resolución cada tres días y de 2 metros de 

resolución todos los días. Debido a que este satélite opera en el dominio óptico, 

necesita ausencia de nubosidad.  
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El sensor digital de imágenes del satélite está diseñado para producir 

imágenes con elevado contraste, resolución espacial y precisión. Las imágenes 

proporcionadas por el satélite IKONOS son aplicadas en agricultura, cartografía, 

geología, hidrología, contaminación, oceanografía, dinámica costera, 

telecomunicaciones, entre otros. 

 

 IRS - 1C (Indian Remote Sensing)  

 

Fue creado por la agencia espacial india (NRSA). El objetivo directo de 

sus satélites es mejorar el conocimiento de los recursos naturales de la India, 

aunque sus imágenes también se utilizan en otras aplicaciones. El IRS-1C 

opera en una órbita circular, heliosíncrona, casi-polar, con una inclinación de 

98,69 grados a 817 kilómetros de altitud. Tarda 101,35 minutos en dar una 

vuelta completa a la Tierra y tiene un ciclo de 24 días, está equipado con tres 

sensores. El sensor PAN es útil para cartografía y planificación urbana, el 

sensor LISS se utiliza para discriminación de vegetación, cartografía de usos 

del suelo y gestión de recursos naturales y el WiFS por sus características es 

útil para el seguimiento de la vegetación a escala regional. 

 

 Serie GOES/METEOSAT 

 

Se encuentran dentro de la división de satélites meteorológicos y están 

repartidos alrededor del Ecuador. Cinco satélites, el GOES Occidente (E.U.A.), 

el GOES Oriente (E.U.A.), METEOSAT (ESA), INSAT (India) y GMS (Japón), 

colectivamente permiten tener una visión de la situación global 

aproximadamente cada media hora. En la figura10 se muestra la distribución de 

los satélites.   
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Figura 10. Posiciones de cinco satélites geosincrónicos que 

proporcionan datos meteorológicos 

 

 

 

 

Fuente: MEADEN, Geoffrey J. y KAPETSKY, James M. Los sistemas de información geográfica  

              y la telepercepción en la pesca continental y la acuicultura. p. 58. 

 

 Serie LANDSAT – Estados Unidos 

 

La serie LANDSAT se encuentra dentro de la división de satélites 

ambientales, su operación es administrada por la NASA (National Space and 

Space Administration) y la producción y comercialización de imágenes depende 

de la USGS (United Sates Geological Survey). Cuando se lanzó el Landsat 4 y 

5 se incorporó un nuevo sensor denominado Thematic Mapper(TM) que se 

utiliza para la cartografía temática. Las características del sensor y los usos que 

se conocen son proporcionados en la tabla X. 
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Tabla X. Características del sensor TM 

 

Banda: Intervalo espectral 
(µm) 

Resolución 
espacial 

(m) 
Usos 

(1)  
0,45 – 0,52 

(violeta-azul) 
30,00 

Mapeo de aguas 
costeras 

(2) 
0,52 – 0,60  

(verde) 
30,00 

Identificación de 
vegetación saludable a 
través de reflectancia 

verde 

(3) 
0,63 – 0,69  

(rojo) 
30,00 

Diferenciación de plantas 
a través de mapeo de 

clorofila 

(4) 
0,76 – 0,90  
(IR cercano) 

30,00 
Delineación de cuerpos 

de agua 

(5) 
1,55 – 1,75  

(IR mediano) 
30,00 

Mediciones de nieve y 
nubes 

(6) 
10,40 –12,50  

(IR lejano o térmico) 
120,00 Mapeo térmico 

(7) 
2,08 – 2,35 

(IR mediano) 
30,00 Mapeo hidrotérmico 

 

Fuente: CATIE. Inventarios forestales para bosques latifoliados en América Central. p. 51. 

 

El LANDSAT 7 puede adquirir imágenes en un área que se extiende 

desde los 81 grados de latitud norte hasta los 81 grados de latitud sur y en 

todas las longitudes del globo terrestre. Una órbita del LANDSAT 7 es realizada 

en aproximadamente 99minutos, permitiendo al satélite dar 14 vueltas a la 

Tierra por día, y cubrir la totalidad del planeta en 16 días. La órbita es de norte a 

sur y está heliosincronizado, o sea que siempre pasa a la misma hora por un 

determinado lugar. Un factor importante es que el período de revolución del 
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LANDSAT 7 es igual que el del LANDSAT 5 (16 días), y una imagen cubre igual 

área (185 x 185 kilómetros por escena). 

 

 Serie NOAA 

 

La Administración Nacional Oceánica y Atmosférica de Estados Unidos 

(NOAA) fundó la serie. Los satélites de la serie NOAA están dedicados a 

observaciones meteorológicas y a estudios de la temperatura superficial del 

mar. 

 

Los satélites NOAA-2 al 5 fueron lanzados en la década de los años 

setenta, en órbita heliosincónica circular, y polar cercano (ángulo de inclinación 

de 102 grados), diseñados para pasar por cualquier estación receptora local 

dos veces al día, tienen un período de 115 minutos realizando de 12 a 13 

revoluciones por día con distancias entre rutas de 3 200 kilómetros. 

 

Estos satélites transportan el sensor VHRR (Radiómetro de Muy Alta 

Resolución), que ha sido utilizado extensivamente para estudios 

oceanográficos. Este sensor se hizo inactivo en 1979 y fue reemplazado por su 

versión mejorada, el radiómetro avanzado de muy alta resolución (AVHRR). 

 

La segunda generación de satélites, NOAA-6 a 11, tienen un ángulo de 

inclinación de 102 grados al igual que la primera generación. Estos satélites 

tienen un período de 99 minutos y realizan de 14 a 15 revoluciones por día con 

distancias entre rutas de 2 760 kilómetros. 
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 SPOT 

 

Este satélite se puso en órbita en marzo de 1998 con el sensor de alta 

resolución HRVIR que opera con una resolución de 20 y de 10 metros, también 

se le incorporó un sensor denominado VEGETATION que se utiliza 

especialmente para estudiar la vegetación. Por medio de este sensor es posible 

obtener imágenes diarias en latitudes superiores a 35 grados con una 

resolución de 1 Km x 1  Km. La posibilidad de combinar imágenes de alta y baja 

resolución resulta de interés para la calibración y validación de modelos de 

vegetación. 

 

En 2002 se lanzó el satélite SPOT 5, este proporciona imágenes de alta 

resolución espacial. Estas mejoras son aplicables en imágenes para la 

cartografía topográfica a escala 1:50 000, con un error de planimetría de 10 

metros y en la elevación de 5 metros. 

 

 QUICKBIRD 

 

Este satélite fue puesto en órbita el 18 de octubre de 2001 y ofrece 

imágenes con tamaño de píxel de hasta 61 centímetros, lo que significa una alta 

resolución. Puede alcanzar los 16,5 kilómetros de longitud en una única 

pasada, se encuentra a 450 kilómetros de altura y realiza una órbita síncrona 

con el sol que dura 93,5 minutos con una inclinación de 97,2 grados siendo 

capaz de almacenar 160 Gbits a bordo. 

 

La data coleccionada por el satélite tiene una resolución radiométrica de 

11 bits y el tamaño de cada escena es de 16,5 Km x 16,5 Km. Las aplicaciones 

pueden ser diversas, se puede mencionar su utilidad en estudios urbanos, 

estudios agrícolas, planes de desarrollo nacional y local, análisis y monitoreo de 
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cuencas sistemas de gestión municipal, evaluación de infraestructura, 

planificación ambiental, zonas críticas de conservación (reservas hidráulicas, 

forestales), auditorías ambientales, conservación de recursos, desarrollos 

turísticos, determinación de zonas de riesgo, planes de contingencia, entre 

otras. 
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3.  SISTEMAS DE INFORMACIÓN GEOGRÁFICA 

 

 

 

3.1. Antecedentes 

 

Como en toda tecnología y ciencia que alcanza el grado de madurez, se 

pueden diferenciar varias etapas en el desarrollo de los Sistemas de 

Información Geográfica, que dieron origen a su concepto actual. 

 

 Era de Innovación (1963 - 1977) 

  

En 1964, Roger Tomlinson, considerado como el padre del SIG, creó el 

CGIS (Canada Geographic Information System) para el inventario y 

planificación de ocupación del suelo en grandes zonas.  

 

Howard Fisher, un arquitecto norteamericano, estableció el primer 

Laboratorio de Gráficos Informatizados y Análisis Espacial en la Universidad de 

Harvard (SYMAP). En 1969, dos estudiantes de este laboratorio de Harvard 

formaron la empresa  ESRI, muy importante y extendida en la actualidad, para 

el desarrollo de proyectos SIG. 

 

Ian McHarg fue el primero en describir diferentes conceptos de análisis 

modernos mediante SIG que plasmó en su libro Design with Nature. Algunos 

productos SIG más específicos se basan aún en sus principios. 
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 Era de la comercialización (1981 - 1999) 

 

Comienza con la salida del software ODYSSEY, un verdadero gestor de 

sistema de información geográfica en el que se incluye la digitalización 

semiautomática de datos espaciales, la gestión de bases de datos y la 

elaboración interactiva de datos. ESRI desarrolla ArcInfo y comienzan a 

desarrollarse programas como IDRISI, ERDAS, entre otros. 

 

El mercado del software creció con rapidez, el precio del hardware estaba 

cayendo, por lo que el poder de los SIG y su industria siguieron aumentando 

hasta la actualidad. Los primeros clientes de productos SIG fueron empresas 

forestales y agencias de recursos naturales, por la necesidad de mantener la 

información y regular el uso eficiente de los recursos.  

 

En 1994 se crea el Open Geospatial Consortium (OGC) que agrupa más 

de 250 organizaciones públicas y privadas. Su fin es la definición de estándares 

abiertos e interoperables dentro de los SIG.  

 

 Era de explotación (2000 - actualidad) 

 

Esta era está basada en la difusión acelerada, incorporando al público en 

sus aplicaciones fundamentalmente a la generalización de su acceso mediante 

internet y al desarrollo de tecnologías como el GPS. 

 

3.2. Concepto 

 

El término SIG es el acrónimo de Sistemas de Información Geográfica y es 

traducción del término en inglés GIS que fue en el primer idioma en que 

apareció, y en la que también es acrónimo de Geographic Information System.  
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Debido al conjunto de aspectos que encierra el concepto y la cantidad de 

fines que pretende, es difícil cualquier intento de definición del término. Es 

posible encontrar definiciones de SIG en función de los usuarios a los que se 

dirige, como se muestra en la tabla XI.  

 

Tabla XI. Definiciones de la tecnología SIG en función de los usuarios a  

  los que se dirige 

 

Usos Usuarios 

Un recipiente de mapas en formato 
digital 

Gran público 

Una herramienta informática para 
resolver problemas geográficos 

Gestores, planificadores 

Un sistema de ayuda a la decisión con 
componente espacial 

Científicos asociados a la gestión 

Un inventario mecanizado de 
características geográficamente 

distribuidas 
Gestores de recursos 

Una herramienta para revelar lo que 
de otra manera es invisible en la 

información espacial (análisis espacial) 
Científicos, investigadores 

Una herramienta para realizar 
operaciones con datos geográficos 

que hechas a mano serían muy 
tediosas, costosas o poco precisas 

Cartógrafos, gestores de recursos 

 

Fuente: ANDRÉS, Manuela y GARCÍA, Francisco. La evaluación de impacto ambiental de  

      proyectos y actividades agroforestales. p. 145. 

 

Basado en lo anterior, se puede resumir a los Sistemas de Información 

Geográfica como un sistema integrado de herramientas que permiten visualizar 

la información en forma espacial y su distribución geográfica, así como el 

análisis y manipulación de los datos geográficos proporcionando una 

modelización de la realidad. 
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3.3. Componentes de un SIG 

 

Los principales componentes necesarios para llevar a cabo las tareas de 

un SIG se resumen en la figura 11 y se detallan a continuación.  

 

Figura 11. Componentes de un SIG 

 

 

 

Fuente: PEÑA LLOPIS, Juan. Sistemas de información geográfica aplicados a la gestión del  

    territorio. p. 7. 

 

 Software 

 

Es el programa informático con el que se crea el SIG. Los programas SIG 

brindan las herramientas y funcionalidades necesarias para almacenar, analizar 

y mostrar información geográfica. Sus componentes principales se resumen en 

la figura 12 y son los siguientes:  
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o Introducción de datos y verificación (Input) 

o Almacenamiento de datos y manejo de base de datos 

o Transformación de datos  

o Interacción con el usuario 

o Salida de datos y presentación (Output) 

 

Figura 12. Componentes principales del software para un SIG 

 

 

 

Fuente: PEÑA LLOPIS, Juan. Sistemas de información geográfica aplicados a la gestión del  

    territorio. p. 8. 

 

 Hardware 

 

Es necesario cumplir los mínimos exigidos por el software, con la 

capacidad para almacenar la información que se pretende introducir en el 

sistema y con la potencia suficiente para realizar los cálculos requeridos a una 

velocidad aceptable.  
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Figura 13. Componentes de hardware más importantes para un SIG 

 

 

 

Fuente: PEÑA LLOPIS, Juan. Sistemas de información geográfica aplicados a la gestión del  

       territorio. p. 8. 

 

Los componentes del hardware se resumen en la figura 13 y son los 

siguientes: 

 

o Computadora: compuesta por un disco duro para almacenar datos 

y programas, se puede proporcionar capacidad extra vía red o en 

otros dispositivos. El usuario controla la computadora mediante la 

pantalla, el teclado y el ratón. La comunicación entre distintas 

computadoras se hace posible a través de redes locales, globales 

o vía Internet. 
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o Escáner: se utiliza para introducir información de mapas (input)  y 

convierte los mapas y documentos a formato digital, por lo tanto, 

estos pueden ser utilizados por los programas de computadora. 

 

o Plotter: se utiliza para mostrar los resultados de los mapas y del 

procesamiento de los datos (output), también puede ser una 

impresora u otro tipo de dispositivo de representación. 

 

 Datos 

 

La base de datos del sistema debe contener la mayor cantidad de 

información posible, de preferencia solamente datos fiables y relevantes, con un 

grado mínimo de redundancia, pues el componente más importante para un 

SIG es la información. Se requieren buenos datos de soporte para que el SIG 

pueda resolver los problemas y contestar a las preguntas de la forma más 

acertada posible.  

 

La importancia de la adquisición de la información no debe ser 

subestimada aunque la consecución de buenos datos generalmente absorbe 

entre un 60 y 80 por ciento del presupuesto de implementación del SIG, y la 

recolección de los datos es un proceso largo que frecuentemente demora el 

desarrollo de productos que son de utilidad. Los datos geográficos y 

alfanuméricos pueden obtenerse por recursos propios u obtenerse a través de 

proveedores de datos.  

 

En un mapa tradicional el almacenamiento y la representación de la 

información coinciden. Por el contrario, en un SIG la forma de almacenamiento 

es distinta de la representación pues se visualiza la información en distintas 

capas temáticas, cada una de las cuales está almacenada en una carpeta o 



54 
 

conjunto de carpetas. Una capa temática es una agrupación de datos que 

representan una misma clase de objetos; por ejemplo, capas de división 

política, de centros poblados, de cuencas, de ubicación de centros 

hospitalarios, etc. Los SIG son capaces de superponer las diferentes capas, 

ocultando al usuario los detalles de almacenamiento, como se observa en la 

figura 14. 

 

Figura 14. Capa temática 

 

 

 

Fuente: COTOS, José Manuel. Sistemas de información medioambiental. p. 63. 

 

 Procedimientos y análisis  

 

El análisis corresponde a las operaciones y consultas que se van a 

realizar sobre la información. Muchas de ellas son rutinarias (en cuanto al 

tiempo de ejecución) y deben automatizarse en la medida de lo posible.  
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 Usuarios 

 

Es el último componente, aunque no el menos importante. Las tecnologías 

SIG son de valor limitado sin los especialistas en manejar el sistema y 

desarrollar planes de implementación del mismo. Sin el personal experto en su 

desarrollo, la información se desfasa y se maneja erróneamente, y el hardware 

y el software no se manipulan con todo su potencial. Una incorrecta 

manipulación de la información podría terminar en la extracción de conclusiones 

que entorpezcan o imposibiliten la finalización del proceso de toma de decisión.  

 

3.4. Almacenamiento de datos 

 

No existe una manera única de incorporación y almacenamiento de datos. 

Las formas varían según el tipo de dato, los resultados deseados y el software 

disponible. Básicamente se emplean dos modos de representación de datos 

espaciales: vectorial y raster, como se muestra en la figura 15.  

 

Figura 15. Modelos de representación vectorial y raster 

 

 

 

Fuente: COTOS, José Manuel. Sistemas de información medioambiental. p. 63. 
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3.4.1. Formato vectorial 

 

Es la forma más común para representar los datos espaciales, utiliza los 

elementos punto, línea y polígono para representar cada característica 

geográfica, como se observa en la figura 16. Los mismos están definidos por un 

par de coordenadas referenciadas en un sistema cartográfico determinado y los 

atributos de tales características geográficas están almacenados en una base 

de datos independiente.  

 

Figura 16. Representación de vectores de tipo: puntos, líneas y  

        polígonos 

 

 

 

Fuente: FAO Fiat Panis. Manual Curso Análisis Espacial ArcView. p. 14. 

 

Los puntos tienen una localización X, Y y no tienen dimensiones, como por 

ejemplo la localización de un poste, un poblado, etc. Las líneas son construidas 

por al menos dos puntos en los extremos de la línea (o nodos), estas poseen 

longitud, como por ejemplo un camino, un cerco, etc. Las áreas o polígonos son 

un conjunto de puntos, donde el punto de inicio es igual al de término, formando 

así un objeto cerrado con un interior y un exterior, poseen perímetro y área, 

como por ejemplo un predio, un área urbana, etc. Las ventajas y desventajas de 

la representación vectorial se describen en la tabla XII. 
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Tabla XII. Ventajas y desventajas del uso de la representación vector 

 

Representación vectorial 

Ventajas Desventajas 

Tiene una estructura de datos más 
compacta 

Su estructura es más compleja que un 
raster. 

La salida en papel presenta muy 
buenos productos. 

No es un modelo adecuado para el 
análisis espacial de imágenes 

digitales, pues el filtrado dentro de los 
polígonos es imposible de realizar. 

Es más adecuado para gráficos 
parecidos a mapas convencionales 

lineales. 

El despliegue y la graficación suelen 
ser caros particularmente por la alta 
calidad, color y sombreado de los 

productos impresos. 

Es posible la recuperación, 
actualización y generación de gráficos 

y atributos. 

La simulación es difícil porque cada 
unidad tiene una diferente forma 

topológica. 

Codifica eficientemente la topología 
por medio de la unión de arcos o 

redes. 

Overlay (capacidad de sobre posición) 
es más difícil de implementar. 

 

Fuente: FAO Fiat Panis. Manual Curso Análisis Espacial ArcView. p 14. 

 

3.4.2. Formato raster 

 

La estructura raster consiste en la representación del mundo real o la 

representación de este en una grilla compuesta de celdas (píxel). Está 

orientado para representar fenómenos tradicionalmente geográficos que varían 

continuamente en el espacio, como la elevación, inclinación o precipitación. 

Pero además pueden ser utilizadas para representar tipos de información 

menos tradicionales, tales como densidad de población, comportamiento del 

consumidor y otras características demográficas. 

 

A la representación raster se le denomina imagen. La estructura genera 

sólo un archivo que contiene las coordenadas en fila columna y el atributo del 
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píxel. El uso de la representación raster tiene ventajas y desventajas, estas se 

detallan en la tabla XIII.  

 

Tabla XIII. Ventajas y desventajas del uso de la representación raster 

 

Representación raster 

Ventajas Desventajas 

Estructura de datos simple. La estructura es menos compacta. 

Overlay o sobreposiciones de 
diferentes coberturas se implementan 

de manera rápida y eficiente. 

La representación de topología es 
más compleja, siendo algunas difíciles 

de representar. 

La tecnología es relativamente barata. 
La calidad de los mapas finales 

depende de una alta resolución que 
significa archivos más pesados. 

Su formato es utilizado en el análisis 
de imágenes digitales. 

La salida en papel tiene menos 
presentación que uno con líneas finas. 

Da la posibilidad de generar Modelos 
de Elevación del Terreno. 

Sin el uso de algoritmos o equipo 
especial, la transformación de 

proyecciones demora bastante. 
 

Fuente: CHEW Daunno, Curso de Sistemas de Información Geográfica. p 13, 

    FAO Fiat Panis, Manual Curso Análisis Espacial ArcView. p 14.  

 

3.5. Etapas de diseño de una base de datos para una aplicación SIG 

 

Un diseño detallado de la base de datos del SIG debe elaborarse 

simultáneamente al diseño del sistema. Cuando se diseña la base de datos 

deben elaborarse las especificaciones para crear y dar mantenimiento a la base 

de datos. Las etapas de diseño se detallan a continuación. 

 

 Investigación de las necesidades 

 

Esta etapa es fundamental porque consiste en determinar las funciones 

que serán apoyadas por el SIG. Es necesario llevar a cabo inventarios de datos 
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existentes, programas, hardware. Este período es crítico para la determinación 

de errores permisibles, tolerancia, escala de trabajo, nivel de precisión y detalle, 

además de otras consideraciones. Para esto es necesario entrevistar a 

personas que conozcan las operaciones dentro de la institución en que se 

implantará el sistema y los potenciales usuarios. La entrevista debe contener 

preguntas como las que se enlistan a continuación, además de otras que sean 

de relevancia: 

 

o ¿Cuáles son las tareas que se llevan a cabo usando datos 

geográficos? 

 

o ¿Cuáles son las tareas que se están haciendo que al presente no 

usan datos geográficos pero que tienen un componente de 

localización o geográfico? 

 

o ¿Cuáles son las tareas que no se están haciendo, pero sería 

deseable poder hacerlas? 

 

o ¿Quiénes estarán usando el sistema y cuáles serán sus funciones 

dentro del mismo? 

 

o ¿Cuáles serán los productos que se obtendrán mediante el 

sistema (mapas, informes, otros)? 

 

o ¿Cuáles serán las aplicaciones e interfaces que necesitan ser 

desarrolladas? 

 

o ¿Cuáles son los datos que son necesarios para desarrollar la base 

de datos? 
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 Diseño conceptual y diseño lógico 

 

Determina el contenido de la base de datos y cómo se organizarán los 

mismos dentro de ésta. Previo al diseño es necesario conocer lo siguiente: 

 

o Los productos que deberían producirse con el sistema. 

 

o Nivel de detalle (gráfico y no gráfico) necesario para llevar a cabo 

los procesos. 

 

o Nivel permitido de error (tolerancia). 

 

o Sistema de referencia espacial. 

 

En la parte del diseño conceptual se escoge el tipo de base de datos a 

usarse. Las bases de datos Geodatabase son ejemplos de este tipo, las cuales 

pueden encapsular comportamientos y características. Este tipo de bases de 

datos suelen ejecutarse más rápidamente, permiten más herramientas de 

validación y no necesitan programación experta para modelar el 

comportamiento de los objetos. Según sea el tipo de base de datos se escogerá 

la manera de representar las características (atributos) de las entidades. Entre 

las ventajas que ofrece la Geodatabase se encuentran: 

 

o Expansible, en el sentido que la base de datos puede ser 

transferida a otra de mayor capacidad, como las RDBMS de tipo 

corporativo. Estas bases de datos empresariales están diseñadas 

para ambientes multiusuarios. 
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o Objetos personalizados, estos pueden ser programados para que 

representen objetos del mundo real de una manera más certera. 

 

o Dominios y sub tipos, los cuales definen propiedades de los 

objetos que permiten la validación de datos tabulares. Los 

dominios y sub tipos no necesitan habilidades especiales 

de programación. 

 

o Redes geométricas, que se generan para el modelaje de la 

conectividad para hacer  procedimientos de trazado de rutas, y 

búsqueda de caminos óptimos. 

 

o Topología, en el caso de las GDB son más flexibles, permitiendo 

escoger entre usarla o no, aceptar excepciones y definir reglas.  

 

 Diseño físico 

 

Este tiene que ver con la forma en que se construirá la base de datos en 

términos físicos. En esta se definirán y abrirán los espacios para colocar 

aquellos datos relevantes a la institución. Entre los aspectos más importantes 

están: 

 

o Fuentes de datos: ¿Cuáles serán las fuentes de datos necesarios 

para el funcionamiento de las operaciones? En muchas ocasiones 

se tendrá que buscar datos en otros lugares o comprarlos. Estos 

serán adoptados en la base de datos. 

 

o Diseño de conjuntos de datos individuales: en este aspecto, se 

hace el bosquejo final de cada conjunto de datos y cada tabla 
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independiente. Esta es la traducción entre el diseño conceptual y 

la construcción física de los espacios a ser llenados por los datos. 

Se debe decidir de manera precisa cómo cada capa de 

información será guardada y cuáles serán los métodos de codificar 

sus nombres. 

 

o Además se debe definir las relaciones entre tablas y los códigos 

de enlace entre las mismas. 

 

o Determinar cuáles y cómo serán los dominios y sub tipos que se 

establecerán en esta base de datos. 

 

o Documentación: servirá para establecer los estándares para el 

nombramiento de los datos, atributos y otros datos relacionados. 

Además se determinará cuál información será guardada como 

documentación para la base de datos y los procedimientos que se 

usarán para implantar la misma. 

 

La selección del sistema de referencia depende del lugar en donde se 

encuentre el diseñador de la base de datos. Es necesario el conocimiento de 

estos sistemas de referencia y las proyecciones cartográficas para poder 

escoger la referencia que mejor se ajuste de acuerdo con la forma y área del 

territorio cartografiado.  

 

 Plan de automatización ­ digitalización 

 

Conlleva la preparación de los datos para insertarlos dentro de la base de 

datos. Se supone también que se haya tomado el tiempo necesario para hacer 

el inventario de datos disponibles y necesarios para producir los productos.  
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Dentro del plan de automatización están contenidos los procesos de 

digitalización, adquisición de datos, conversión de formatos y si es necesario el 

agrego de los mismos para los propósitos de producción de los productos que 

saldrán del sistema.  

 

En este plan deben estar presentes los procedimientos de validación de 

los datos gráficos sobre la topología, redes (si es factible) o algún otro de 

validación gráfica basada en criterios propios dela institución. Además de estos 

están los criterios de validación de datos no gráficos como los dominios, 

subtipos y relaciones entre las tablas.  

 

 Proyecto piloto 

 

Contiene el diseño completo y documentado de todo el sistema. Este es el 

documento que guiará el proceso de prototipo o desarrollo del sistema. Permite 

evaluar el diseño de la base de datos usando pocos recursos antes de pasar a 

la etapa de producción completa. El diseño debe ser probado en términos de 

funcionalidad, desempeño y flexibilidad usando diferentes conjuntos de datos 

que aseguren que el diseño está trabajando en diversas circunstancias. 

 

 Prototipo 

 

 Contiene todos los requerimientos de programado para el desarrollo del 

sistema o de la base de datos. En esta parte el programa o las pantallas, 

parámetros, rutinas de validación, estarán listas para sus primeras pruebas en 

vivo, antes de pasar finalmente a la etapa de producción. Este es el punto 

donde los errores se deben documentar para ser corregidos. 
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3.6. Aplicaciones SIG 

 

El uso de los SIG se ha incrementado en los últimos años, debido a su 

carácter multipropósito y multidisciplinario. Los SIG tienen un rango de 

aplicación muy amplio, lo que permite que se utilicen en distintos sectores como 

una herramienta para la toma de decisiones y ayuda a la gestión.  

 

3.6.1. Catastro 

 

El catastro es un elemento crucial para el desarrollo de la economía 

municipal e incide sobre el planeamiento urbano, la dotación de servicios, la 

regulación de la tenencia de la tierra y el uso del suelo. Comprende información, 

tanto espacial (localización, límites y superficies), como temática (usos, valores 

y propietarios), acerca de parcelas y bienes inmuebles rurales y urbanos.  

 

La aplicación principal es la gestión de impuestos, en el caso de 

Guatemala; el Impuesto Único Sobre Inmuebles (IUSI), la gestión catastral, 

localizar e identificar bienes inmuebles de naturaleza rural y urbana, asignarles 

referencia catastral que es la clave fundamental para identificar y localizar los 

bienes, medir superficies, apoyar labores de valoración, detectar errores y 

omisiones en la información catastral, actualizar datos que no coincidan con la 

realidad, entre otros. 

  

3.6.2. Clima 

 

Los SIG aplicados en clima permiten la realización de mapas climáticos, 

estos son representaciones gráficas de los valores de ciertas variables 

meteorológicas sobre una zona geográfica determinada y aportan una imagen 

de conjunto de las situaciones atmosféricas. 
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La publicación de mapas climáticos contribuye significativamente al 

conocimiento de los climas globales, regionales y nacionales. Además, muchos 

sectores demandan a diario mapas climáticos autorizados en la aplicación de la 

información climatológica y meteorológica en una amplia gama de proyectos 

económicos, sociales y ambientales en escala local. Desde un punto de vista 

estadístico y para los fines del proceso de datos climatológicos, usualmente se 

divide a los elementos climáticos en continuos (los que se expresan en términos 

de su media aritmética, como la temperatura del aire, la presión atmosférica, la 

humedad) y discontinuos (los que se expresan como totales, como la 

precipitación, la duración de la insolación y el número de días con condiciones 

específicas).  

 

En la figura 17 se muestra un mapa climático de la precipitación de la 

cuenca del río Achiguate. 
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Figura 17. Mapa de precipitación (mm) de la cuenca del río Achiguate,  

    Escuintla 

 

 

 

Fuente: GUTIÉRREZ, Lily; SANTOS, Guillermo; TOBÍAS, Hugo; LÓPEZ, Adalberto y DE LEÓN,  

             Renato. Identificación de zonas vulnerables a desastres naturales en la Cuenca del Río  

             Achiguate. p. 36. 

 

3.6.3.  Medio ambiente 

 

Los SIG se aplican al medio ambiente como una herramienta para la toma 

de decisiones ante catástrofes, para la prevención de riesgos de diversos tipos, 

como amenazas volcánicas, inundaciones, sismos, avalanchas, depósito de 
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materiales peligrosos, deslizamientos, entre otros. En la figura 18, se observa el 

mapa de áreas vulnerables a deslizamientos de la cuenca del río Achiguate.  

 

Figura 18. Mapa de áreas vulnerables a deslizamientos de la cuenca  

    del Río Achiguate, Escuintla 

 

 

 

Fuente: GUTIÉRREZ, Lily; SANTOS, Guillermo; TOBÍAS, Hugo; LÓPEZ, Adalberto y DE LEÓN,  

   Renato. Identificación de zonas vulnerables a desastres naturales en la Cuenca del Río  

     Achiguate. p. 36. 

 

Asimismo, con la ayuda de un SIG se pueden determinar los focos y áreas 

de influencia, posibilidades de evacuación, inventario de población y propiedad 

privada afectada. Entre otras aplicaciones de los SIG en el Medio Ambiente 

están: 
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 Inventarios de especies 

 Concentración de contaminantes y sus causas 

 Impactos ambientales de obras civiles  

 Caracterización de escenarios  

 Estudio y manejo de ecosistemas 

 Manejo de basura (correcta localización de vertederos) 

 Administración de emergencias 

 Distribución de especies 

 Monitoreo de áreas de protección 

 Monitoreo de áreas costeras 

 Monitoreo de la calidad de las aguas 

 Monitoreo orbital y análisis de pautas de difusión de incendios 

 

3.6.4. Gobierno 

 

Las instituciones gubernamentales, en el caso de Guatemala, los distintos 

ministerios, secretarías de la presidencia, instituciones autónomas y semi 

autónomas, Policía Nacional Civil, comisiones, consejos, fondos y programas, 

se encargan de gestionar los recursos públicos, con el objetivo principal del 

bienestar de los ciudadanos. Este objetivo podría facilitarse en su cumplimiento 

aplicando los Sistemas de Información Geográfica correctamente en cada área.  

 

En la sección 3.7 se presentan algunas instituciones de Guatemala que 

utilizan los Sistemas de Información Geográfica como herramienta. La 

necesidad e importancia de que cada institución gubernamental utilizara un SIG 

se basa en que las personas ven como una necesidad inmediata el poder 

conocer el espacio, la ubicación, las condiciones que los rodean, para tener 

mayor objetividad y una base para decidir sobre medidas o acciones de algún 

evento en particular. 
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3.6.5. Redes de infraestructura 

 

Por medio de los SIG se puede realizar la gestión de las principales redes 

de infraestructura: redes eléctricas, distribución de agua, alcantarillado, luz, etc. 

Ejemplos de aplicación son la localización y reparación de desperfectos en 

alguna red, solucionar problemas por falta de coordinación y planificación, 

realizar nuevos trazados en lugar específico, análisis de las redes actuales, 

entre otras.  

 

3.6.6. Urbanismo 

 

En esta rama los SIG facilitan la proyección y el diseño de los planes de 

ordenamiento territorial, cartografiando los impactos de los crecimientos 

urbanos y asignando los criterios de edificabilidad como información básica. Un 

ejemplo de esta aplicación es un estudio de ordenamiento territorial que se 

realiza con el objetivo de disminuir las amenazas de flujos no controlados de 

agua y lodos, provenientes de la lluvia en un mes determinado y por 

deslizamientos de tierras a fin de disminuir los riesgos vinculados a esos 

fenómenos en un asentamiento de la Ciudad de Guatemala.   

 

3.6.7. Turismo 

 

Los SIG aplicados en turismo, ayudan a tomar decisiones estratégicas 

importantes como el análisis de localización de instalaciones, determinando la 

accesibilidad y conveniencia para el usuario y, por tanto, los ingresos obtenidos 

por la empresa. En la tabla XIV se muestran algunas cuestiones a las que 

puede responder un SIG para esta aplicación. 
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Tabla XIV. Cuestiones a las que puede responder un SIG 

 

Situación Pregunta Descripción Ejemplo 

Localización 
¿Qué hay 

en…? 
- 

¿Cuántos hoteles hay 
en un departamento? 

Condición 
¿Dónde 

sucede…? 
- 

¿Dónde hay un sitio 
arqueológico maya 

que este a menos de 
dos horas en bus? 

Tendencias 
¿Qué ha 

cambiado en…? 

Comparación entre 
situaciones 

temporales distintas, 
si bien para ello se 

pueden incluir 
condiciones 

- 

Rutas 
¿Cuál es el 

camino óptimo? 

El sistema puede 
calcular el camino 
optimo entre dos 

puntos (el más corto, 
más barato y más 
rápido) a través de 

una red 

¿Cuál es el óptimo 
para llegar a cierto 

departamento? 

Pautas 
¿Qué pautas 
existen…? 

Ciertas regularidades 
especiales pueden 

ser detectadas por un 
SIG 

- 

Modelos 
¿Qué ocurriría 

si…? 

Se pueden generar 
modelos para simular 

el efecto que 
producirían posibles 

fenómenos o  
actuaciones en el 

mundo real 

¿Qué efecto tendría 
una tormenta tropical 
en la ocupación de un 

hotel en una zona 
costera? 

 

Fuente: AGUILAR, Víctor y GARRIDO, Pedro. Los Sistemas de Información Geográfica (SIG) y  

              su aplicación en localización de establecimientos turísticos. p. 4 y 5. 
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3.6.8. Geomarketing 

 

El Geomarketing es una disciplina conjunta de marketing y geografía que 

consta de información estadística y cartográfica, tratamiento de la información y 

estudios de mercado. Por medio de estos elementos permite analizar la realidad 

económico-social.  

 

Figura 19. Cuestiones críticas de la cuestión comercial 

 

 

 

Fuente: CHASCO, Coro. El Geomarketing y la distribución comercial. p. 7. 

 

En la figura 19 se muestran algunas cuestiones a las que puede responder 

un SIG para esta aplicación. Algunos ejemplos de aplicación y toma de 

decisiones de Geomarketing son los siguientes:  

 

 Una empresa regional dedicada a la venta de electrodomésticos desea 

convertirse en una cadena nacional. 
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 La directora de ventas de una cadena de regalos se plantea abrir una 

tienda en un centro comercial de reciente creación. 

 

 Una cadena de grandes almacenes no sabe por qué una de sus mejores 

tiendas está experimentando, de pronto, un importante declive. 

 

3.7. Algunas instituciones que utilizan Sistemas de Información 

Geográfica en Guatemala 

 

Aunque en Guatemala existen diversas instituciones gubernamentales que 

utilizan los sistemas de información como una herramienta para mayor facilidad 

en la toma de decisiones que se presentan, en la elaboración del presente 

trabajo se tomó en cuenta al IGN, CONRED, MAGA e INSIVUMEH.  

 

Para poder conocer la importancia de esta herramienta en las instituciones 

mencionadas, se entrevistó a personas que laboran en cada una de ellas, 

realizando las siguientes preguntas: 

 

 Pregunta 1: ¿Qué software SIG se utiliza en la institución? 

 Pregunta 2: ¿Desde cuándo utilizan SIG en la institución? 

 Pregunta 3: ¿Qué aplicación le dan en la institución a los SIG? 

 Pregunta 4: ¿Qué ventaja tiene para la institución trabajar con SIG? 

 Pregunta 5: ¿Qué desventaja tiene para la institución trabajar con SIG? 

 

3.7.1. Instituto Geográfico Nacional (IGN) 

 

   El Instituto Geográfico Nacional, ingeniero Alfredo Obiols Gómez (IGN), 

es una dependencia del Ministerio de Agricultura, Ganadería y Alimentación; de 

carácter técnico científico, rector y proveedor de productos y servicios, que 
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elabora y garantiza la información geográfica y cartográfica confiable para la 

investigación, planificación y monitoreo, para el desarrollo del país a nivel 

público y privado. 

 

Para obtener información acerca del IGN y su relación con los Sistemas 

de Información Geográfica se necesitó la colaboración del ingeniero Milton 

Núñez y como complemento se visitó la página web http://www.ign.gob.gt. Las 

respuestas fueron las siguientes: 

 

 Pregunta 1 

 

El software utilizado en el IGN es ArcGis versión 9.1,  9.2  y ArcInfo.  

 

 Pregunta 2 

 

El primer SIG que realizó el IGN data de 2004, con el SIG de Puerto 

Barrios. 

 

 Pregunta 3 

 

El IGN  construye los SIG de cabeceras o centros urbanos, como una 

plataforma básica, en la que se separan por capas los usos urbanos del suelo, 

como una primera aplicación, estos usos van desde el habitacional, comercio, 

institucional, áreas verdes, predios baldíos, etc., y se podría decir que las 

aplicaciones directamente se la dan los usuarios, en la mayoría de los casos las 

Corporaciones Municipales, que pueden usarlo para ver el crecimiento  urbano 

de sus ciudades, planes de regulación de tránsito, control del pago del IUSI y 

otros impuestos, dotación de servicios públicos agua, luz, drenaje, tipos de 

http://www.ign.gob.gt/www/index.php?option=com_content&view=article&id=863:sig&catid=6:contenido
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pavimentación y donde hace falta, sectorización, zonificación, control del 

territorio. Por otro lado, usar un SIG en el IGN, se aplica para: 

 

o Agrupar  elementos de un mismo tipo, y atributo por ejemplo lineal: 

carreteras, para ver su tipo de recubrimiento, características y 

longitudes y hacer estudios y mapas. 

 

o Consulta y selección de información para la creación de mapas 

temáticos.  

 

o Interrelación de los distintos fenómenos geográfico-ambientales, y 

el estudio de su interacción para respuestas a problemática 

nacional. 

 

o Consulta y respuesta a solicitudes de información geográfica 

precisa. 

  

 Pregunta 4 

 

Entre las ventajas se encuentran: 

 

o Ahorrar tiempo y utilizarlo como una herramienta para la solución 

de problemas, que de otra manera no se puede visualizar en 

mapas de formato papel, ya que no habría interrelación de las 

distintas capas.  

 

o Trabajar con información georeferenciada. Esto es muy importante 

porque toda la información que produce el IGN, lleva estándares 

de calidad, precisión y exactitud.   
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o Poder segregar e integrar a la vez la información geográfica, en 

capas y la relación que se puede hacer de la información 

plasmada en los mapas relacionarla directamente con su base de 

datos asociada, todo en un solo programa informático. 

  

 Pregunta 5 

 

No se conoce alguna desventaja. 

 

Entre los proyectos ejecutados por el IGN durante el 2012 se pueden 

mencionar los siguientes: 

 

o Actualización del Diccionario Geográfico de 13 municipios del 

departamento de Escuintla. 

 

o Caracterización urbana de la ciudad de Chimaltenango, 

departamento de Chimaltenango. 

 

o Generación de la base de datos de límites municipales a escala          

1:50 000. 

 

o Actualización cartográfica y base de datos del área metropolitana 

de la ciudad de Guatemala. 
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3.7.2. Comisión Nacional para la Reducción de   Desastres 

(CONRED) 

 

La CONRED fue creada como la entidad encargada de prevenir, mitigar, 

atender y participar en la rehabilitación y reconstrucción de los daños derivados 

de la presencia de los desastres.  

 

El Sistema de Información Geográfica (SIG) de la Secretaría Ejecutiva de 

la Coordinadora Nacional para la Reducción de Desastres (CONRED) es un 

sistema computarizado de adquisición, almacenamiento, análisis y despliegue 

de datos geográficos relacionados con desastres que sirve como una 

herramienta  para la toma de decisiones. 

   

Para obtener información acerca de SIG CONRED se necesitó la 

colaboración de Antonio Pacheco, Técnico en Sistemas de Información de esta 

institución y como complemento se visitó la página web 

http://www.conred.gob.gt/www/index.php?option=com_content&view=article&id

=863:sig&catid=6:contenido. Las respuestas fueron las siguientes: 

 

 Pregunta 1 

 

Dependiendo del tipo de análisis que se necesite hacer, en algunas 

ocasiones se utiliza ArcGis versión 10, también se utilizan otros como Quantum 

GIS (QSIG), gvSIG, entre otros. 

 

 Pregunta 2 

 

La CONRED incorporó el uso de la cartografía digital desde sus inicios en 

1996, intensificando su uso para la elaboración de diversos análisis a partir del 

http://www.conred.gob.gt/www/index.php?option=com_content&view=article&id=863:sig&catid=6:contenido
http://www.conred.gob.gt/www/index.php?option=com_content&view=article&id=863:sig&catid=6:contenido
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2001 aproximadamente y se inició con la elaboración de mapas de amenaza 

por inundaciones y posteriormente de amenaza volcánica. 

 

 Pregunta 3 

 

La aplicaciones del SIG CONRED, son múltiples, se utiliza para la 

elaboración de mapas temáticos de diversa índole de todo el territorio nacional, 

por ejemplo, la elaboración de mapas sobre los distintos eventos que amenazan 

al país como riesgo sísmico, deslizamientos e inundaciones, zonas propensas a 

heladas, así como mapas de ubicación de incidentes de eventos ocurridos 

durante el año, monitoreo de incendios forestales,  de eventos en situaciones 

de alerta a través de sensores remotos (imágenes de satélite) y su 

representación geográfica; análisis y desarrollo geográfico para identificación de 

amenazas naturales y vulnerabilidades y riesgo estructurales, sobre vuelos 

digitales, apoyar al Centro de Operaciones de Emergencia (COE) permanente 

con datos geográficos relacionado con distintos eventos de monitoreo. 

 

 Pregunta 4 

 

Con el manejo de capas de información geográfica que han sido 

proporcionadas a la CONRED, por otras Instituciones del sistema, se obtienen 

múltiples ventajas, ya que a través de la combinación y análisis de las mismas, 

se han elaborado mapas diversos sobre amenazas y riesgos a los que está 

expuesto el territorio nacional. 
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 Pregunta 5 

 

En algunos casos la desventaja o inconveniente que se ha tenido es la 

obtención de capas que son elaboradas por otras instituciones del Sistema 

CONRED. 

 

Es de relevancia conocer que el Sistema de Información Geográfica de la 

CONRED coordina con otras  instituciones del Estado como: 

 

 Instituto Geográfico Nacional (IGN). 

 Instituto Nacional de Estadística (INE). 

 Instituto Nacional de Sismología, Vulcanología, Meteorología e 

Hidrología (INSIVUMEH). 

 Ministerio de Agricultura, Ganadería  y Alimentación (MAGA). 

 Ministerio de Educación (MINEDUC). 

 Ministerio de Salud Pública y Asistencia Social (MSPAS). 

 Secretaría de Planificación y Programación de la Presidencia de la 

Republica (SEGEPLAN). 

 Tribunal Supremo Electoral (TSE). 

 Universidades del país.   

  

Los usuarios del SIG CONRED son: 

  

 Direcciones internas de la SE-CONRED 

 Instituciones Gubernamentales 

 Municipalidades 

 Público en General 

 Sedes Regionales de CONRED 

 Universidades del país 
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3.7.3. Ministerio de Agricultura, Ganadería y Alimentación 

(MAGA) 

 

Para obtener información acerca de SIG en el MAGA, se necesitó la 

colaboración del ingeniero Rovoham Monzón y como complemento se consultó 

la página web: http://www.sigmaga.com.gt/vision_mision.html. Se obtuvo lo 

siguiente: 

 

 Pregunta 1 

 

El software que se utiliza es ArcGis 9.3, Erdas Imagine, ErMapper, 

ArcView 3.2. 

 

 Pregunta 2 

 

De acuerdo al Artículo 22 del Acuerdo Gubernativo No. 338-2010, se creó 

oficialmente la Dirección de Información Geográfica, Estratégica y Gestión de 

Riesgo (DIGEGR) del MAGA, aunque se utilizan SIG en el MAGA desde 1999. 

 

 Pregunta 3 

 

Entre las aplicaciones que tiene DIGEGR del MAGA está generar, 

procesar y difundir información geográfica, estadísticas agropecuarias y de 

gestión de riesgo, de tal forma que el procesamiento y análisis de la información 

permita realizar propuestas estratégicas y de coyuntura en apoyo a los 

subsectores agrícola, pecuario, forestal e hidrobiológico del país. 

 

 

 

http://www.sigmaga.com.gt/vision_mision.html
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 Pregunta 4 

 

Entre las ventajas se encuentra el cumplimiento a las distintas 

aplicaciones por medio de la formulación del Plan Operativo Anual, que 

contempla dentro de sus líneas estratégicas de acción, la formulación de 

estudios y proyectos que mediante su ejecución permitan obtener información 

temática de aspectos vinculados a la agricultura, manejo de los recursos 

naturales, seguridad alimentaria, gestión de riesgo del sector agropecuario y 

otros. 

 

Por ejemplo, en el 2011 se llevó a cabo un proyecto que consistía en la 

elaboración del Mapa de Taxonomía de Suelos y Capacidad de Uso de la Tierra 

a escala 1:50 000 de la República de Guatemala, en el cual se realizó un 

estudio semidetallado de los suelos del departamento de Sacatepéquez, 

Guatemala, del departamento de Sololá, Guatemala y del departamento de 

Guatemala, Guatemala. 

 

 Pregunta 5 

 

La desventaja es que la mayoría de usuarios no diferencia que la 

información geográfica y el nivel de detalle está vinculado a las escalas 

de levantamiento de información, por lo que se mezclan mapas de 

diferentes escalas. 
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3.7.4. Instituto Nacional de Sismología, Vulcanología, 

Meteorología e Hidrología (INSIVUMEH) 

 

El INSIVUMEH fue creado por medio del Acuerdo Gubernativo del 26 de 

marzo de 1976 y forma parte del Ministerio de Comunicaciones, Infraestructura 

y Vivienda. Coordina servicios con el sector privado, actuando como asesor 

técnico del Gobierno en caso de desastres naturales, planificando, diseñando y 

ejecutando estudios y monitoreos sistematizados con tecnología adecuada, 

enriqueciendo las bases de datos y sistemas de información geográfica 

referencial del país, a través de sus redes de información en todas las escalas 

espaciales y temporales que le es posible obtener con la tecnología disponible. 

 

Trabaja en cooperación en la generación, análisis y transferencia oportuna 

de información a CONRED en lo relacionado con  amenazas causadas por 

fenómenos naturales como huracanes, tormentas tropicales, lluvias intensas 

locales, inundaciones, desbordes de ríos, erupciones volcánicas, sismos, 

lahares y deslizamientos. 

 

A diferencia de otras instituciones, el INSIVUMEH no tiene una unidad 

específica que se dedique a lo concerniente a los Sistemas de Información 

Geográfica. Para llevar a cabo los estudios y proyectos relacionados con estos 

sistemas, cada unidad que conforma a esta institución realiza de forma 

independientemente lo que a cada una compete. 

 

Para obtener información acerca de SIG en el INSIVUMEH se necesitó la 

colaboración del ingeniero Sergio López Dubón de la Unidad de Hidrología; de 

Walter Bardales, asesor en Agrometeorología de la sección de Climatología de 

la Unidad de Meteorología y Climatología, y de Francisco Valdés, técnico en 

Geo-Física de la sección de Sismología. Como complemento se visitó la página 
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web del INSIVUMEH específicamente con ayuda del documento que presenta 

las funciones generales que cada departamento desempeña. Las respuestas 

fueron las siguientes: 

 

 Pregunta 1 

 

Según la ocasión el software utilizado en cada una de las unidades es 

ArcGis versión 8 y Quantum Gis. 

 

 Pregunta 2 

 

Se introdujo el uso de Sistemas de Información Geográfica en el 2003 

aproximadamente. 

 

 Pregunta 3 

 

Unidad de Hidrología: georeferenciar las estaciones meteorológicas, realizar 

boletines del comportamiento de los ríos comparado con estadísticas de años 

anteriores, emulaciones utilizando raster proporcionado por el IGN, delimitación 

de cuencas hidrográficas, control de calidad del agua, con el fin del desarrollo 

productivo del país, así como para la prevención y monitoreo de amenazas 

naturales. 

 

Unidad de Climatología: análisis raster isoyetas, isotermas, isobaras. Cantidad 

de lluvia diaria, acumulada, porcentaje de lluvia, índice de sequía meteorológica 

cuando inicia el invierno, delimitación de zonas homogéneas, zonas de 

pronóstico, identificar zonas donde iniciará antes la lluvia. La estadística se 

elabora en papel y luego se ingresan a las bases de datos para darle un uso 
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posterior en el software específico. También se analizan las zonas probables de 

inicio de canícula y finalización de época lluviosa. 

 

 Pregunta 5 

 

El cambio generacional pues algunas personas aún no están capacitadas 

para trabajar con Sistemas de Información Geográfica, no se tiene equipo de 

cómputo suficiente y/o de buen estado para todo el personal que trabaja en el 

Departamento de Investigación y Servicios Hídricos, se cuenta con mucha 

información histórica únicamente en papel, siendo necesaria su digitalización 

para la generación de estudios y como parte del rescate de información. 

 

3.7.5. Otras instituciones que utilizan Sistemas de 

Información Geográfica en Guatemala 

 

De lo anteriormente descrito, es evidente que la información espacial 

juega un papel importante en las instituciones públicas, privadas o no 

gubernamentales en las cuales se necesita información para tomar algún tipo 

de decisión. A continuación se enlistan otras instituciones que utilizan SIG en 

Guatemala. 

 

Sector público 

 

 Consejo Nacional de Áreas Protegidas (CONAP) 

 Departamento Geográfico Militar (ver anexo) 

 Instituto Nacional de Electrificación (INDE) 

 Instituto Nacional de Bosques (INAB) 

 Instituto Nacional de Estadística (INE) 

 Ministerio de Ambiente y Recursos Naturales (MARN) 
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 Ministerio de Comunicaciones Infraestructura y Vivienda (MICIVI) 

 Ministerio de Cultura y Deportes 

 Ministerio de Educación (MINEDUC) 

 Ministerio de Energía y Minas (ver anexo) 

 Ministerio de Defensa Nacional 

 Ministerio de Salud Pública y Asistencia Social (MSPAS) 

 Policía Nacional Civil (PNC) 

 Programa Nacional de Autogestión para el Desarrollo Educativo 

(PRONADE) 

 Secretaría de Análisis Estratégico 

 Secretaría de la Paz 

 Secretaría de Planificación y Programación de la Presidencia 

(SEGEPLAN) 

 Universidad de San Carlos de Guatemala (USAC) 

 UTJ / Protierra (Catastro Nacional) 

 Registro de Información Catastral (RIC) 

 

Sector privado 

 

 Agropecuaria Eslovaquia 

 Albor S.A. 

 APESA 

 Avícola Villalobos  

 Cabcorp (Pepsi) 

 Corporación de Noticias 

 Comtech – Telgua 

 El Periódico  

 Ingenio Pantaleón 
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 Malher 

 Perenco 

 Unión Fenosa, S.A. 

 Siglo XXI 

 ICASA (Cervecería Centroamericana) 

 

Sector no gubernamental 

 

 Agencia de Cooperación Internacional del Japón (JICA) 

 Agencia Española de Cooperación Internacional (AECI) 

 AID 

 Asociación Nacional del Café (ANACAFÉ)  

 CARE 

 Cuerpo de Paz 

 Facultad Latinoamericana de Ciencias Sociales (FLACSO) 

 Fundación para el Ecodesarrollo y la Conservación (FUNDAECO) 

 GTZ Cooperación Alemana (Salud y Catastro) 

 IGER 

 Programa MOSCAMED 

 Naciones Unidas 

 Organización Mundial de la Salud (OMS) 

 Programa de las Naciones Unidas para el Desarrollo (PNUD) 

 Proyecto EPSUM 

 Universidad del Valle de Guatemala 

 Universidad Galileo 

 Universidad Rafael Landívar 
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4. SOFTWARE ARCGIS 9.1 

 

 

 

4.1. Descripción del software 

 

ArcGis es el paquete más conocido de ESRI (Enviromental Systems 

Research Institute) que es una de las compañías líderes de comercialización de 

software de Sistemas de Información Geográfica. ArcGis está compuesto por 

tres partes principales, ArcGis Desktop que es el conjunto de aplicaciones SIG 

integrados y en el que se hará énfasis; ArcSDE gateway que consiste en la 

interfaz para el manejo de Geodatabases multiusuarios en un sistema de 

manejo de base de datos y ArcIMS, que es la aplicación basada en Internet 

para la distribución de datos y servicios.    

  

4.1.1. ArcGis Desktop 

 

Es un conjunto de aplicaciones integradas: ArcMap, ArcCatalog y 

ArcToolbox, las cuales trabajan en conjunto incluyentes unas con otras, con el 

fin de desarrollar todas las funciones propias de un SIG, manejando la 

información geográfica desde una muy simple hasta una muy avanzada, 

incluyendo edición y creación de mapas, manejo de datos, análisis geográfico, 

edición de datos y geoprocesos. 

  

4.1.2. ArcMap 

 

Es una aplicación de ArcGis Desktop, que se utiliza esencialmente para el 

mapeo digital, se utiliza tanto para entrada de datos, búsquedas estadísticas y 

geográficas, además de output (mapas impresos). ArcMap es la aplicación 
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central que ArcGis Desktop utiliza para todas las actividades relacionadas a la 

cartografía, análisis de mapas y edición. Ofrece dos formas de ver un mapa las 

cuales se detallan en el capítulo 4.4.2.:  

 

 Una vista de datos geográficos (Data). 

 Una vista del diseño del cartográfico (Layout), en la cual se pueden 

desarrollar un amplio rango de funciones avanzadas de SIG. 

 

4.1.3. ArcCatalog 

 

Esta aplicación de ArcGis está diseñada para facilitar la exploración y 

organización de los distintos datos contenidos en ArcGis, además administra los 

esquemas de la Geodatabase, también administra los servidores GIS (WMS, 

por ejemplo). ArcCatalog permite un acceso al disco duro para el manejo de la 

información cartográfica, puede decirse que es una aplicación semejante al 

explorador de Windows, aunque proporciona el acceso de forma más fácil y 

segura.  

 

4.1.4. ArcToolbox 

 

Es una aplicación que proporciona las herramientas para realizar cualquier 

proceso en ArcGis, se utiliza en el geoprocesamiento de datos. Las  

herramientas utilizadas en el presente trabajo son las que combinan atributos, 

capas, manipulan datos, definen y transforman sistemas de coordenadas, entre 

otras.  
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4.2. Interfaz del usuario 

 

Como se describió anteriormente, ArcGis Desktop tiene tres aplicaciones 

principales; ArcMap, ArcCatalog y ArcToolbox, estas tienen una interfaz gráfica 

del usuario predeterminada que facilita e incrementa la productividad trabajando 

juntas para ayudar a interactuar con los SIG a través de métodos básicos, 

mapas, datos y herramientas. La interfaz de ArcMap se detalla en el capítulo 

4.4.1.  

 

Figura 20. Interfaz de ArcCatalog 

 

 

 

Fuente: elaboración propia, utilizando ArcCatalog. 
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La interfaz de ArcCatalog es como se muestra en la figura 20, en la 

pestaña Contents se observa el listado de los distintos shapes, en Preview se 

observa la apariencia de cada capa y en Metadata se observa la descripción, la 

referencia espacial, y los atributos. 

 

Figura 21. Interfaz de ArcToolbox 

 

 

 

Fuente: elaboración propia, utilizando ArcToolbox. 

 

Se puede visualizar ArcToolbox por medio del botón que se muestra en la 

figura 21. Una vez abierto, la búsqueda de comandos se podrá hacer mediante 

Favorites, que corresponde a la ruta propia de cada herramienta o utilizando 
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Index, que es el índice donde se colocan las primeras letras del nombre de la 

herramienta y aparece el listado, el Index es un acceso más eficiente utilizada 

cuando se conoce solamente el nombre de la herramienta, pero se desconoce 

en qué parte del ArcToolbox está ubicada. 

 

4.3. Sets de datos de ArcGis 9.1 

 

Existen distintas formas en la que se guarda la información en ArcGis 9.1 

según la codificación de los datos geográficos, a continuación se detallan las 

principales características de almacenamiento. 

 

4.3.1. Codificación de los datos geográficos 

 

La forma en que se guarda la información que representa los datos tiene 

dos formas, la representación vectorial y raster, el funcionamiento de ambas 

como tal, fue explicado en los capítulos 3.4.1 y 3.4.2, respectivamente. A 

continuación se detalla su importancia en ArcGis. 

 

4.3.1.1. Representación vectorial 

 

El modelo vectorial constituye una codificación de los datos geográficos en 

la que se representa una variable geográfica por su geometría, 

independientemente de su escala y son almacenados con un formato digital 

fácilmente convertible en un dibujo; las porciones del territorio y su 

representación digital suelen constituir una lista de coordenadas de puntos y 

vértices que definen la geometría de los elementos. Su codificación se realiza a 

través de una base de datos de tipo relacional asociada a la representación 

gráfica. 
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En ArcGis el formato vectorial más utilizado es el shapefile (.shp) y es el 

formato de almacenamiento digital donde se guarda la localización de los 

elementos geográficos y los atributos asociados a ellos. Un shapefile es 

generado por varios archivos y tienen las extensiones siguientes: 

 

 .shp – archivo que almacena las entidades geométricas de los objetos. 

 .shx – archivo que almacena el índice de las entidades geométricas. 

 .dbf – base de datos, archivo que almacena la información de los 

atributos de los objetos. 

 .prj – guarda la información referida a sistemas de coordenadas. 

 

Dentro de los elementos gráficos que pueden hacer referencia a un 

elemento geográfico, el modelo vector puede ser de puntos, líneas o polígonos, 

y para identificar cada uno de ellos en ArcCatalog o cuando se agregan en 

ArcMap es por medio de los íconos que los representan, como se observa en la 

figura 22. 

 

Figura 22. Shapefiles. Puntos, líneas y polígonos 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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 Puntos (nodos): corresponde a un punto, los campos que constituyen la 

tabla de atributos contienen campos como Id, que es un identificador del 

punto, con un valor entero y único para cada uno; coordenada X, 

coordenada Y, ambas del sistema de referencia para el punto; tipo de 

punto que se representa y texto del usuario. 

 

 Líneas (arcos): corresponden a segmentos unidos de forma consecutiva 

que determinan elementos geográficos lineales y se definen en función 

de un punto inicial y uno final. Los campos que constituyen la tabla de 

atributos contienen campos como Id, longitud de la línea en unidades 

definidas, identificador del punto inicial y punto final y texto usuario. 

 

 Polígonos: corresponden al área delimitada por una o varias líneas. Los 

campos que constituyen la tabla de atributos contienen campos como 

identificador del polígono, único para uno; perímetro, área y texto del 

usuario. 

 

4.3.1.2. Representación raster 

 

Un archivo raster puede identificarse en ArcCatalog o cuando se agrega 

en ArcMap, por medio del ícono que lo representa, como se observa en la figura 

23. El resultado de la codificación raster es una discretización tanto de las 

coordenadas de los elementos constitutivos del mapa obtenido como de la 

variable representada. Por tanto los cálculos y medidas serán aproximaciones a 

la realidad con cierto error, que depende de la precisión de la malla o rejilla. 

Algunos formatos muy utilizados: jpeg, png, tiff, entre otros de imagen. 
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Figura 23. Archivos raster 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

4.3.1.3. Variables geográficas 

 

Una variable geográfica es una colección de valores de una determinada 

característica en un conjunto de celdas espaciales. Las variables se localizan 

normalmente mediante el registro de coordenadas  

 

 Según la cantidad de espacio en la que se extienden se agrupan en: 

 

o Datos puntuales o de lugar: suponen la posición y no la superficie 

que ocupan los datos en el espacio. 

 

o Datos lineales: indican el curso y dirección que sigue un objeto sin 

conocer la superficie que ocupa, por ejemplo, ríos y medios de 

transporte. 
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o Datos zonales: indican la extensión del área que ocupa un hecho, 

fenómeno, por ejemplo, clima, vegetación, etc. 

 

o Datos volumétricos: pretenden representar cantidades localizadas 

de un fenómeno específico, como las poblaciones, precipitaciones, 

etc. 

 

 Según la forma en que se extienden en el espacio geográfico pueden 

ser: 

 

o Discretos o discontinuos: son aquellos cuyo valor no puede ser un 

número decimal sino un número entero, por ejemplo, número de 

habitantes y cantidad de edificios. 

 

o Continuos o superficiales: son valores que cambian continuamente 

respecto a su posición espacial, por ejemplo, temperaturas, 

densidades de habitantes y precipitación. 

 

o Uniformes: por ejemplo, gradientes de presión. 

 

o No uniformes: por ejemplo, usos de suelo. 

 

 Según su ordenación espacial o topológica pueden ser: 

 

o Cualitativas 

o Cuantitativas 
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4.4. Visualización de datos 

 

ArcGis permite visualizar datos espaciales por medio de sus 

componentes. ArcMap es la interfaz más utilizada en la que el usuario puede 

visualizar la información. 

 

4.4.1. Interfaz de ArcMap 

 

La información geográfica se muestra en capas o layers. Cada capa 

representa un tipo particular de datos, por ejemplo, usos del suelo, división 

político-administrativa, entre otras. Las capas en la tabla de contenidos, se 

organizan en el Marco de Datos o Data Frame para ser visualizadas de forma 

conjunta y ocupar una misma área geográfica, a este se le pueden añadir tantas 

capas como se desee.  

 

Figura 24. Botón Add Data 

 

 

 

Fuente: elaboración propia. 

 

Para cargar una nueva capa en la interfaz de ArcMap, se hace por medio 

del botón Add Data o Agregar Datos, como se observa en la figura 24. Esta 

opción permite acceder a los archivos almacenados en los directorios de la 

computadora, y al seleccionar el archivo deseado, este aparece en la tabla de 

contenidos y en el área de visualización.  
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Figura 25. Interfaz de ArcMap 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Los componentes de la interfaz de ArcMap se muestran en la figura 25 y 

son las siguientes: 

 

 a - Barra de título: muestra el nombre del mapa (archivo .mxd en el que 

se está trabajando). 

 b - Barra de herramienta Tools: esta barra permite la navegación sobre el 

documento del mapa y siempre deberá ser visible. 

 c - Tabla de contenidos o Table of Contents (TOC): lista el orden de 

visualización de los datos y las leyendas de las capas.  
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 d - Área de visualización (Map Display): es donde se dibujan y disponen 

las capas georeferenciadas y los elementos del mapa. 

 e - Barra de estado: informa las coordenadas y muestra una descripción 

de los botones e ítems seleccionados del menú. 

 

4.4.2. Presentación gráfica 

 

En ArcGIS, la fase de preparación de las capas se hace trabajando sobre 

la vista del mapa (Data View), esta sub interfaz sirve para mostrar, hacer 

cambios, ingresar datos, hacer búsquedas geográficas o en las tablas de 

atributos. El diseño del mapa se hace trabajando en la ventana del layout 

(Layout View).  

 

Para que el usuario pueda pasar de una ventana a otra, se utilizan los 

botones que aparecen en la esquina inferior izquierda de la pantalla o por medio 

del Menú View, como se observa en la figura 26. 

 

Figura 26. Ubicación de Layout View y Data View 

 

   

Fuente: elaboración propia, utilizando ArcMap. 
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4.5. Manejo de tablas 

 

Las tablas contienen información descriptiva asociada a los elementos 

geográficos contenidos en las capas de información y se componen de filas y 

columnas.  

 

 Identify 

 

Este botón, que se observa en la figura 27, se utiliza para identificar o 

conocer qué es el objeto seleccionado. Se encuentra en el Menú Tools y es 

utilizado para recuperar los atributos o propiedades de un objeto. Los atributos 

se muestran en una ventana que muestra sólo las propiedades de los objetos 

investigados. 

 

Figura 27. Botón correspondiente a la herramienta Identify 

 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

http://www.gratisweb.com/arcgis/tav_ferr.htm#interface.html#interface
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 Open Attribute Table 

 

La tabla de atributos se utiliza para visualizar todos los atributos o 

características de una capa determinada. Se encuentra desplegando el menú 

contextual de la capa (dando clic derecho en el nombre de la capa ubicada en 

la tabla de contenidos), como se muestra en la figura 28. 

 

Figura 28. Open Attribute Table 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Select by attributes 

 

En la consulta en la base de datos, ArcGis emplea el lenguaje estándar 

SQL (Structured Query Language), como se muestra en la figura 29. 
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Figura 29. Select By Attributes 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

  

Los operadores relacionales vienen incluidos en la interfaz, lo que permite 

realizar las consultas de manera sencilla, ocasionando que el atributo que sea 

seleccionado satisfaga un criterio específico para que sean destacados con 

color celeste posteriormente en la capa de despliegue. Los elementos que 

conforman Select By Attributes se describen en la tabla XV.  
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Tabla XV. Elementos de Select By Attributes 

 

Elementos 
según 

figura 51 
Descripción 

1 Layer: Se selecciona la capa a la que se desea hacer la consulta 

2 
Fields: Se muestran todos los campos de la capa 
y se selecciona el campo deseado con doble clic. 

3 

S
e

 s
e

le
c
c
io

n
a
 e

l 
o
p

e
ra

d
o

r 
q
u
e

 

s
e

 u
ti
liz

a
rá

 p
a

ra
 h

a
c
e

r 
la

 c
o

n
s
u

lt
a

. 

= Igual que 

< > Diferente 

> Mayor que 

>= Mayor o igual que 

< Menor que 

< = Menor o igual que 

AND 
El resultado es verdadero si se cumplen las 

dos condiciones 

OR 
El resultado es verdadero si se cumple por 

lo menos una de las condiciones 

Like Como 

_ Representa cualquier letra o número 

% 
Representa cualquier conjunto de 

caracteres o números. 

( ) Permiten modificar el orden de evaluación 

Not Negación 

4 
Get Unique Values: Se utiliza para obtener todos los registros que 

pertenecen a un atributo seleccionado de la capa. 
Para seleccionar uno se hace por medio de doble clic. 

5 

Debe seguir la siguiente estructura: 
SELECT * FROM <tabla> WHERE <condición> 

Por medio de este lenguaje se seleccionarán los registros de la 
tabla seleccionada que cumplan con la condición que estará 

formada por campos, operadores y valores. Si el campo coincide 
con el valor el resultado será verdadero y el registro se marcará 

con color celeste. 
 

Fuente: elaboración propia. 
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4.6. Cambio de proyección de mapas 

 

ArcGis tiene funciones específicas de cambio de proyección que permite 

la transformación del sistema de referencia de coordenadas de un mapa digital 

a otro sistema, sin modificar su forma. El cambio de proyección se limitará a 

seleccionar la nueva proyección y sus parámetros. ArcGis cuenta con una base 

de datos con las proyecciones y parámetros más habituales. Debido a que la 

proyección GTM no está incluida en la base de datos, el software permite la 

introducción de los parámetros manualmente. 

 

El desconocimiento sobre los parámetros cartográficos es una fuente 

común de error, por esta razón es necesario conocer los efectos que se 

producen cuando la cartografía cambia de un sistema de referencia a otro. 

Usualmente estos cambios se ven reflejados en la forma, cambios en la 

distancia y en el área entre los diferentes elementos que componen al mapa y 

en su dirección.  

 

4.6.1. Sistemas de coordenadas 

 

Para definir el sistema de coordenadas de una capa ya existente, es 

necesario conocer su origen (como se explicará a detalle en el capítulo 5.6.), si 

la capa es creada por medio de ArcCatalog, el sistema de referencia de 

preferencia debe ser asignado en el momento de la creación. El sistema de 

coordenadas se puede definir de dos formas diferentes: 

 

 Asignar un sistema de coordenadas predefinido 

 Crear un nuevo sistema de coordenadas 
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ArcMap tiene la cualidad de mostrar un mensaje de advertencia al usuario 

al cargar una capa que no tiene información sobre su referencia espacial, y por 

tanto, los datos no podrán ser proyectados. Esto no impide poder trabajar con 

estos normalmente, aunque si impedirá alinear esos datos con otros que tengan 

un sistema de coordenadas distinto. 

 

4.6.2. Proyecciones cartográficas 

 

Las proyecciones son sistemas que reproducen la esfera tridimensional de 

la superficie de la Tierra en las dos dimensiones de un mapa. Al realizar una 

proyección, los atributos del globo terráqueo (por ejemplo, meridianos, paralelos 

y límites entre países) sufren distorsiones de forma, área, distancia o dirección. 

Existen distintas clases de proyección que atacan uno o más tipos de distorsión 

pero no hay ninguna que corrija todas a la vez. 

 

 Proyecciones en ArcGis 

 

Para conocer la proyección de una capa determinada en ArcGis se hace 

por medio de sus propiedades (como se explica en el ejercicio 2 del capítulo 

5.6.4.). ArcGis está diseñado para colocar una capa en el sitio correcto aunque 

esta tenga una proyección distinta, siempre y cuando la capa tenga alguna 

proyección definida. Sin embargo, lo que no se puede permitir es dejar capas 

sin proyección. En formato vectorial la proyección queda almacenada en un 

archivo .prj.  

 

Si la capa no tiene la proyección que se requiere puede ser necesaria 

alguna de las acciones que se presentan en la tabla XVI. 
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Tabla XVI. Acciones a tomar si una capa no tiene proyección definida 

 

Situación Acción 
Cómo llegar desde 

ArcToolbox 
Parámetros a 

seguir 

La capa no 
tiene 

información del 
sistema de 

coordenadas 
pero se sabe 

que 
corresponde al 

sistema 
requerido. 

 

S
e

 l
e

 d
e

fi
n
e

 l
a

 

p
ro

y
e

c
c
ió

n
 

 

 
 

 

Se pedirá solamente 
la capa y el sistema 

de coordenadas 

La capa tiene 
información de 

proyección pero 
no es la 

proyección 
requerida S

e
 r

e
p

ro
y
e

c
ta

 

 

 

Se pedirá: 
- Capa a 

proyectar 
- Nombre 

archivo de 
salida 

- A qué sistema 
de 
coordenadas 

- Qué 
transformación 

La capa no 
tiene 

información de 
proyección y se 
sabe que está 
en un sistema 

diferente al 
requerido 

S
e

 l
e

 d
e

fi
n
e

 l
a

 p
ro

y
e

c
c
ió

n
 y

 

lu
e

g
o
 s

e
 r

e
p

ro
y
e

c
ta

 

 

 

 

 

Fuente: FRANCO, Rodolfo. Proyecciones y datums en ArcGis. p. 4. 
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4.6.3. Datum 

 

Los mapas son dibujados con respecto a un punto de referencia llamado 

datum; una misma posición real, contendrá valores de coordenadas diferentes 

si se expresan en dos datum diferentes. Un datum define la posición del origen, 

la escala y la orientación de los ejes de un sistema de coordenadas. 

 

La necesidad de integrar toda la información en un solo sistema de 

proyección y datum que permite administrar y analizar los datos de manera 

estandarizada, radica en que un usuario puede obtener datos o capas digitales 

que pueden tener georeferencia distinta y tener las mismas en ArcGis con 

datums diferentes, que provenga de imágenes, datos tabulares, digitales o de 

trabajo de campo como por ejemplo de GPS. 

 

4.6.4. Escala 

 

El Data Frame posee propiedades tales como la escala de referencia y la 

escala de despliegue.  

 

La escala de referencia permite provocar que los símbolos puntuales y 

lineales cambien de tamaño en forma proporcional a la escala de despliegue de 

la vista. Esta opción de escala de referencia se configura en las propiedades del 

Data Frame. A mayor valor en el denominador de esta escala, mayor será el 

tamaño de los símbolos. 
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Figura 30. Escala de referencia 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

La introducción de una escala de referencia provoca que las etiquetas 

cambien su tamaño en forma proporcional a la escala de la vista y cuando se 

realiza un acercamiento o alejamiento en la vista el tamaño de las etiquetas no 

cambia, lo que ocasiona que se vean demasiado grandes o demasiado 

pequeños con respecto al resto del mapa. Un ejemplo de escala de referencia 

se observa en la figura 30. 

 

4.7. Diseño gráfico 

 

El último paso de un proyecto en ArcGis consiste en diseñar los mapas y 

su importancia radica en que los resultados de todo el trabajo serán reflejados 

en estas salidas gráficas. Es importante considerar que el tiempo necesario 
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para realizar esta labor correctamente es largo en comparación con las demás 

fases del proyecto. 

 

En el momento en que se ingresa en el Layout (ver capítulo 4.4.2.), 

aparece una barra de herramientas, como se observa en la figura 31, que 

permite hacer Zooms a la hoja, moverse por el mapa, etc., sin modificar la 

escala de impresión. 

 

Figura 31. Barra de herramientas de Layout 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Los mapas generados en la vista de Layout pueden imprimirse o 

exportarse a archivos de imagen, por ejemplo, .pdf, .bmp, .jpg, entre otros. 

 

4.7.1. Elementos básicos de un mapa 

 

En el Layout deben definirse e incorporarse los elementos básicos de un 

mapa. El Menú Insert que se observa en la figura 32, contiene las opciones 

necesarias para incorporar: Data Frame, título, texto, leyenda, norte, escala, 

texto de escala, imagen y objeto.  

 

 

 



109 
 

Figura 32. Menú Insert 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Los elementos básicos se describen a continuación: 

 

 Tamaño de la hoja, márgenes 

 

Este es el primer paso a realizar previo al diseño que se realiza en las 

propiedades del layout, se hace por medio del Menú File en la opción Page and 

Print Setup y ahí se configuran todas las propiedades de la hoja que se 

imprimirá posteriormente. 

 

 Mapa de situación  

 

Por medio de la opción Data Frame se puede insertar un mapa de 

situación, con la finalidad de almacenar información a una escala más amplia 

que la utilizada para presentar el mapa principal. Por ejemplo, si se está 

trabajando en un mapa correspondiente a un departamento, el mapa de 
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situación puede mostrar el país señalando el departamento, para que el usuario 

final que observa el mapa, pueda ubicarse fácilmente. 

 

 Título 

 

La opción Title permite incorporar al mapa el título, el cual es el nombre 

del mapa que indica el contenido del mismo, por defecto aparece situado 

centrado en la parte superior de la hoja, aunque su ubicación dependerá de los 

gustos o preferencias del diseñador cartográfico. 

 

 Leyendas, simbología 

 

La opción Legend permite incorporar la leyenda al mapa, por medio de un 

asistente que facilita al usuario esta tarea. La leyenda, como otros elementos 

del layout, es interactiva, esto permite que los cambios que se realicen en las 

capas del mapa se representen en la leyenda, es decir, cada vez que el usuario 

hace un cambio en la capa utilizada, la leyenda correspondiente a esa capa se 

actualiza.  

 

También se puede utilizar la opción de convertir la leyenda en un gráfico 

para mejorar algunos aspectos de la misma. Esto no es siempre útil pues se 

desvincula la leyenda del mapa, y deja de actualizarse al efectuar nuevos 

cambios, como se explicó en el párrafo anterior. 

 

 Orientación (Norte) 

 

Al igual que la leyenda es interactivo. Se introduce en el mapa por medio 

de la opción North Arrow y es un elemento orientativo que no debe faltar en un 
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mapa. Es importante evitar que sea muy grande y su ubicación dependerá de 

las preferencias del diseñador cartográfico.  

 

 Escala  

 

Por medio de la opción Scale Bar se puede seleccionar el estilo de la 

escala gráfica, las unidades de medida, el número de intervalos, la ubicación 

del texto de la unidad de medida y el espaciamiento entre el gráfico de la escala 

y los textos que lo acompañan. Respecto a estos textos, por medio de la opción 

Scale Text, el texto insertado queda vinculado a la escala gráfica, y varía 

automáticamente de acuerdo con los cambios de escala que se efectúen sobre 

la vista. 

 

Al imprimir el mapa es fundamental comprobar que la escala no ha sido 

deformada, para evitar consecuencias negativas en el desarrollo del proyecto al 

que va destinado el mapa. 

 

 Cajetín con información del proyecto realizado, logotipos 

 

Es importante que dentro del mapa aparezca información cartográfica 

referente al mapa, por ejemplo, el sistema de coordenadas en que está 

definido, la proyección, datum, etc. También es importante la información 

personal o de la empresa. Para lograr esto, es necesario elaborar en el layout 

(dibujando gráficos del tipo líneas) un pequeño cuadro o cajetín que contenga 

esta información. Una vez creado el cajetín se añade dentro la información 

como texto y logotipos o fotografías (insertados como imágenes por medio de la 

opción Picture también incluida en el menú Insert) modificando el tamaño según 

el gusto del diseñador cartográfico. 
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 Grid o malla de coordenadas 

 

Se ingresa a esta opción por medio del Data Frame en la pestaña Grids. 

El grid o malla de coordenadas es un elemento fundamental, se utiliza para 

insertar una retícula en función del sistema de coordenadas utilizado. Se puede 

incluir más de un sistema de cuadrículas en un único mapa (por ejemplo, puede 

insertarse una retícula de coordenadas geográficas y otra de coordenadas en 

proyección UTM). Para modificar las propiedades de cada elemento el usuario 

debe dar doble clic o clic derecho> Properties. 
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5. EJERCICIOS REALIZADOS EN EL LABORATORIO           

   DE    CARTOGRAFÍA  DIGITAL  DEL   CURSO   DE  

   TOPOGRAFÍA 3 

 

 

 

5.1. Formato de resolución de ejercicios 

 

Es importante explicar el orden lógico que se utilizó para realizar cada una 

de las prácticas, esto ayuda a que el usuario comprenda cada uno de los 

procesos que se están llevando a cabo, teniendo clara la descripción de la 

práctica; las barras, comandos y herramientas a utilizar; las capas y la solución 

paso a paso. 

 

5.1.1. Descripción de la práctica 

 

En esta sección se dará la descripción de los distintos ejercicios que 

conforman cada una de las prácticas realizadas en el laboratorio de cartografía 

digital del curso Topografía 3, impartido en la Facultad de Ingeniería de la 

Universidad de San Carlos de Guatemala. 

 

5.1.2. Barras, comandos y herramientas a utilizar 

 

Por medio de tablas se explicarán las rutas de acceso para las distintas 

barras, comandos y herramientas desconocidas al momento de realizar cada 

uno de los ejercicios, con la finalidad de no duplicar información en cada 

práctica, estará ordenada alfabéticamente para facilidad del usuario para poder 

consultarlas cada vez que sea necesario. Asimismo, se explicará a detalle la 
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función de cada comando y herramienta, para que pueda utilizarse 

posteriormente en algún otro caso similar que se presente.  

 

5.1.3. Capas 

 

En esta sección se listará el nombre y la descripción de la información 

correspondiente de cada capa que se utilizará para llevar a cabo cada práctica. 

También se informa acerca de la página web en la que podrá descargarse la 

información, para que el usuario realice los ejercicios en conjunto con el 

presente manual. Cabe mencionar que la información de las capas es tomada 

de datos reales y fue proporcionada tanto por el ingeniero Gerson Díaz, asesor 

del presente trabajo, como por el ingeniero Daunno Chew. 

 

5.1.4. Solución 

 

Se presentarán las posibles soluciones paso a paso de los distintos 

ejercicios que conforman cada práctica basados en la descripción de la misma. 

Es importante mencionar que cuando el usuario no conozca la ruta de acceso 

de una barra, comando o herramienta, consulte la sección destinada para ello. 

 

Para verificar que los ejercicios realizados por el usuario están 

debidamente ejecutados, deberán revisarse las carpetas denominadas 

Solución, contenidas en las prácticas correspondientes en la página web. 

 

5.2. Fundamentos de cartografía digital 

 

La presente práctica aporta conocimientos relacionados con el 

funcionamiento básico del mismo, conociendo la forma de despliegue de la 
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cartografía realizada en formato shape, en programas de diseño asistido por 

computadora como AutoCAD y en hojas cartográficas previamente escaneadas. 

 

5.2.1. Descripción de la práctica 

 

Se recopiló información en distintos formatos con el objetivo de utilizarlos 

en ArcGis 9.1. Se desea desplegar cada uno de estos para su mayor 

aprovechamiento. 

 

 Ejercicio 1: SIG 

 

o Despliegue de cartografía en formato CAD 

o Despliegue de cartografía en formato shape 

o Despliegue una hoja cartográfica  

o Aplicación de simbologías 

o Georeferencia de mapa 1:50 000  

 

 Ejercicio 2: manipulación de atributos 

 

o Cálculo de atributo de área para shape de predios 

 

5.2.2. Barras, comandos y herramientas  

 

Las barras a utilizar en la presente práctica se describen en la tabla XVII. 

Se explicarán las rutas de acceso desconocidas hasta el momento para que el 

usuario se familiarice con las barras, comandos y herramientas. En las prácticas 

posteriores no se describirán a fin de no duplicar información, por lo que deberá 

consultarse el presente capítulo.  
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Tabla XVII.   Barras utilizadas en fundamentos de cartografía digital 

 

Barra Apariencia 

Georeferencing 
 

Main Menu 
 

Estándar 
 

Tools 
 

 

Fuente: elaboración propia. 

 

Los comandos/herramientas a utilizar en la presente práctica se describen 

en la tabla XVIII. 

 

Tabla XVIII.   Comandos y herramientas utilizados en fundamentos de  

      cartografía digital 

 

Comando / 
herramienta 

Icono Ruta de acceso 

Add Control Points 
  Barra Georeferencing> Add Control Points 

Add Data  Barra Standar> Add Data 

Tabla de contenidos - 
Barra Main Menu> Window> Table of 

Contents 

Clear Selected 
Features  Barra Tools> Clear Selected Features 

Fit to Display - 
Barra Georeferencing> Georeferencing> Fit 

to Display 

Full Extent  Barra Tools> Full Extent 

Input X and Y - Barra Georeferencing> Add Control Points 

Pan  BarraTools> Pan 

Propiedades de capa - 
Menú contextual (clic derecho) de una capa 

en la Tabla de Contenidos> Properties 

Rectify - 
Barra Georeferencing> Georeferencing> 

Rectify 
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Continuación de la tabla XVIII. 

Select Features  Barra Tools> Select Features 

Simbología de capa - Propiedades de capa> pestaña Symbology 

Tabla de atributos de 
una capa 

(Open Attribute Table) 
- 

Menú contextual de una capa en la Tabla de 
Contenidos> Open Attribute Table 

Update Georeferencing - 
Barra Georeferencing> Georeferencing> 

Update georeferencing 

View Link Table 

 

 
Barra Georeferencing> View Link Table 

Zoom In  Barra Tools> Zoom In 

Zoom Out  Barra Tools> Zoom Out 

Zoom To Layer - 
Menu contextual de una capa en la Tabla de 

Contenidos> Zoom To Layer 

 

Fuente: elaboración propia. 

 

5.2.3. Capas 

 

La información que se utilizará para realizar los ejercicios se describe en la 

tabla XIX y puede descargarse en la página http://ejerciciosgis.weebly.com > 

Práctica 1: cad.zip, shapes.zip e imagenes.zip.  

 

Tabla XIX. Capas a utilizar en fundamentos de cartografía digital 

 

Capa Descripción 

 pais.dwg 
Archivo CAD correspondiente 

al mapa de la República de Guatemala 

 Amatitlan.jpg Hoja 1:50 000 del territorio de Amatitlán 

 man10.shp 
Distribución de algunas manzanas ubicadas 
en la zona 10 del municipio de Guatemala 

 pre10.shp  
Distribución de algunos predios ubicados en 

la zona 10 del municipio de Guatemala 

 

 

 

http://ejerciciosgis.weebly.com/
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Continuación de la tabla XIX. 

 MUNICIPIOS.shp 
Distribución de municipios de la República 

de Guatemala 
 

Fuente: elaboración propia. 

 

5.2.4. Solución 

 

A continuación se presentarán las posibles soluciones de los respectivos 

ejercicios paso a paso basados en la descripción. Para verificar que los 

ejercicios realizados por el usuario están debidamente ejecutados, deberá 

revisar la carpeta denominada Solución, situada en la Práctica 1 en la página 

web. 

 

 Ejercicio 1: SIG 

 

o Objetivo: desplegar cartografía en formato CAD, en ArcMap. 

 

La incorporación de archivos .dxf o .dwg en ArcMap es frecuente debido al 

gran uso de programas CAD. Un archivo de este tipo se manipula dentro de 

softwares como AutoCAD y se maneja a través de layers, cada layer tiene 

propiedades como color, grosor de líneas o tipo de línea y se pueden encontrar 

geometrías de punto, líneas, polígonos y anotaciones. Cada archivo CAD puede 

contener un número infinito de layers. 

 

En ArcMap un archivo CAD se desglosa en 5 elementos que son punto, 

línea, polígono, anotaciones y multipatch (varios elementos geográficos están 

en un sólo registro dentro de la tabla). 
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Para desplegar un archivo con extensión .dwg se dará clic en el botón Add 

Data, se navega hasta encontrar pais.dwg y luego clic en el botón Add. El 

resultado es como se muestra en la figura 33. Para cargar otros archivos con la 

misma extensión, se siguen los mismos pasos, teniendo en cuenta la ubicación 

de los mismos.  

 

Figura 33. Despliegue de un archivo CAD en ArcMap 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

o Objetivo: desplegar cartografía en formato shape en ArcMap. 

 

Para desplegar un archivo con extensión .shp se dará clic en el botón Add 

Data, se navega hasta encontrar man10.shp y se agrega por medio del botón 

Add, el resultado es como se muestra en la figura 34. Para cargar otros 
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archivos con la misma extensión, se siguen los mismos pasos, teniendo en 

cuenta la ubicación de los mismos. 

 

Figura 34. Despliegue de shapefile en ArcMap 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

o Objetivo: desplegar hoja cartográfica. 

 

Para desplegar una hoja cartográfica, se dará clic en el botón Add Data, 

se navega hasta encontrar Amatitlan.jpg y se agrega por medio del botón Add, 

el resultado es como se muestra en la figura 35. Para cargar otros archivos con 

la misma extensión, se siguen los mismos pasos, teniendo en cuenta la 

ubicación de los mismos. Las imágenes pueden tener extensiones como .tif, 

jpeg, entre otras. 

  

 



121 
 

Figura 35. Hoja cartográfica desplegada en ArcMap 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

o Objetivo: aplicar simbología a las distintas capas. 

 

La simbología se utiliza para describir de forma gráfica los componentes 

de un mapa con la finalidad de ubicar uno o varios atributos. La manera más 

sencilla de colocar símbolos en las capas es seleccionando los que se 

encuentran almacenados en los estilos que proporciona ArcGis. Para que el 

usuario final comprenda la simbología utilizada, debe colocarse en el mapa un 
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cuadro con una leyenda que detalle esa información. Existen dos componentes 

en la simbología: tipo de símbolo y simbología de capa. 

 

 Tipo de símbolo  

 

El tipo de símbolo define la apariencia de un símbolo individual, tales 

como líneas continuas, relleno de polígonos, etc. Para este ejercicio se utilizará 

pre10.shp agregándola por medio de Add Data. 

 

Figura 36. Tipo de simbología para polígonos 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Una vez cargada pre10.shp se da clic en el recuadro que se encuentra 

debajo de su nombre en la Tabla de Contenidos, como indica la flecha en la 

figura 36. Aparecerá un cuadro de diálogo con el nombre Symbol Selector y 

desde ahí se le puede colocar a la capa el tipo de relleno deseado. Si la capa 
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fuese de líneas o puntos así se aplicará su simbología respectiva, como se 

muestra en la figura 37. 

 

Figura 37. Tipo de simbología para capas de puntos y líneas 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Simbología de capa 

 

Se utiliza para agrupar una capa y así representar la selección con un 

símbolo o color diferente con la finalidad de realizar diversos análisis 

posteriormente. Al igual que en el ejercicio anterior se utilizará pre10.shp. Se 

ingresa a las propiedades de la capa y se selecciona la pestaña Symbology. 

Como se observa en el recuadro de la ventana Layer Properties indicado en la 

figura 38, ArcMap propone al usuario diversas formas de aplicar simbología, los 

cuales se explicarán a continuación.  
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Figura 38. Simbología de capa 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Features> Single symbol: aplica la simbología 

utilizando un único color, por medio de Symbol 

Selector. Es lo equivalente a lo explicado en tipo de 

símbolo del inciso anterior, como se muestra en la 

figura 39. 
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Figura 39. Simbología por medio de la opción Features 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Categories> Unique values: aplica la simbología 

utilizando uno, varios o todos los valores de un solo 

campo de una capa determinada. Para comprender 

esto de una mejor manera se proponen los 

siguientes tres ejemplos. 

 

Ejemplo 1: se desea conocer qué predio tiene mayor área de todos.  

 

En la ventana Layer Properties se elige en el ListBox que tiene por título 

Show: Categories> Unique values. A continuación en la lista desplegable Value 

Field se escoge el campo AREA. Para conocer el predio de mayor área se da 

clic en el botón Add Values, al abrirse el cuadro de diálogo se busca en la lista 

el valor más alto, que corresponde a 28 840,23; cabe señalar que los valores se 
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ordenan en forma ascendente. En caso el botón Complete List del cuadro de 

diálogo Add Values esté activado, es necesario darle clic para que todos los 

valores se muestren, con la finalidad de no elegir datos erróneos que puedan 

afectar el análisis. El proceso expuesto se detalla en la figura 40. 

 

Figura 40. Agregando un único valor de un campo por medio de Add  

   Values 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Ejemplo 2: se desea identificar los tres predios que tienen mayor área. 

 

Para identificar los tres predios de mayor área se da clic en el botón Add 

Values, al abrirse el cuadro de diálogo se buscan en la lista los últimos tres 

valores, que corresponden a 65 94,65; 9 803,83 y 28 840,23, como se muestra 

en la figura 41. 
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Figura 41. Simbología aplicada a algunos valores de un campo 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Ejemplo 3: se desea identificar todos los predios según su área. 

 

Para aplicar la simbología a todos los predios según su área se da clic en 

el botón Add All Values y automáticamente se despliegan todos los valores, 

como se muestra en la figura 42. 
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Figura 42. Simbología aplicada a todos los valores de un campo 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Categories> Unique values, many fields: dibuja las 

categorías combinando hasta tres atributos de una 

misma capa. 

 

Ejemplos de las distintas formas de aplicar simbología se apreciarán en 

los capítulos siguientes. Es importante mencionar que aplicar simbología a una 

capa permite apreciar los atributos que esta ofrece, en la figura 43 se observa la 

diferencia. 
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Figura 43. Aplicación de simbología a una capa determinada 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

o Objetivo: georeferenciar hoja cartográfica 1:50 000. 

 

Para realizar este ejercicio debe encontrarse activa la barra 

Georeferencing. Georeferenciar un archivo consiste en ubicarlo en un sistema 

de coordenadas determinado, mediante una serie de puntos de control. Aunque 

existen diversas formas de georeferenciar, en este ejercicio se hará de dos 

formas, la primera ingresando los puntos definidos desde ArcMap y la segunda 

por medio de puntos definidos previamente desde una tabla de Microsoft Excel. 

La imagen a utilizar es Amatitlan.jpg y se añadirá por medio de Add Data.  

 

Debido a que esta imagen es una hoja cartográfica, cuenta con una grilla 

que tiene coordenadas conocidas de las cuales se ubicarán cuatro de ellas, 
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preferentemente en las esquinas, que serán utilizadas posteriormente como 

puntos de control. 

 

Aunque el usuario puede elegir los puntos al azar, para realizar este 

ejercicio es recomendable que se utilicen las coordenadas de los puntos 

presentados en la tabla XX. 

 

Tabla XX. Coordenadas de puntos para georeferenciar manualmente 

 

ID X Y OBSERVACIONES 

1 744 000 1 587 000 Esquina inferior izquierda 

2 744 000 1 603 000 Esquina superior izquierda 

3 769 000 1 587 000 Esquina inferior derecha 

4 769 000 1 603 000 Esquina superior derecha 
 

Fuente: elaboración propia. 

 

 Ingresando puntos manualmente 

 

Una vez cargada la imagen se hace un Zoom In lo más cercano posible a 

uno de los puntos seleccionados, se iniciará con las coordenadas X=744 000 y 

Y=1 603 000. Se da clic en el botón Add Control Points y se notará que el 

cursor toma forma de cruz. Se da un sólo clic en el punto deseado, 

posteriormente se da clic derecho y aparecerán dos opciones de las cuales se 

elige Input X and Y, como se muestra en la figura 44. En el cuadro de diálogo 

Enter Coordinates que aparece, el programa solicita que se ingresen las 

coordenadas que pertenecen a ese punto las cuales son las presentadas 

anteriormente. 
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Figura 44. Punto de control agregado manualmente 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Nótese que el Zoom In se realizó de tal manera que se observan los 

píxeles que conforman la imagen con la finalidad de obtener más precisión en el 

punto a georeferenciar. Para regresar al tamaño original de la imagen se 

utilizará Zoom Out y para desplazarse en la pantalla de un punto a otro se hace 

por medio de Pan. 

 

El orden que se seguirá para ingresar las coordenadas escogidas será en 

forma cruzada (después de la coordenada número 1 se hará la 3), esto se 

realiza para que la imagen original no sufra distorsiones. Al finalizar este 

proceso se da clic en el botón View Link Table, como se muestra en la figura 

45. Se observará que hay un cuadro denominado Total RMS Error, que es la 

raíz cuadrada del error cuadrático medio según sus siglas en inglés (Root Mean 
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Square). Este comando sirve para calcular estadísticamente el grado de ajuste 

del resultado del proceso de georeferenciación y para ello se comparan las 

coordenadas de los puntos de control respecto a las coordenadas del punto 

real, ajustándolas mediante mínimos cuadrados para calcular el error del ajuste.  

 

Figura 45. Ventana Link Table 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

El tipo de transformación será 1st Order Polynomial que permite corregir 

distorsiones simples en la imagen. La transformación es apropiada para mapas 

escaneados y se requieren como mínimo tres puntos de control, en este 

ejercicio se utilizaron cuatro puntos, lo que dará una mayor precisión en la 

imagen georeferenciada. 
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Realizado el procedimiento se puede decir que la imagen está 

georeferenciada, ahora es necesario que se guarde la referencia y para ello 

existen dos opciones:  

 

 Update Georeferencing: esta opción no debe 

confundirse con que el archivo original es alterado 

totalmente, lo que sucede realmente es que se crea 

un archivo auxiliar con extensión .rrd que tendrá las 

actualizaciones de georeferencia que se le hagan al 

archivo original, es decir, si ya no se desea tener la 

georeferencia que en algún momento se realizó, 

únicamente debe borrarse el archivo .rrd. En caso de 

compartir con otro usuario la imagen 

georeferenciada, es necesario brindar tanto el 

archivo original como su auxiliar, de otro modo, la 

información no estará completa.  

 

 Rectify: esta opción creará un nuevo archivo raster 

georeferenciado sin alterar el archivo original y las 

propiedades con las que se guardará al elegir Rectify 

son como se muestra en la figura 46. Una desventaja 

de utilizar esta opción es que la información que se 

genera ocupa más espacio en el disco duro de la 

computadora que Update Georeferencing; en este 

ejemplo no será un espacio considerable pero si el 

caso fuera georeferenciar las hojas cartográficas que 

cubren todo el territorio de la República de 

Guatemala, no sería recomendable utilizar esta 

opción.  



134 
 

Figura 46. Creando un nuevo archivo raster georeferenciado por medio  

  de Rectify 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para fines ilustrativos se realizarán ambos procedimientos. La primera 

opción para georeferenciar (ingresando puntos manualmente) se hará utilizando 

Rectify. 

 

 Ingresando puntos desde Microsoft Excel 

 

Se abrirá un archivo en blanco de Microsoft Excel y se colocan los datos 

mostrados en la tabla XXI. A la hoja del libro de Excel en la que se coloque la 

información se le colocará como nombre puntos_control.shp. El archivo deberá 

guardarse en la carpeta utilizada por el usuario para la presente práctica con el 

nombre Georeferencia. 
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Tabla XXI. Coordenadas para georeferenciar utilizando Microsoft Excel 

 

ID X Y OBSERVACIONES 

1 744 000 1 587 000 Esquina inferior izquierda 

2 744 000 1 603 000 Esquina superior izquierda 

3 769 000 1 587 000 Esquina inferior derecha 

4 769 000 1 603 000 Esquina superior derecha 
 

Fuente: elaboración propia. 

 

Posteriormente se abrirá un proyecto en blanco de ArcMap y por medio de 

Add Data se explora hasta encontrar Georeferencia.xls, se da doble clic y se 

elige puntos_control.shp, que corresponde a la tabla elaborada anteriormente. 

Al cargar estos datos no existe ningún cambio en la pantalla, entonces en la 

Tabla de Contenidos se da clic derecho sobre puntos_control$, al desplegarse 

el menú contextual se elige Display XY Data, aparece un nuevo cuadro de 

diálogo y en la descripción del mismo se informa que los puntos que se 

presentarán tienen un sistema de coordenadas desconocido.  

 

Para asignar un sistema se da clic en el botón Edit> Select> Projected 

Coordinate Systems> UTM> WGS 1984> WGS 1984 UTM Zone15N.prj> Add> 

Aceptar. La ventana tendrá la apariencia que se observa en la figura 47, luego 

se da clic en Ok y se despliegan cuatro puntos en la pantalla. Existe la 

posibilidad de que los puntos no se observen automáticamente, entonces se 

dará clic derecho sobre puntos_control$ en la Tabla de Contenidos> Zoom to 

Layer. 
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Figura 47. Ventana Display XY Data 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Una vez cargada la imagen se utiliza la herramienta Fit to Display de la 

barra Georeferencing y aparecerá la hoja cartográfica que representa a 

Amatitlán en la pantalla. Se hace un Zoom In a uno de los puntos 

seleccionados, por ejemplo, el de las coordenadas X = 769 000, Y = 1 587 000. 

El resultado del punto de control ingresado en Excel y el punto verdadero de la 

hoja cartográfica se observa en la figura 48.  

 

 

 

 

 



137 
 

Figura 48. Punto verdadero y punto de control 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

A continuación se da clic en el botón Add Control Points de la barra 

Georeferencing, se notará que el cursor toma una forma de cruz, el primer clic 

se dará en el punto señalado como punto verdadero y el segundo en el 

señalado como punto de control. Automáticamente el punto de control se 

mueve hacia el punto verdadero. Este procedimiento se utiliza para los otros 

puntos que fueron elegidos previamente, de preferencia haciéndolo en el 

siguiente orden: Punto 1, 3, 2 y 4. Para obtener una mayor precisión en la 

colocación de los puntos es recomendable utilizar el Zoom In, Zoom Out, Pan y 

Full Extent. Al finalizar este proceso se da clic en el botón View Link Table.  

  

Realizado el procedimiento, la imagen está georeferenciada, ahora es 

necesario que se guarde la referencia y en esta ocasión se utilizará Update 

Georeferencing. 
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Para comprobar que las imágenes están correctamente referenciadas se 

agregará por medio de Add Data la capa MUNICIPIOS.shp. El resultado es 

como se observa en la figura 49. 

 

Figura 49. Hoja georeferenciada sobre capa de municipios de  

   Guatemala 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Ejercicio 2: manipulación de atributos. 

 

o Objetivo: calcular el área de un shape. 

 

En este ejercicio se utilizará la capa pre10.shp. Para poder observar los 

atributos se hace por medio del botón Select Features, una vez seleccionado se 

señala un polígono de la capa al azar y se da clic. Se observa que lo señalado 

tiene un contorno de color celeste, como se muestra en la figura 50.  
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Figura 50. Tabla de atributos de un polígono determinado 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para observar los atributos del polígono seleccionado, se abre la tabla de 

atributos correspondiente a pre10.shp por medio de Open Attribute Table. De 

esta forma, el renglón en el que están descritos los atributos del polígono 

seleccionado, estará marcado con celeste y se observa, entre otros atributos, el 

valor del área correspondiente para el polígono seleccionado. Si ya no se desea 

ver el polígono seleccionado marcado en azul, se utiliza el botón Clear Selected 

Features, como se muestra en la figura 50. 

 

5.3. SIG aplicado a catastro 

 

Esta práctica consiste en abrir un proyecto existente y realizar distintas 

operaciones por medio de los atributos de las distintas capas que lo conforman, 

para tener un conocimiento general de los análisis que se pueden llevar a cabo.  
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Antes de iniciar con los ejercicios es importante que el usuario navegue en 

los distintos niveles de despliegue, encienda y apague capas, note la diferencia 

entre shapes de puntos, líneas y polígonos, visualice la información de atributos 

y utilice el botón Identify para consultar atributos de objetos. 

 

5.3.1. Descripción de la práctica 

 

Se realizó el catastro de hidrantes en distintas zonas del municipio de 

Guatemala con el objetivo de conocer a detalle la cantidad, condición y 

ubicación de los surtidores de agua, para servirse de dicha información en caso 

de emergencias, como las que se presentan en los siguientes ejercicios: 

 

 Ejercicio 1 

 

o Seleccionar la zona 1 por consulta de atributos. 

o Seleccionar cuántos hidrantes están ubicados en la zona 1. 

o Seleccionar cuántos hidrantes ubicados en la zona 1 se 

encuentran en buen estado. 

 

 Ejercicio 2 

 

o Crear un nuevo shape de puntos. 

o Cargar una capa creada al proyecto actual. 

o Iniciar sesión de edición. 

o Insertar un punto en el centro de El Trébol. 

o Buscar hidrantes existentes en un radio de 1 000 metros. 
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 Ejercicio 3 

 

o Insertar punto nuevo en la esquina de la 6 avenida y 6 calle      

zona 1. 

o Se incendia el Palacio Nacional y se necesita conocer cuántos 

hidrantes hay en un radio de 500 metros en buen estado. 

 

 Ejercicio 4 

 

o Se necesita conocer cuántos mercados cuentan con hidrantes a  

una distancia igual o menor a 200 metros. 

o Aplicar transparencia y color a mercados_buffer.shp. 

o Intersectar el área de influencia de mercados con los hidrantes. 

o Seleccionar cuántos polígonos del buffer de mercados cuentan 

con los hidrantes a 200 metros.  

 

5.3.2. Barras, comandos y herramientas  

 

Las barras a utilizar en la presente práctica se describen en la tabla XXII. 

Se explicarán las rutas de acceso desconocidas hasta el momento para que el 

usuario se familiarice con las barras, comandos y herramientas. En las prácticas 

posteriores no se describirán a fin de no duplicar información, por lo que si es 

necesario, deberá consultarse el presente capítulo.  
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Tabla XXII.      Barras utilizadas en SIG aplicado a catastro 

 

Barra Apariencia 

Editor 
 

 

Fuente: elaboración propia. 

 

Los comandos y herramientas a utilizar en la presente práctica se 

describen en la tabla XXIII. 

 

Tabla XXIII.      Comandos y herramientas utilizadas en SIG aplicado a  

         catastro 

 

Comando / 
Herramienta 

Icono Ruta de acceso 

ArcCatalog 
 

Inicio> Todos los programas> ArcGis> ArcCatalog 

Buffer - 
ArcToolBox> Analysis Tools> Proximity> Buffer o por medio de 

ArcToolBox> Index> Buffer 

Dissolve - ArcToolBox> Data Management Tools> Generalization> Dissolve 

Export Data - Menú contextual de la capa> Data> Export Data 

Identify 
 

Barra Tools> Identify 

Intersect - ArcToolbox> Analysis Tools> Overlay> Intersect 

Save Edits - Barra Editor> Editor> Save Edits 

Select By Attributes - Main Menu> Menú Selection> Select By Attributes 

Select By Location - Main Menu> Menú Selection> Select By Location 

Sketch Tool 
 

Barra Editor> Sketch Tool 

Spatial Join - 
ArcToolbox> Analysis Tools> Overlay>  

Spatial Join 

Start Editing - Barra Editor> Editor> Start Editing 

Stop Editing - Barra Editor> Editor> Stop Editing 

 

Fuente: elaboración propia. 
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5.3.3. Capas 

 

La información que se utilizará para realizar los ejercicios 

correspondientes a la presente práctica se describe en la tabla y puede 

descargarse en la página http://ejerciciosgis.weebly.com > Práctica 2: 

practica2.zip > Capas. 

 

El proyecto que se utilizará se denomina MapaBomberos.mxd y en la tabla 

XXIV se  muestran las capas contenidas en el proyecto. 

 

Tabla XXIV.    Capas a utilizar en SIG aplicado a catastro 

 

Capa Descripción 

 Bomberos.shp 
Distribución de nueve estaciones de bomberos 

ubicadas en el municipio de Guatemala 

 departamento.shp Municipios del departamento de Guatemala 

 Hidrantes.shp 
Distribución de hidrantes en el municipio de 
Guatemala y sus respectivas características 

 Mercados.shp 

Distribución de mercados ubicados en el 
municipio de Guatemala y sus respectivas 

características 

 redvial.shp 
Distribución de la red vial correspondiente al 

municipio de Guatemala 

 zonas.shp Zonas del municipio de Guatemala 
 

Fuente: elaboración propia. 

 

5.3.4. Solución 

 

En los ejercicios que siguen a continuación se encontrarán situaciones en 

las que se deseará realizar consultas para extraer información de los datos 

geográficos, permitiendo una selección de elementos pertenecientes a una 

capa, utilizando como ejemplo zonas.shp. Los tipos de consultas que se 

http://ejerciciosgis.weebly.com/
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utilizarán son la directa, la gráfica y en la base de datos, las cuales se describen 

a continuación. 

 

 Consulta directa 

 

Este tipo de consulta extraerá la información de una única capa. Se hará 

por medio del botón Select Features, o por medio del botón Identify explicado 

en el capítulo 4.5. 

 

Una vez activado el botón Select Features se da clic sobre algún polígono 

o elemento determinado y este se marcará con color celeste. Al abrir la tabla de 

atributos de zonas.shp se observará que el elemento seleccionado también 

estará marcado con el mismo color, como se observa en la figura 51. 
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Figura 51.  Polígono seleccionado de zonas.shp por medio de Select    

     Features y tabla de atributos correspondiente 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Consulta gráfica 

 

En la consulta gráfica se utilizan las características de una o más capas 

basándose en su localización para seleccionar los atributos de una capa 

determinada que cumplen con ciertas condiciones. Para realizar una consulta 

de este tipo en ArcMap se hace por medio de Select By Location, como se 

muestra en la figura 52. En algunos ejercicios posteriores se nombrará como 

selección por localización. 
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Figura 52. Menú Selection  

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Aunque este tipo de consulta tiene varias funciones, en el presente 

manual se elegirán características de capas que intersecten con otra, como se 

muestra en la figura 53. 

 

Figura 53. Select By Location 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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 Consulta en la base de datos 

 

Para realizar una consulta de este tipo en ArcMap se hace por medio de 

Select By Attributes. En algunos ejercicios posteriores se nombrará también 

como selección por atributos, según su traducción al español. 

 

 Ejercicio 1 

 

o Objetivo: seleccionar la zona 1 por consulta de atributos. 

 

Para este caso se elige hacer una selección por atributos de la capa 

zonas.shp. En SELECT * FROM zonas WHERE se escribirá textualmente 

“ZONA” = 1, como se observa en la figura 54. Luego al dar clic en Ok, 

automáticamente el polígono correspondiente a la zona 1 que se solicitó se 

marcará en color celeste. 

 

Figura 54. Consulta en la base de datos de zonas.shp 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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o Objetivo: seleccionar cuántos hidrantes están ubicados en la zona 

1. 

 

Para este caso se elige hacer una selección por atributos de 

Hidrantes.shp. En SELECT * FROM Hidrantes WHERE se escribe 

textualmente: “ZONA” = 1.  

 

Al dar clic en Ok el programa reconoce automáticamente los puntos 

correspondientes a los hidrantes que se encuentran ubicados dentro del 

perímetro del polígono de la zona 1 y los remarca con color celeste, como se 

observa en la figura 55. 

 

Figura 55. Selección de un único atributo 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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o Objetivo: seleccionar cuántos hidrantes ubicados en la zona 1 se 

encuentran  en buen estado. 

 

Al igual que en los incisos anteriores se elige hacer una selección por 

atributos de Hidrantes.shp. En SELECT * FROM Hidrantes WHERE: se escribe 

textualmente “ZONA” = 1 AND “ESTADO” = „BUENO‟, como se observa en la 

figura 56. Es de vital importancia escribir todos los símbolos que se ven en el 

recuadro, de lo contrario, no se obtienen los resultados deseados.  

 

Figura 56. Selección de dos atributos distintos en una misma capa 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

En el botón señalado Get Unique Values se despliegan los valores 

correspondientes para cada campo, en el caso de “ZONA” se mostrarán 

números del 1 al 15 (solamente de esas zonas existen datos de hidrantes) y 

para el atributo “ESTADO” se lee „BUENO‟ y „MALO‟. Para que se intersecten 

los valores de la zona seleccionada con el estado de cada hidrante se coloca 
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AND que está incluida en la lista de operadores. Los objetos escogidos 

aparecerán en el Data View en un color celeste. 

 

 Ejercicio 2 

 

Para los incisos siguientes es necesario que la Barra Editor se encuentre 

activa. 

 

o Objetivo: crear por medio de ArcCatalog un nuevo shape de 

puntos. 

 

El objetivo de crear una nueva capa para insertar un punto es para no 

alterar los valores de puntos de las capas existentes y poder interactuar con las 

otras que se cargaron anteriormente. 

 

Figura 57. Creación de un nuevo shapefile desde ArcCatalog 

 

 

 

Fuente: elaboración propia, utilizando ArcCatalog. 
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Una vez abierto ArcCatalog se le indicará crear un nuevo shapefile en la 

carpeta que se esté utilizando. Como en la figura 57, se visualizará la ventana 

Create New Shapefile, en esta ventana se ingresa el nombre de la nueva capa 

que será incendios_trebol.shp. En Feature Type se elige Point, puesto que será 

un shape de puntos. Adicionalmente se asignará el sistema de referencia a la 

capa por medio del botón Edit> Select> Projected Coordinate Systems> UTM> 

WGS84> WGS 1984 Zone 15N.prj, se presiona Ok para todas las ventanas. Se 

seleccionó este sistema, pues es en éste que están referenciadas las otras 

capas del ejercicio. 

 

o Objetivo: cargar incendios_trebol.shp creada anteriormente al 

proyecto actual. 

 

Para cargar incendios_trebol.shp en el proyecto actual se hace por medio 

de Add Data, explorando hasta llegar a la ubicación del archivo. 

 

o Objetivo: iniciar sesión de edición. 

 

Para iniciar sesión de edición se selecciona Start Editing, como se observa 

en la figura 58.  
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Figura 58. Inicio de sesión de edición con Start Editing  

 

 

 

Fuente: elaboración propia, utilizando ArcMap 

 

o Objetivo: insertar un punto en el centro de El Trébol. 

 

Para encontrar El Trébol como guía la figura 58. Con el botón Sketch Tool 

se selecciona el punto deseado, como se muestra en la figura 59. Luego se 

selecciona Stop Editing que se despliega de la misma forma que Start Editing 

explicado en el inciso anterior.  

 

Figura 59. Punto marcado por medio de Sketch Tool en El Trébol 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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o Objetivo: buscar hidrantes existentes en un radio de 1 000 metros. 

 

Para buscar hidrantes existentes dentro de un radio determinado se utiliza 

la herramienta Buffer. En el Input Features se selecciona la capa que contiene 

el punto en el centro de El Trébol, incendios_trebol.shp y en la distancia se 

escribe el valor de 1 000 metros.  

 

La capa resultante llevará por nombre incendios_trebol_Buffer.shp. 

 

Figura 60. Selección por localización de hidrantes alrededor de El  

      Trébol 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

A continuación se hará una selección por localización, colocando los datos 

como se muestra en la figura 60.  
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Al ingresarlos de esa forma se seleccionan las características de 

Hidrantes.shp que intersectan las características en el radio de 1 000 metros 

alrededor del punto colocado en el Trébol (incendios_trebol_Buffer.shp). El total 

de hidrantes es dos y para visualizar los atributos de cada uno se abre la tabla 

de atributos de Hidrantes.shp. El resultado es como se observa en la figura 61. 

 

Figura 61. Hidrantes localizados dentro de área de influencia de El  

                            Trébol 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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 Ejercicio 3 

 

o Objetivo: insertar un punto nuevo en la esquina de la 6ta. avenida 

y 6ta. calle zona 1. 

 

Para insertar un punto nuevo en la dirección indicada se siguen los 

mismos pasos indicados en los primeros cuatro incisos del Ejercicio 2 del 

presente capítulo, esta vez el shapefile llevará por nombre 

incendios_PalacioNac.shp. 

 

o Objetivo: conocer cuántos hidrantes existen en un radio de 500 

metros, suponiendo que se incendia el Palacio Nacional. 

 

A diferencia del ejercicio anterior, en este se pide señalar los hidrantes 

que estén en buen estado localizados dentro del radio señalado. Se aplica 

Buffer de 500 metros a incendios_PalacioNac.shp. La capa resultante tendrá 

por nombre incendios_palacio_buffer.shp. 

 

A continuación se hará una selección por localización eligiendo las 

características de Hidrantes.shp que intersecten las características en el radio 

de 500 metros alrededor del punto colocado en la 6ta. avenida y 6ta. calle de la 

zona 1 (incendios_palacio_buffer.shp).  

 

Para verificar cuáles de esos hidrantes se encuentran en buen estado, 

debe hacerse una selección por atributos, para lo cual se tomarán únicamente 

los datos de la capa Hidrantes que son del interés de este ejercicio. Para esto 

es necesaria la creación de una capa independiente a partir de los datos 

seleccionados, a fin de facilitar el análisis, esto se hará por medio de Export 

Data, y se guardará con el nombre Palacio500mHidran.shp, luego se hace una 
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selección por atributos a esta capa, señalando que el estado sea bueno. El 

resultado se observa en la figura 62. 

 

Figura 62. Selección de atributos de una capa con atributos exportados 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Ejercicio 4 

 

Se necesita conocer cuántos mercados cuentan con hidrantes a  una 

distancia igual o menor a 200 metros. 
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o Objetivo: crear Buffer a 200 metros. 

 

Como en los ejercicios anteriores se crea un Buffer a 200 metros para 

Mercados.shp, como resultado se obtendrá mercados_buffer.shp y los análisis 

que se realicen a esta nueva capa estarán únicamente dentro de la distancia 

señalada. 

 

o Objetivo: aplicar transparencia de 50 por ciento y color rojo a 

mercados_buffer.shp. 

 

Para aplicar color rojo a esta capa se hace por medio de los métodos 

mostrados en el capítulo 5.1.1.1.4. La transparencia se coloca por medio de las 

propiedades de la capa, en la pestaña Display, colocando 50 en Transparent, 

como se muestra en la figura 63. 

 

Figura 63. Pestaña Display para aplicar transparencia a una capa 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

o Objetivo: intersectar capa mercados_buffer.shp con Hidrantes.shp.  

 

Es necesario relacionar los atributos de mercados_buffer.shp con 

Hidrantes.shp para lo cual se utiliza la herramienta Intersect. Se eligen ambas 
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capas y resultará una nueva capa que a la que se le pondrá por nombre 

mercados_buffer_intersect.shp.  

 

o Objetivo: seleccionar cuántos polígonos del Buffer de mercados 

cuentan con hidrantes a 200 metros.  

 

Para saber cuántos polígonos cuentan con hidrantes a 200 metros se 

hace una selección por localización de mercados_buffer_intersect.shp que 

intersecte a Hidrantes.shp. El resultado que se obtiene se observa en la figura 

64, al contar los polígonos se determina que existen 8 mercados que tienen 

hidrantes a 200 metros, con un total de 13 hidrantes.  
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Figura 64. Total de polígonos con hidrantes a 200 metros o menos, 

     utilizando Select By Location 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Este es un método que no sería funcional si el volumen de datos que se 

está manejando fuese mayor. Para casos en los que la cantidad de información 

sea muy grande,  se puede seguir la siguiente alternativa. 

 

o Objetivo: realizar un método más eficiente para conocer cuántos 

polígonos del Buffer de mercados cuentan con hidrantes a 200 

metros.  
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Se utilizará mercados_buffer_intersect.shp, creada a partir de intersectar 

la capa mercados_buffer.shp con Hidrantes.shp del presente ejercicio. Es 

importante recordar que cuando estas capas fueron intersectadas se tomaron 

únicamente los mercados en los cuales existen hidrantes en un radio de 200 

metros.  

 

La siguiente herramienta a utilizar será Spatial Join, y esta relacionará las 

tablas de atributos de dos capas distintas con la finalidad de hacer un conteo de 

alguno de sus atributos. La capa que interesa principalmente es 

mercados_buffer_intersect.shp y se relacionará con zonas.shp. Esta capa 

llevará por nombre buffer_hidrantes_SJ.shp. 

 

Posteriormente se utilizará la herramienta Dissolve en la que se utilizará la 

capa buffer_hidrantes_SJ.shp, el nombre de la capa nueva será 

cant200buffer_hidrantes.shp. En Dissolve_Fields se activará el Check Box del 

campo MERCADO, en Statistics Field se elige Join_Count y en el tipo de 

estadística se coloca SUM. Esto creará una nueva tabla de atributos que 

presenta 8 mercados distintos con la cantidad de hidrantes que tiene cada uno, 

como se muestra en la figura 65. Debe prestarse especial atención a la tabla de 

atributos de las dos alternativas presentadas y la importancia del uso de cada 

método. 

 

 

 

 

 

 

 

 



161 
 

Figura 65. Total de polígonos con hidrantes a 200 metros o menos, 

     utilizando ArcToolBox 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

5.4. SIG aplicado a medio ambiente 

 

La presente práctica aporta conocimientos relacionados con el uso de 

Sistemas de Información Geográfica en el ámbito vectorial y raster y orienta 

sobre su utilidad en el ámbito de la toma de decisiones. 
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5.4.1. Descripción de la práctica 

 

El Ministerio de Medio Ambiente solicita que se evalúe y emita un informe 

relativo a la capa adquirida a una empresa internacional en la que se presenta 

la recurrencia de incendios en el país por medio de una cuadrícula indicativa.  

El producto ha tenido un valor de $ 50 000,00; por lo que la evaluación decidirá 

si se da por recibido o por rechazado. Para el análisis se cuenta con una base 

de datos donde cada punto simboliza un incendio ocurrido entre 1998 y 2000 

ocurridos en toda la república. Se solicita: 

 

 Que dentro del análisis se establezca cuál es el municipio con más 

incendios en ese lapso de tiempo. 

 El municipio con mayor cantidad de incendios por kilómetro cuadrado. 

 Listar los 20 municipios más propensos a sufrir incendios en esos 3 años. 

 Comparar los resultados obtenidos con los de la capa adquirida a la 

empresa. 

 Además el ministerio cuenta con una capa de zonas de sequía 

proporcionada por el MAGA que también debe compararse para 

establecer qué tipo de área (sequía alta, media o baja) es más propensa 

a incendios recurrentes. 

 Como punto final se desea establecer cuál es el área protegida con más 

incendios en el 2000. 

 

5.4.2. Barras, comandos y herramientas 

 

Los comandos y herramientas a utilizar se describen en la tabla XXV. En 

las prácticas posteriores no se describirán a fin de no duplicar información, por 

lo que deberá consultarse el presente capítulo. En la presente práctica no se 

utilizarán barras nuevas. 
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Tabla XXV.      Comandos y herramientas utilizadas en SIG aplicado  

    a Medio Ambiente 

 

Comando / herramienta Ruta de acceso 

Raster to Polygon 
ArcToolBox> Conversion Tools> From 

Raster> Raster to Polygon 
 

Fuente: elaboración propia. 

 

5.4.3. Capas 

 

La información que se utilizará para realizar los ejercicios de la presente 

práctica se describe en la tabla XXVI y puede descargarse en la página 

http://ejerciciosgis.weebly.com > Práctica 3: capas.zip > Capas. 

 

Tabla XXVI.       Capas a utilizar en SIG aplicado a Medio Ambiente 

 

Capa Descripción 

 areas_protegidas.shp 
Distribución de áreas protegidas a 

nivel nacional 

 incendios.shp 
Puntos que corresponden a cada 

incendio registrado entre 1998 y 2000 

 MUNICIPIOS.shp 
Municipios de la República de 

Guatemala 

 recurrencia.shp 
Cuadrícula indicativa de recurrencia de 
incendios a nivel nacional entre 1998 y 

2000 

 rios.shp Cobertura de ríos a nivel nacional 

 sequias.shp 
Distribución de áreas correspondientes 

a tipos de sequía 
 

Fuente: elaboración propia. 

 

 

 

http://ejerciciosgis.weebly.com/
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5.4.4. Solución 

 

Para iniciar se abrirá un proyecto en blanco en ArcMap y a continuación se 

cargarán, por medio de Add Data, las capas mencionadas en el punto anterior. 

En la figura 66 se muestra el orden de despliegue y la apariencia que deberá 

aparecer en pantalla. 

 

Figura 66. Orden de despliegue y apariencia de capas 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

A continuación se aplicará la simbología a recurrencia.shp (por medio del 

campo RECURRENCIA), areas_protegidas.shp (por medio del campo 

AP_NOM) y sequias.shp (por medio del campo TIPO); tomando como guía la 
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aplicación de simbología de capa contenida en el Ejercicio 1 del capítulo 5.2.4. 

(ver ejemplos).  

 

o Objetivo: establecer cuál es el municipio con más incendios entre 

1998 y 2000. 

 

Se utilizará Spatial Join. La ventana que aparece debe llenarse con los 

datos que se muestran en la figura 67. En este caso se relacionan los atributos 

de MUNICIPIOS.shp con los de incendios.shp para crear la nueva capa 

MUNICIPIOS_SJ_incendios.shp.  

 

Figura 67. Herramienta Spatial Join 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Al abrir la tabla de atributos de la capa nueva denominada   

MUNICIPIOS_SJ_incendios.shp se puede observar que en ella están 

contenidos todos los datos de las capas relacionadas y se crea 

automáticamente una columna nueva con el nombre Join_Count en la que se 
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sumaron todos los puntos que simbolizan los incendios ocurridos en cada 

municipio, por ejemplo, en los municipios en los que no ocurrió ningún incendio 

aparece 0, como se observa en la figura 68. 

 

Figura 68. Cantidad de incendios ocurridos en cada municipio,  

                               utilizando Spatial Joint 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para determinar cuál municipio tuvo la mayor cantidad de incendios 

ocurridos entre 1998 y 2000 se realiza lo siguiente: 

 

En la pestaña correspondiente a la simbología por categoría de las 

propiedades de MUNICIPIOS_SJ_incendios.shp se elegirá el campo 
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Joint_Count> Add Values> Complete List y se seleccionará el valor más alto (en 

este caso 40), luego clic en Ok y Aceptar. Automáticamente el municipio que 

tiene mayor cantidad de incendios cambia de color como se muestra en la 

figura 69. Si se utiliza el comando Identify y se da clic sobre el municipio 

aparecen todos los datos que le corresponden. 

 

Figura 69. Simbología aplicada a un único atributo 

 

 

 

Fuente: elaboración propia, utilizando ArcMap 

 

o Objetivo: identificar el municipio con mayor cantidad de incendios 

por kilómetro cuadrado. 

 

Para obtener esta información se siguen los siguientes pasos: clic derecho 

sobre MUNICIPIOS_SJ_incencios.shp> Open Attribute Table> Options> Add 

Field> colocar el nombre el cual será incen_km_1, Type: Double> clic derecho 
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sobre el nombre del campo nuevo> Field Calculator> aparecerá una ventana 

como la que se muestra en la figura 70 y se colocan los datos que se muestran. 

Join_Count y AREA_KM representan la cantidad de incendios y el área en 

kilómetros cuadrados de cada municipio, respectivamente y al finalizar Ok. 

 

Figura 70. Field Calculator en la tabla de atributos 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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Figura 71. Ventana Export Data 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

A continuación se hace una selección por atributos de 

MUNICIPIOS_SJ_incendios.shp, donde el campo Join_Count sea diferente a 

cero, con la finalidad de obtener solamente los municipios en los que ha 

ocurrido al menos un incendio. Automáticamente se observará en pantalla la 

selección realizada, siendo el siguiente paso la creación de una capa 

independiente a partir de los datos seleccionados, a fin de facilitar el análisis, 

esto se hará por medio de Export Data a MUNICIPIOS_SJ_incendios.shp y 

como nombre se le colocará Con_incendios.shp, como se observa en la figura 

71. Una vez exportada como capa independiente, se puede apagar 

MUNICIPIOS_SJ_incendios.shp. El resultado de la nueva capa y su nueva tabla 

de atributos se observa en la figura 72. 
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Figura 72. Capa creada a partir de datos exportados por una selección  

                       de atributos 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para seleccionar el municipio en el que ocurrieron más incendios por 

kilómetro cuadrado se siguen los mismos pasos que en el inciso anterior, 

utilizando Con_incendios.shp y por medio de la simbología de la capa se 

agrega como único valor al más alto, como se muestra a continuación: 

Propiedades de la capa> Symbology> Categories> Unique values> 

incen_km_1> Add Values> Complete List> Seleccionar el valor más alto> Ok> 

Aceptar. 
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o Objetivo: listar los 20 municipios más propensos a sufrir incendios 

en esos 3 años. 

 

Figura 73. Simbología aplicada a dos atributos de una misma tabla 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Se utilizará de igual forma Con_incendios.shp> Properties> Symbology> 

Unique values, many fields> Value fields: Join Count y MUNICIPIO> Add 

values> Complete List> elegir los 20 con mayor cantidad de incendios, como  se 

observa en la figura 73. Es importante desactivar el checkbox de <all other 

values> para que no existan confusiones en la selección. 

 

El listado se despliega en una paleta de colores que varía desde rojo a 

verde, indicando que los colores más cercanos a rojo corresponden a los 

municipios en los que han ocurrido mayor cantidad de incendios, y los más 
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cercanos a verde corresponden a los municipios en los que han ocurrido menor 

cantidad de incendios, como se muestra en la figura 74.  

 

Figura 74. Municipios más propensos a incendios entre 1998 y  

      2000 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

o Objetivo: comparar los resultados obtenidos con los de la capa 

adquirida a la empresa. 

 

Para apreciar la variación de incendios en toda la República de 

Guatemala, se aplica simbología a la capa MUNICIPIOS_SJ_incendios.shp, 

añadiendo todos los valores del campo Join_Count.  
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Figura 75. Comparación del análisis realizado con la capa obtenida por  

  empresa internacional 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Según lo que se observa en la figura 75 la empresa internacional afirma 

que en el área de el Petén es en donde mayor recurrencia de incendios existe. 

El municipio San Jerónimo, Baja Verapaz, es en el que mayor cantidad de 

incendios ocurrieron (40), y según la capa proporcionada está en una zona 

entre muy baja y baja recurrencia. 
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o Objetivo: establecer qué tipo de área (sequía alta, media o baja) 

es más propensa a incendios recurrentes por medio de una capa 

de zonas de sequía proporcionada por el MAGA. 

 

Se utilizará sequias.shp, cargada al iniciar esta práctica. Esta capa tiene 

distintos colores que corresponden a lugares sin sequía, con sequía baja, media 

y alta, lo cual se corrobora al abrir la tabla de atributos de la capa. Como se 

puede observar, es de tipo raster, por lo que para realizar análisis en conjunto 

con incendios.shp es necesario convertirla en una capa de polígonos. 

 

Para realizar la conversión de un archivo raster a vectorial (en este caso 

polígonos) se utiliza la herramienta Raster to Polygon. En el campo Input raster 

de la ventana Raster to Polygon, se ingresa la capa sequias.shp, como se 

observa en la figura 76.  

 

Figura 76. Conversión de un archivo por medio de Raster to Polygon 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

En Field (optional) se despliegan tres opciones que son VALUE, COUNT y 

TIPO; estas corresponden a los atributos de la capa original en formato raster. 

VALUE son números del 1 al 4 y cada uno es asignado para representar cada 
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tipo de sequía. COUNT corresponde a la cantidad de píxeles que tiene cada 

tipo de sequía. TIPO designa a cada polígono la denominación de cada sequía.  

 

Se puede asignar cualquiera de los tres campos, la diferencia radicará en 

la tabla de atributos de la nueva capa. Para fines del presente ejemplo, 

únicamente se hará para el campo de TIPO y se le da un nombre en Output 

polygon features, que será sequias_polygon.shp. En la figura 77 se observan 

las tablas de atributos de cada campo, si se hiciera para cada uno para fines 

ilustrativos. 

 

Figura 77. Tablas de atributos de una capa raster convertida en  

        polígonos, según sus atributos 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Una vez convertida la capa a polígonos, aparecerá un nuevo mapa sin 

simbología aplicada, será necesario aplicarla para notar la diferencia entre las 
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áreas que corresponden a cada tipo de sequía. Además esta capa no tendrá 

referencia espacial, por lo que tendrá que hacerse según el capítulo 5.6, 

Ejercicio 3 y 4 (al hacer el cambio de proyecciones se le colocará como nombre 

a esa nueva capa sequias_polygon_gtm.shp. 

 

Para unir los atributos de incendios.shp y sequias_polygon_gtm.shp se 

hará un Spatial Join, esta nueva capa llevará por nombre 

incendios_SJ_sequias.shp.  

 

Figura 78. Dissolve para conocer la cantidad de incendios    

            correspondiente a cada tipo de sequía 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

A continuación se hará un Dissolve a incendios_SJ_sequias.shp que 

llevará por nombre incendios_sequias_Dissolv.shp, en los campos a disolver se 

elige TIPO, para que en base a ese atributo se haga la nueva capa. Como será 

necesario saber cuántos incendios ocurrieron se hace una suma por medio de 



177 
 

Join_Count y SUM, como se muestra en la figura 78, el cual contará los puntos 

en cada área correspondiente a cada tipo de sequía. La capa resultante será 

como se muestra en la figura 79.  

 

Figura 79. Incendios ocurridos en la República de Guatemala según  

                           tipo de sequía 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para establecer finalmente qué área es más propensa a incendios, se 

aplica simbología a incendios_sequias_Dissolv.shp, agregando en el campo a 

evaluar el correspondiente a las sumas de los puntos que representan a los 
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incendios (SUM_Join_C) y como único valor el más alto que es de 778 

incendios, el resultado es como se muestra en la figura 80. 

 

Figura 80. Incendios de la República de Guatemala en área con sequía 

                        baja 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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Si se comparan estos resultados con la capa de municipios en los que 

más incendios ocurrieron en Guatemala se observa que estos municipios están 

ubicados en zonas de sequía baja, lo cual brinda veracidad al análisis realizado, 

como se observa en la figura 81. 

 

Figura 81. Comparación de los 10 municipios con más incendios 

                             respecto al área  de sequía baja, utilizando la capa de 

        incendios que le corresponde 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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o Objetivo: establecer cuál es el área protegida con más incendios 

en el 2000. 

 

Se hace un Spatian Join a incendios.shp y areas_protegidas.shp; la nueva 

capa llevará por nombre incendios_SJ_areasprot.shp y a continuación se le 

hace una selección por atributos por medio del campo ANNOS igual a 2000. 

Para trabajar únicamente con esos datos se exporta como una capa nueva y se 

le coloca como nombre incendios2000.shp. Al abrir la tabla de atributos de esta 

capa debe observarse que en el campo ANNOS tiene únicamente valores igual 

a 2000, es decir que la capa representa los incendios ocurridos en ese año. 

 

Figura 82. Incendios ocurridos en áreas protegidas de Guatemala 

                            durante el 2000 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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A incendios2000.shp se le hará un Dissolve y el atributo AP_NOM se 

elegirá como Dissolve_Field(s), como se observa en la figura 82, para que ahí 

se sume la cantidad de incendios en total que tiene cada uno. La capa 

resultante llevará como nombre incendios2000_areasprot.shp.  

 

Para conocer cuál es el área protegida con mayor cantidad de incendios 

se le aplica simbología a incendios2000_areasprot.shp, y en Add Values se 

busca cuál es el número mayor. Debe tomarse en cuenta que el ejercicio indica 

determinar el área protegida y en los valores se observa que el más alto es 339, 

que corresponde a la cantidad de incendios en las áreas que no son protegidas, 

según la tabla de atributos de la capa. De esta forma se elige entonces el valor 

que sigue, que es de 28. Dando clic en el polígono seleccionado por medio del 

botón Identify se observa que este corresponde al área protegida de uso 

múltiple de Atitlán, como se observa en la figura 83. 
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Figura 83. Área protegida con mayor cantidad de incendios en el 2000 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

5.5. SIG aplicado a ordenamiento territorial 

 

La presente práctica aporta conocimientos relacionados con el uso de 

Sistemas de Información Geográfica en lo relacionado al análisis espacial a 

partir de modelos de elevación digital, así como el uso de los servicios WMS. 

 

5.5.1. Descripción de la práctica 

 

Debido a que el ordenamiento territorial constituye un elemento valioso 

para la gestión de riesgo, se solicita realizar un mapa de zonas vulnerables a 

deslizamientos en el municipio San Antonio Aguascalientes, Sacatepéquez con 

el fin de identificar áreas en riesgo frente a desastres naturales por medio de lo 

siguiente. 
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 Crear una capa de pendientes de acuerdo a la vulnerabilidad  al 

deslizamiento siguiendo los siguientes parámetros: 

 

Vulnerabilidad baja: pendiente de terreno de 0 – 17%  

Vulnerabilidad media: pendiente de terreno de 17 – 48% 

Vulnerabilidad alta: pendiente de terreno mayor a 48% 

 

 Crear una capa de la situación de los centros poblados según la 

vulnerabilidad al deslizamiento. 

 

5.5.2. Barras, comandos y herramientas  

 

Las barras a utilizar en la presente práctica se describen en la tabla XXVII. 

Se explicarán las rutas de acceso desconocidas hasta el momento para que el 

usuario se familiarice con las barras, comandos y herramientas. En las prácticas 

posteriores no se describirán a fin de no duplicar información, por lo que deberá 

consultarse el presente capítulo.  

 

Tabla XXVII.     Barras utilizadas en SIG aplicado a ordenamiento territorial 

 

Barra Apariencia 

Spatial 
Analyst  

 

Fuente: elaboración propia. 

 

Los comandos y herramientas a utilizar en la presente práctica se 

describen en la tabla XXVIII. 
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Tabla XXVIII.      Comandos y herramientas utilizadas en SIG aplicado a  

           ordenamiento territorial  

 

Comando / 
herramienta 

Icono Ruta de acceso 

Slope - 
Barra Spatial Analyst> Surface Analysis> 

Slope 
 

Fuente: elaboración propia. 

 

5.5.3. Capas 

 

La información que se utilizará para realizar los ejercicios 

correspondientes a la presente práctica se describe en la tabla XXIX y puede 

descargarse en la página http://ejerciciosgis.weebly.com > Práctica 4: 

practica4.zip > Capas.  

 

Tabla XXIX.    Capas a utilizar en SIG aplicado a ordenamiento territorial 

 

Capa Descripción 

 MUNICIPIOS_GTM.shp 
Municipios de la República de 

Guatemala 

 MEDSM.tif 

Modelo digital de elevaciones lámina 
correspondiente al municipio San 

Antonio Aguascalientes, Sacatepéquez 

 uso_sanantonioaguascal.shp  
Uso actual del suelo del municipio San 
Antonio Aguascalientes, Sacatepéquez 

Ortofotos por medio de Servicios 
WMS 

Ortofotos de la República de 
Guatemala 

 

Fuente: elaboración propia. 

 

 

 

http://ejerciciosgis.weebly.com/
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5.5.4. Solución 

 

Para iniciar se abrirá un proyecto en blanco en ArcMap y se cargarán, por 

medio de Add Data, las capas mencionadas en el punto anterior.  

 

 Objetivo: crear una capa de pendientes del municipio a partir del modelo 

de elevación digital proporcionado. 

 

Se seleccionará, por medio del botón Select Features el municipio San 

Antonio Aguascalientes (se puede identificar ya sea aplicando la simbología a 

MUNICIPIOS_GTM.shp, o por medio del botón Identify o por medio de la tabla 

de atributos). Una vez identificado el municipio se utilizará la barra Spatial 

Analyst> Surface Analysis> Slope. La ventana que aparece debe llenarse con 

los datos que se muestran en la figura 84.  

 

Figura 84. Creación de una capa de pendientes a partir del modelo de 

   elevación digital 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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Una vez creada la capa de pendientes, se observa que la clasificación no 

está acorde a la vulnerabilidad que se planteó al principio del ejercicio, por lo 

que deben cambiarse por medio de las propiedades de la capa> Symbology> 

Classify> Method: Manual> Ingresar manualmente los valores en Break Values, 

como se observa en la figura 85. 

 

Figura 85. Valores de clases ingresados manualmente 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

El resultado es como se observa en la figura 86. 
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Figura 86. Zonas según la vulnerabilidad al deslizamiento 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Objetivo: observar la situación de los centros poblados por medio de la 

capa correspondiente al uso de suelo y a ortofotos. 

 

Para esto se utilizará uso_sanantonioaguas.shp, se observa que el área 

correspondiente a centros poblados (elegida por medio de la selección de 

atributos) cuenta con muy poca área con vulnerabilidad alta a deslizamientos. 

Para observar el uso real según una ortofoto, se puede utilizar el servicio WMS 

que presta la página web de SEGEPLAN. El link para poder observar las 

ortofotos es el siguiente: 

 

http://ide.segeplan.gob.gt/cgi-

bin/mapserv.exe?map=/ot_web/ot_overview_1.map&SERVICE=WMS& 
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Para poder utilizar este servicio se necesitará de ArcCatalog (Inicio> 

ArcCatalog) y como se observa en la figura 87, GIS Servers> Add WMS Server 

y se ingresa en URL el link proporcionado anteriormente.  

 

Figura 87. Acceso a servicio WMS por medio de ArcCatalog 

 

 

 

Fuente: elaboración propia, utilizando ArcCatalog. 

 

Para cargar este servicio en ArcMap se hace por medio de Add Data 

explorando hasta encontrar ArcCatalog> GIS Servers> Ortofotos on 

ide.segeplan.gob.gt. El resultado es como se observa en la figura 88. 
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Figura 88. Ortofoto vista desde servicio WMS 

 

 

 

Fuente: elaboración propia utilizando ArcMap y servicio WMS: http://ide.segeplan.gob.gt/cgi- 

bin/mapserv.exe?map=/ot_web/ot_overview_1.map&SERVICE=WMS&. Consulta: 15 de 

diciembre de 2012. 

 

5.6. Conversión de coordenadas 

 

La presente práctica aporta conocimientos relacionados con el uso de 

Sistemas de Información Geográfica y la importancia de la uniformidad del 

sistema de referencia en el que se trabaje para obtener los resultados 

deseados, de lo contrario, la información entregada no será correcta. 

 

5.6.1. Descripción de la práctica 

 

Consiste en compatibilizar las capas en un sistema de referencia unificado 

que permita explotar la información proveniente de diferentes orígenes o darle 
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un mismo sistema de coordenadas a información que no posea referencia 

espacial por medio del conjunto de herramientas de proyecciones y 

transformaciones. Los ejercicios a realizar son los siguientes:  

 

 Ejercicio 1: definición de la proyección de una capa al momento de 

crearla. 

 Ejercicio 2: definición del sistema de referencia de una capa.  

 Ejercicio 3: creación de proyección GTM. 

 Ejercicio 4: cambio de un sistema de proyección a otro. 

 

5.6.2. Barras, comandos y herramientas 

 

Los comandos y herramientas a utilizar se describen en la tabla XXX. En 

las prácticas posteriores no se describirán a fin de no duplicar información, por 

lo que deberá consultarse el presente capítulo. En la presente práctica no se 

utilizarán barras nuevas. 

 

Tabla XXX.   Comandos y herramientas utilizadas en conversión de 

        coordenadas 

 

Comando / herramienta Icono Ruta de acceso 

Define Projection - 

ArcToolBox> Data Management Tools> 
Projections and Transformations> Define 

Projection 
O por medio del Index de ArcToolBox 

escribiendo Define Projection. 

Project - 

ArcToolBox> Data Management Tools> 
Projections and Transformations> 

Feature> Project 
O por medio del Index de ArcToolBox 

escribiendo Project. 
 

Fuente: elaboración propia. 
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5.6.3. Capas 

 

La información que se utilizará para realizar los ejercicios 

correspondientes a la presente práctica se describe en la tabla XXXI y puede 

descargarse en la página http://ejerciciosgis.weebly.com > Práctica 5: 

practica5.zip > Capas.  

 

Tabla XXXI.   Capas a utilizar en conversión de coordenadas 

 

Capa Descripción 

 MUNICIPIOS.shp Municipios de la República de Guatemala 
 

Fuente: elaboración propia. 

 

5.6.4. Solución 

 

En los ejercicios que siguen a continuación se encontrarán situaciones en 

las que se trabajará con distintos sistemas de coordenadas, permitiendo una 

correcta asignación a cada una de las capas, para lo cual se utilizará como 

ejemplo un shape en el momento de su creación y MUNICIPIOS.shp 

comúnmente utilizada en otras prácticas. 

 

 Ejercicio 1 

 

o Objetivo: definir el sistema de referencia de una capa en el 

momento de su creación. 

 

Cuando se crea un nuevo shape de puntos, polígonos o líneas, es 

fundamental asignarle un sistema de coordenadas específico, ya sea geográfica 

o proyectada, según las necesidades que convengan. Para observar el proceso 

http://ejerciciosgis.weebly.com/
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de asignación de la proyección UTM zona 15 Norte a una capa nueva, se 

utilizará como ejemplo el ejercicio 2 del capítulo 5.3.4., específicamente donde 

se crea por medio de ArcCatalog un nuevo shape de puntos. 

 

 Ejercicio 2 

 

o Objetivo: definir el sistema de referencia de una capa que carece 

del mismo. 

 

Para realizar este ejercicio se abrirá un proyecto nuevo en ArcMap y se 

utilizará como ejemplo MUNICIPIOS.shp. Una capa sin referencia espacial se 

reconoce cuando al agregarla a un proyecto por medio de Add Data aparece 

una ventana como la que se observa en la figura 89.  

 

Figura 89. Ventana Unknown Spatial Reference 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

En caso la capa esté cargada y no se conozca cuál es su referencia 

espacial, se da clic derecho sobre el nombre de la capa en la Tabla de 
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Contenidos> Properties> Source, en la figura 90 se observa que el sistema de 

coordenadas es indefinido. 

 

Figura 90. Capa sin referencia espacial 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Cuando la capa no cuenta con un  sistema de referencia definido, se debe 

obtener del proveedor de la capa el sistema en el que se encuentra realmente. 

Si esto no fuera posible, como generalmente sucede, es posible descubrirlo por 

comparación con otras capas cuyo sistema es conocido. Es importante recalcar 

que cuando una capa no tiene referencia espacial, no quiere decir por ello que 

se le pueda colocar cualquier sistema que se desee; primero se define el 

sistema en el cual fue creado y luego se le pueden hacer las modificaciones de 

sistemas que se deseen. 

 

Según se observa en la figura 91, MUNICIPIOS.shp tiene coordenadas 

que coinciden con la ubicación de la zona 15 UTM norte (si fuese la zona 16 

UTM norte, la coordenada de la izquierda empezaría en valores menores a    

500 000). 
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Figura 91. Coordenadas de una capa 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para definir la proyección de la capa se utiliza la herramienta Define 

Projection, como se muestra en la figura 92. Esta herramienta deberá utilizarse 

únicamente si la proyección no está definida (como en este caso), pero si se 

conoce su fuente. 

 

Figura 92. Ruta de acceso para llegar a Define Projection de  

                                 ArcToolBox 

 

 

 

Fuente: elaboración propia, utilizando ArcToolbox. 
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Una vez abierta la ventana de esta herramienta se selecciona la capa y se 

le establece la proyección correspondiente por medio del botón Spatial 

Reference Properties que se representa con el ícono . Luego se elige 

Select…> Projected Coordinate Systems> UTM> WGS 1984> WGS 1984 UTM 

Zone15N.prj. 

 

Al finalizar este procedimiento, se verifica en las propiedades de la capa y 

el resultado es como se observa en la figura 93, si se utiliza el explorador de 

Windows debe verificarse que se haya creado un archivo con extensión .prj con 

el mismo nombre de la capa proyectada. 

 

Figura 93. Capa con proyección definida 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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 Ejercicio 3 

 

o Objetivo: crear proyección GTM. 

 

Debido a que la proyección GTM no está incluida dentro de los sistemas 

de coordenadas predefinidos de ArcGis, es necesario agregarla manualmente 

siguiendo los pasos que a continuación se presentan. Aunque esta no es la 

única opción que existe, se consideró la más adecuada por su fácil 

comprensión. 

 

Figura 94. Cambio de parámetros de sistemas de coordenadas 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Se utilizará una capa que haya sido previamente proyectada, para este 

caso MUNICIPIOS.shp, luego se abrirá la herramienta Project del ArcToolBox, 

se selecciona la capa y se le establece la proyección correspondiente por medio 

del botón Spatial Reference Properties que se representa con el ícono . 

Luego se elige Select…> Projected Coordinate Systems> UTM> WGS 1984> 

WGS 1984 UTM Zone15N.prj> Add> Modify> Cambio de parámetros como se 

observa en la figura 94, (Central_Meridian -90.5 y Scale_Factor 0.9998)> 
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Aceptar> Save as…> navegar hasta encontrar la carpeta Coordinate Systems> 

ingresar y crear una nueva carpeta con el nombre GTM> ingresar y guardar el 

archivo como gtm.prj.  

 

La importancia de guardar gtm.prj en la carpeta Coordinate Systems 

radica en que cuando en el futuro se lleve a cabo un cambio de proyecciones a 

GTM, será fácil encontrarla, pues cuando se hace este procedimiento por medio 

de la herramienta Project, el programa ubica la carpeta que contiene las 

referencias espaciales, de lo contrario, el usuario tendría que navegar hasta 

encontrar la ubicación de gtm.prj. 

 

 Ejercicio 4 

 

o Objetivo: cambiar el sistema de proyección de una capa a otro 

sistema. 

 

Se tiene una capa proyectada en UTM zona 15 norte y se desea cambiar 

esta información a GTM, pues se está trabajando únicamente en este sistema. 

Para realizar este ejercicio, se utilizará de nuevo MUNICIPIOS.shp que se 

referenció en el ejercicio 2 de la presente práctica.   

 

Para cambiar la proyección de la capa, se utiliza la herramienta Project. 

Esta herramienta se utilizará cuando la capa tiene información de proyección, 

pero no es la proyección requerida o cuando la capa no tiene información de 

proyección y se sabe que está en un sistema diferente al requerido. 

 

Una vez abierta la ventana de esta herramienta se selecciona la capa y en 

el Output Dataset se le coloca el nombre deseado, en este caso 

MUNICIPIOS_GTM.shp. En Output Coordinate System, se colocará el sistema 
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de referencia, por medio del botón Spatial Reference representado por el ícono

. Luego se elige Select…> GTM> GTM.prj. Una vez terminado este 

proceso, se tendrá una nueva capa proyectada en GTM y la anterior quedará 

sin alterarse, y se tendrá un resultado como se muestra en la figura 95.  

 

Figura 95. Municipios de Guatemala proyectados en zona 15 norte UTM  

 y en GTM 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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5.7. Diseño gráfico básico de un mapa 

 

La presente práctica aporta conocimientos relacionados con el uso de 

ArcGis 9.1 en cuanto a la presentación de la información analizada para que 

pueda ser interpretada por el usuario final por medio de la creación de mapas 

temáticos.  

 

5.7.1. Descripción de la práctica 

 

Se solicita que se realice un mapa temático que describa la distribución de 

los municipios del departamento de Guatemala, agregando paso a paso los 

elementos básicos que deben incorporarse en un mapa, según lo descrito en el 

capítulo 4.7. Se requiere: 

 

 Configurar el tamaño de la hoja y los márgenes 

 Insertar título 

 Insertar leyenda 

 Insertar orientación 

 Insertar escala gráfica y numérica 

 Insertar cajetín 

 Colocar Grid o malla de coordenadas 

 Realizar un Template 

 Convertir el mapa a formato PDF 

 

5.7.2. Barras, comandos y herramientas 

 

Los comandos y herramientas a utilizar se describen en la tabla XXXII, 

ninguno de estos fue detallado en las prácticas anteriores con el fin de no 

duplicar información. En la presente práctica no se utilizarán barras nuevas. 
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Tabla XXXII.     Comandos y herramientas a utilizar en diseño gráfico 

                              básico de un mapa 

 

Comandos / herramientas Ruta de acceso 

Data Frame Menú Insert> Data Frame 

Legend Menú Insert> Legend 

North Arrow Menú Insert> North Arrow 

Picture Menú Insert> Picture 

Scale Bar Menú Insert> Scale Bar 

Scale Text Menú Insert> Scale Text 

Template Save as… 

Text Menú Insert> Text 

Title Menú Insert> Title 
 

Fuente: elaboración propia. 

 

5.7.3. Capas 

 

La información que se utilizará para realizar la presente práctica se 

describe en la tabla XXXIII y puede descargarse en la página 

http://ejerciciosgis.weebly.com > Práctica 6: practica6.zip > Capas. 

 

Tabla XXXIII.      Capas a utilizar en diseño gráfico básico de un mapa 

 

Capa Descripción 

 escudo_civil.jpg 
Escudo de la Escuela de Ingeniería 

Civil 

 escudo_ingenieria.jpg Escudo de la Facultad de Ingeniería 

 escudo_usac.jpg 
Escudo de la Universidad de San 

Carlos de Guatemala 

 DEPTOS_GTM.shp 
Distribución de departamentos de la 

República de Guatemala 

 MUNICIPIOS_GTM.shp 
Distribución de municipios del 
Departamento de Guatemala 

 

Fuente: elaboración propia. 

http://ejerciciosgis.weebly.com/
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5.7.4. Solución 

 

Se insertarán los elementos básicos de un mapa temático para que el 

usuario final obtenga la información que necesita, para comprender lo que se 

describe en el mapa. Es fundamental crear plantillas y exportar mapas a 

distintos formatos de imagen y PDF. 

 

 Objetivo: configurar el tamaño de la hoja y los márgenes. 

 

Previo a diseñar el mapa, es necesario realizar las configuraciones 

relacionadas de la hoja en la que se imprimirá posteriormente. Para ingresar a 

Page and Print Setup, se hace por medio del Menú File, como se observa en la 

figura 96. 

 

Figura 96. Page and Print Setup 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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En Paper se elige el tamaño, la fuente y la orientación del papel. En Map 

Page Size se describen las medidas estándar para el tipo de hoja que se 

utilizará para imprimir. Como se observa en la figura 96, el CheckBox: Use 

Printer Paper Settings, indica utilizar o no la configuración del papel de la 

impresora, en este caso no está elegido, para que el proyecto pueda ser 

impreso en otra impresora, o si fuese el caso, en un Plotter. 

 

 Objetivo: insertar título al mapa. 

 

Para insertar el título se hará por medio de Title, al seleccionar este 

comando aparecerá un pequeño cuadro en la parte central superior del mapa 

en el que se escribirá lo siguiente: Distribución de municipios del departamento 

de Guatemala. Al terminar se presiona Enter en el teclado o se da clic en 

cualquier parte del mapa.  

 

Para cambiar las propiedades del título, se hace dándole doble clic o clic  

derecho sobre él, seleccionando Properties. En el cuadro de diálogo que 

aparece se pueden hacer modificaciones, como se muestra en la figura 97. 

Para cambiar el tipo y propiedades de la fuente se da clic en el cuadro About 

Formatting Text y ahí se describe el código para cada modificación deseada.  
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Figura 97. Ventana de propiedades del título del mapa 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Objetivo: insertar la leyenda al mapa. 

 

Previo a insertar la leyenda se preparará MUNICIPIOS_GTM.shp. Para 

cambiar el nombre de la capa se dará clic sobre el nombre de la capa en la 

Tabla de Contenidos y se cambia por Municipios, esto no afectará la base de 

datos. Luego se aplicará simbología a la capa agregando todos los valores del 

campo MUNICIPIOS. Es importante que la opción <all other values> esté 

desactivada; para desactivarla se da clic en el Check Box que tiene al lado 

izquierdo. La importancia de modificar datos desde la pestaña simbología de las 

propiedades de la capa se muestra en la figura 98. Debajo de <all other values> 

se lee Municipios, se dará clic sobre ese nombre y se borrará con fines 

estéticos en el momento de insertar la leyenda en el mapa. 
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Figura 98. Vista de leyenda del mapa 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para insertar la leyenda en el mapa se hará por medio de Legend, y 

aparecerá una ventana asistente denominada Legend Wizard, que se muestra 

en la figura 99. En el ListBox de nombre Map Layers, se mostrarán todas las 

capas que están en la Tabla de Contenidos, para seleccionar la capa se hace 

por medio de un clic, en este caso MUNICIPIOS_GTM.shp y al presionar el 

botón “>”, la capa aparecerá en Legend Items. Si se quisiera agregar más 

capas se realiza el mismo procedimiento. 

 

 

 

 

 

 

 

 



205 
 

Figura 99. Selección de capas a colocar en la leyenda por medio de  

     Legend Wizard 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Set the number of colums in your legend se refiere a la cantidad de 

columnas en que irá distribuida la leyenda, para el presente ejemplo se elegirán 

dos, como se muestra en la figura 99; elegir el número de columnas dependerá 

del espacio que tenga en el mapa para colocarla y de las preferencias del 

diseñador cartográfico. Al terminar las elecciones en este cuadro del asistente 

se dará clic en Siguiente. 

 

El siguiente cuadro del asistente es referente al título de la leyenda, al que 

se le colocará Simbología. Luego de escribir el título se le podrán configurar, si 

se desea, las propiedades del texto, como color, tamaño, tipo, estilo y 

justificación. Una vez realizadas las modificaciones correspondientes se dará 

clic en el botón Siguiente. 
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Figura 100. Selección de las propiedades del cuadro de la leyenda 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

En la próxima opción, que se muestra en la figura 100, se podrá configurar 

el borde, relleno y sombra del cuadro en el que irá inserta la leyenda. Una vez 

realizadas las modificaciones deseadas se dará clic en el botón Siguiente.  

 

Luego se permite cambiar el tamaño del cuadro (en el caso de shapes de 

polígonos) que acompaña la simbología de cada polígono y el espacio entre 

cada elemento. Para concluir la configuración de lo relacionado a la leyenda se 

da clic en el botón Finalizar. 
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En caso que se desee hacer algún cambio a la leyenda ya inserta en el 

mapa, se dará sobre clic sobre el cuadro donde está contenida para modificar 

sus propiedades.  

 

 Objetivo: insertar la orientación (norte) al mapa. 

 

Para ingresar el Norte se hará por medio de North Arrow. Al desplegarse 

el cuadro de diálogo North Arrow Selector, que se muestra en la figura 101, se 

dará clic sobre la elegida y luego Ok. Una vez colocada en el mapa se podrá 

mover hacia la posición que se desee. 

 

Figura 101. North Arrow Selector 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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 Objetivo: insertar escala gráfica y numérica al mapa. 

 

Para ingresar la escala gráfica y numérica se hará por medio de Scale Bar 

y Scale Text, respectivamente. Al desplegarse la ventana de cada una, que se 

muestran en la figura 102, se dará clic sobre la elegida y luego Ok. Una vez 

colocada en el mapa se podrá mover hacia la posición que se desee. Para 

hacer un cambio en la escala se hace por medio de Map Scale de la barra 

Standar, ingresando manualmente la escala. 

 

Figura 102. Ventanas Scale Bar Selector y Scale Text Selector 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

 Objetivo: insertar un cajetín que describa la información de quien realizó 

el mapa al mismo. 

 

Para insertar una imagen se hace por medio Image, se elegirá 

escudo_usac.jpg, escudo_ingenieria.jpg y escudo_civil.jpg. Las imágenes se 

ajustan al tamaño que tienen destinado dentro del cajetín. 
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 Objetivo: insertar Grid o malla de coordenadas al mapa. 

 

Para colocar una malla de coordenadas se dará clic derecho sobre el Data 

Frame que contiene el mapa> Properties> Pestaña Grids> New Grid. Aparece 

una nueva ventana denominada Grids and Graticules Wizard, como se observa 

en la figura 103.  

 

Figura 103. Ventana Grids and Graticules Wizard 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Este asistente permite crear fácilmente: 

 

o Graticule (Geográfica): esta opción divide el mapa en meridianos 

(líneas de longitud) y paralelos (líneas de latitud), es una 

cuadrícula no constante. 
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o Measured Grid (Proyección): se crea una cuadrícula perfecta que 

divide el mapa.  

 

o Reference Grid (Arbitraria): es conocida como índice de grilla o 

referencia y divide el mapa en cualquier número de filas y 

columnas. 

 

Cuando se ingresa por primera vez al asistente, se elegirá entre los tres 

tipos, en este caso se utilizará Measured Grid. Por defecto, el nombre es el tipo 

de grilla pero esta puede cambiarse por el nombre que se desee para que sea 

más fácil identificarla en la lista de la pestaña Grid en caso de que 

posteriormente se cuente con varias grillas. El nombre que se colocará es GTM, 

luego clic en el botón Siguiente.  

 

El cuadro Create a measured grid que se muestra en la figura 104, ofrece 

tres opciones de apariencia de las cuales se elegirá Grid and labels (Grilla y 

etiquetas) que como su nombre lo indica, muestra las líneas y las etiquetas de 

la grilla. Aunque los intervalos de los valores de los ejes X y Y mantienen los 

valores predeterminados que no son demasiado gruesos ni demasiado finos 

para la extensión actual del mapa, para este caso se colocará 100 000 para 

cada uno, pues se hará preferentemente en un múltiplo de la escala gráfica. Es 

importante recordar que la grilla también es interactiva y cada cambio que se 

realice se verá reflejado en el mapa. 
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Figura 104. Ventanas del asistente Measured Grid 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

En el cuadro Axes and labels se decide el estilo de los ejes y la fuente de 

la etiqueta. En el siguiente cuadro no se hacen cambios y se da clic en 

Finalizar. En las propiedades del Data Frame se da clic en Aplicar y Aceptar. El 

resultado es como se muestra en la figura 105.  
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Figura 105. Grilla inserta en un mapa 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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Figura 106. Procedimiento para cambiar el número de decimales en las  

                         etiquetas de la grilla 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

En el Data Frame, se observará que las etiquetas de la grilla del mapa 

tienen seis decimales, si se desea quitarlos se sigue el siguiente procedimiento: 

Ingresar a las propiedades del Data Frame> Pestaña Grids> Properties> 

Pestaña Labels> Botón Aditional Properties> Botón Number Format> Elegir 

Number of significant places = 0, como se muestra en la figura 106. La 

diferencia se muestra en la figura 107. 
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Figura 107. Diferencia entre etiquetas con y sin decimales 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para cambiar las propiedades de una grilla, se elige de la lista de la 

pestaña Grids dando clic posteriormente en el botón Properties. Ahí pueden 

cambiarse las propiedades de las marcas divisorias, las líneas, las etiquetas y 

los bordes. Este botón no está disponible si no hay ninguna grilla seleccionada 

en la lista que aparece a la izquierda. 

 

 Objetivo: realizar un Template del diseño actual del mapa. 

 

Algunas veces será necesario realizar dos o más mapas con el mismo 

diseño pero con algunas variaciones en los elementos espaciales y los atributos 

que se observan, por ejemplo índices de analfabetismo en el departamento de 

Guatemala, usos de suelo del departamento de Guatemala, entre otros. Para 

ello es útil crear una plantilla común que servirá de base para todos los mapas. 

 

Como previamente se realizó el diseño del mapa de distribución de 

municipios del departamento de Guatemala, se utilizará como plantilla para 
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futuros mapas, es decir, sin tener que colocar de nuevo todos los elementos 

básicos que debe llevar el mapa.  

 

Antes de guardar la plantilla se dejará en cada Data Frame solamente las 

capas que se necesitan para este fin, como se observa en la figura 108. Se 

eligieron estas capas pues la plantilla se utilizará únicamente para cualquier 

mapa temático que tenga como base el Departamento de Guatemala. Cabe 

mencionar que en caso la plantilla pudiera ser utilizada con información de 

cualquier departamento del país, no sería necesario dejar ninguna capa en la 

misma, o bien, removerla cuando sea necesario en el futuro. 

 

Figura 108.   Capas necesarias para la creación de una plantilla  

    específica 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Luego se dará clic en File> Save As… De nombre se le colocará 

PLANTILLA DEPTO GUATE y en tipo se elegirá ArcMap Template en vez de 

ArcMap Document. 
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Para abrir esta plantilla se abrirá un nuevo archivo en ArcMap y en vez de 

elegir un nuevo mapa en blanco se elegirá una plantilla, como se observa en la 

figura 109. En la pestaña My Templates se explora por medio del botón 

indicado hasta encontrar la ubicación de la plantilla creada previamente. 

 

Figura 109. Ruta para encontrar una plantilla creada previamente 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 

 

Para agregar nuevas capas en la plantilla establecida debe revisarse que 

estas estén en las mismas coordenadas o proyección de la grilla de la plantilla y  

que las unidades estén en metros. Cuando se esté conforme con el resultado, 

el nuevo mapa se guardará con el nombre deseado asegurando que el tipo de 

archivo es .mxd (ArcMap document) y no una plantilla nueva.  
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 Objetivo: convertir el mapa elaborado a formato PDF. 

 

En algunas ocasiones se deseará convertir el mapa a un formato distinto a 

los programas compatibles con ArcGis, en el que otros usuarios no puedan 

hacerle modificaciones o con la finalidad de utilizar el mapa para fines 

ilustrativos, para ello se selecciona del Menú File la opción Export Map. Aunque 

en este ejemplo se convertirá el archivo a PDF, cabe mencionar que no es el 

único formato que puede utilizarse, también puede convertirse en archivos de 

imagen como JPEG, GIF, TIFF, entre otros. 

 

En la ventana Export Map se coloca el nombre deseado para el archivo en 

este caso será guate_division_politica, y en tipo se elige PDF. Se presiona clic 

en Guardar y al explorar en la carpeta en la que se guardó el archivo estará 

contenido el PDF creado. El resultado final se observa en la figura 110. 
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Figura 110. Elementos básicos de un mapa temático 

 

 

 

Fuente: elaboración propia, utilizando ArcMap. 
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CONCLUSIONES 

 

 

 

1. Los Sistemas de Información Geográfica son una herramienta valiosa 

aplicada a temas relacionados con ingeniería civil, muestra de ello es la 

importancia de su uso en las distintas instituciones públicas, privadas y 

no gubernamentales de Guatemala. 

 

2. Los Sistemas de Información Geográfica son de gran utilidad en 

ordenamiento territorial pues ayudan a identificar el espacio territorial en 

función del bienestar colectivo actual y futuro, por medio de la creación 

de mapas de riesgo, amenaza y vulnerabilidad que contribuyen con la 

prevención de desastres. 

 

3. La aparición de los Sistemas de Información Geográfica ha contribuido 

en optimizar la forma en la que se realizan los análisis, logrando 

hacerse indispensables en los proyectos relacionados con medio 

ambiente y recursos naturales. 

 

4. El catastro de redes de distribución, incluidos los hidrantes, es muy útil 

para fines de seguridad y emergencia por incendios; los Sistemas de 

Información Geográfica se utilizan para la creación de áreas de 

influencia que son eficaces para encontrar la relación espacial entre dos 

elementos equidistantes, así como las acciones de unos sobre otros 

para determinar áreas comunes de interacción y, por tanto, tener 

elementos para tomar una decisión. 
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5. Para poder llevar a cabo la práctica de un software como ArcGis 9.1 y 

versiones posteriores, es fundamental que el usuario tenga bases 

teóricas de sistemas de coordenadas, datum, elipsoide de referencia, 

material cartográfico, sistemas de información y el funcionamiento 

mismo del software, para cumplir de manera más eficiente en la toma 

de decisiones. 

 

6. La página web creada para descargar la información que se necesita 

para la realización de los ejercicios, previamente descritos y resueltos 

paso a paso, ayudan a adquirir la experiencia en el manejo de ArcGis 

9.1 y versiones posteriores. 

 

7. Es importante utilizar los GeoServicios WMS pues estos permiten al 

usuario solicitar mapas o imágenes georeferenciadas a través de las 

web, recopiladas de distintas instituciones gubernamentales de 

Guatemala por medio de SEGEPLAN, para consumir información 

geográfica sin necesidad de tener una copia local en la memoria de la 

computadora. 
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RECOMENDACIONES 

 

 

 

1. Para capacitar a los estudiantes en el manejo de Sistemas de 

información geográfica y las distintas aplicaciones en la rama de 

ingeniería civil, es importante asignar un catedrático para que se 

imparta el laboratorio de Cartografía Digital dentro del programa del 

curso de Topografía 3. 

 

2. Utilizar los ejercicios realizados como base para estudios que tengan 

relación con las distintas aplicaciones en lo concerniente a ingeniería 

civil por medio del manejo adecuado de la información digital en ArcGis. 

 

3. Es necesario que instituciones como SEGEPLAN asuma la 

responsabilidad de tener actualizada la mayor cantidad de información 

digital a detalle que pueda utilizarse para realizar diversos análisis por 

medio de los GeoServicios WMS que brindan. 
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Tabla.       Usos recomendados para obtener los mejores resultados 

  con las ortofotos básicas y ortofotos verdaderas 

 

Usos recomendados 1º orden 
2º 

orden 
3º 

orden 
4º orden 

Catastro Urbano (precisiones 
planimétricas superiores a 3mm X 

Escala mapa ) 
X - - - 

Estudios de distribución espacial 
detallados en zonas urbanas 

X - - - 

Análisis de redes urbanas X X - - 

Catastro Rural X X - - 

Catastro Urbano (precisiones 
planimétricas superiores a 5mm X 

Escala mapa) 
X X - - 

Control de calidad de la cartografía 
vectorial (Grado de totalidad y 

consistencia temática) 
X X - - 

Obras civiles X X - - 

Servicios públicos X X - - 

Sistemas de información 
Geográfica 

X X - - 

Vías X X - - 

Actualización de cartografía 
temática 

X X X - 

Agrología X X X - 

Cuencas hidrográficas X X X - 

Distritos de riego X X X - 

Estudios Geográficos X X X - 

Geolocalización X X X - 

Mapas de ruta X X X - 

Planeación territorial X X X - 

Planeación y gestión municipal X X X - 

Turismo X X X - 

Uso y cobertura vegetal X X X - 

Arqueología X X X X 

Comprobación de nuevos 
desarrollos urbanos 

X X X X 

Estudios Agroforestales X X X X 

Hidrología X X X X 
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Continuación de la tabla. 

Inundaciones X X X X 

Medio ambiente X X X X 

Mercadeo X X X X 

Recreación X X X X 

Visualización del paisaje X X X X 

Zonas homogéneas X X X X 
 

Fuente: http://www.cartesia.org/article.php?sid=409. Consulta: 20 de abril de 2012. 

 

 

1. Listado de procedimientos de la dirección general de minería en 

     Guatemala 

 

A. Departamento de Derechos Mineros 

B. Departamento de Desarrollo Minero 

C. Departamento de Gestión Legal 

D. Departamento de Control Minero 

E. Aplicación General 

 

En lo referente a Sistemas de Información Geográfica solamente se tiene 

influencia en el Departamento de Derechos Mineros y los procedimientos que 

ahí se realizan se detallan a continuación. 

 

Departamento de Derechos Mineros 

 

Elaboración de mapa geográfico geológico-minero 

 

Propósito: el mapa geográfico geológico minero permite contar con un criterio 

para definir el inventario de los recursos minerales del país. Las autoridades del 

Ejecutivo, o bien del Legislativo, obtienen de estos mapas una visión del estado 

http://www.cartesia.org/article.php?sid=409
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actual de la minería a nivel nacional o regional. Es un instrumento de toma de 

decisiones. 

 

Alcance: autoridades de distintos ministerios, especialmente del MEM y del 

MARN, alcaldes municipales, diputados al Congreso, jueces municipales, el 

MP, universidades y otros, solicitan mapas geográficos geológico-mineros para 

conocer y evaluar el estado actual de la minería local o a nivel nacional. Desde 

el ingreso de la solicitud al Despacho de la Dirección General de Minería hasta 

el envío de los mapas solicitado, conforma el alcance de este procedimiento. 

 

Responsabilidades: los técnicos de las secciones SIG y de Catastro son 

responsables de la parte técnica y elaboración del mapa correcto con toda la 

información requerida incorporada. 

 

Descripción del procedimiento: 

 

El Despacho de la DGM recibe solicitud de elaboración de un mapa geográfico 

geológico-minero, de otros ministerios, de la Presidencia, del Congreso de la 

República, ONGs, Ministerio Público, embajadas acreditadas en el país etc. 

 

1. Traslado de la solicitud al DDM, donde se analiza la solicitud y se 

solicita la elaboración del mapa al área SIG. 

 

2. El encargado del área SIG diseña el mapa determinando tamaño de 

hojas, distribución de los objetos como los polígonos mineros, cajetín, 

símbolo del norte y escala, tamaños relativos, nivel del detalle, mapa 

base etc., con el objeto que sea comprensible para quienes lo utilicen. 
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3. Habilita los shapes o capas SIG que se van a utilizar para confeccionar 

el mapa requerido. 

 

4. Se despliegan las capas SIG en pantalla para elaborar el mapa según 

requerimientos, haciéndose una presentación práctica y profesional. Se 

etiqueta con tamaño y colores según la escala utilizada para visualizar 

adecuadamente los objetos. Se abren las tres capas de licencias de 

exploración, explotación y reconocimiento, así como las capas con las 

solicitudes, y capas de áreas protegidas, áreas especiales como las que 

se encuentran bajo jurisdicción de AMSA, Conred o Amasurli, capa de 

ríos y capa con la división política-administrativa etc. 

 

5. Según requerimientos y para lograr la comprensión del mapa, se 

incluyen tablas de atributos con los campos activados y referenciados a 

los objetos del mapa. Impresión del mapa. 

 

6. Se entrega al Jefe del Departamento para revisión. Si cumple con los 

requerimientos, se envía al Director para que disponga a discreción y 

finaliza el procedimiento. 

 

7. Si se necesita modificar la información, se regresa el mapa con las 

observaciones al técnico SIG par un nuevo diseño o enmiendas y 

confección del mapa. Esto se debe a que sólo viendo el producto final 

se detectan oportunidades de mejora en la presentación de los mapas. 

 

Inspección de campo para solicitudes de explotación o ampliación de área 

 

Procedimiento: inspección de campo para solicitudes de explotación o de 

ampliación de área. 
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Propósito: verificar los extremos de la solicitud en aspectos técnicos de campo 

para evaluar la viabilidad del proyecto minero, durante la fase del trámite de la 

solicitud previo al otorgamiento de la licencia, como indicado en el Artículo 44 

de la Ley de Minería. 

 

Alcance: este procedimiento es aplicable desde el ingreso de la solicitud de 

licencia minera de explotación, o de ampliación de área, hasta el dictamen del 

DDM que aprueba o desaprueba la solicitud en materia técnica relacionada con 

aspectos del área afecta correspondiente. 

 

Responsabilidades: el técnico que realiza la inspección de campo es el 

responsable de confirmar el cumplimiento de las características del área afecta 

con respeto a la normativa minera y ambiental. 

 

Descripción del procedimiento: 

 

1. El expediente ingresa al DDM proveniente de la DGL. Corresponde 

realizar una inspección de campo como indicado en el artículo 44 de la 

Ley de Minería. Es una solicitud de licencia de explotación, o es una 

licencia de explotación donde solicitan ampliación de área. 

 

2. Se registra en la BD del DDM para control del ingreso y egreso de 

expedientes y se firma el libro de traslado del DGL, así como el último 

folio del expediente con fecha y hora y anotando número de folios. Se 

traslada a la Sección de Supervisión. 

 

3. Análisis de expediente para determinar si corresponde efectuar 

inspección y cuáles son los objetivos o características particulares del 

proyecto minero a considerarse. 
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4. Se estima kilometrajes para programa de gastos de combustible y 

viáticos y el itinerario. 

 

5. El jefe del departamento firma los viáticos anticipo y traslado de papelería 

al despacho de la DGM para firma del nombramiento.  

 

6. Se traslada la papelería al Departamento Financiero para elaboración del 

cheque de la comisión y que se entreguen los viáticos constancia. 

 

7. Se accede al área minera para efectuar la inspección. 

 

8. Es opcional contactar previamente al interesado para que acompañe 

durante la inspección. A veces es necesario para facilitar el ingreso a 

propiedad privada. Otras veces es conveniente que la comunidad 

reconozca a alguien dentro del equipo realizando a la inspección, para 

no crear un ambiente de desconfianza. Asimismo, los potenciales frentes 

de explotación ya deben estar localizados y es conveniente acceder 

directamente a ellos o al menos al más significativo y no convertir la 

inspección en una actividad de exploración. Sin embargo, las 

inspecciones sorpresa pueden ser una opción en la mayoría de casos, o 

el frente de explotación es fácilmente localizable. 

 

9. El CMN utiliza coordenadas UTM y el Datum Norteamericano de 1927. 

Las coordenadas UTM son obligatorias por la Ley de Minería, artículo 29. 

El NAD27 no es obligatorio pero se recomienda utilizar Este datum para 

la presentación de polígonos mineros. El sistema de posicionamiento 

global o gps debe operarse en NAD27 central. 

 



235 
 

10. Se accede al menos a un afloramiento o un potencial frente de 

explotación. Por logística, no es recomendable realizar la inspección 

inmediatamente al ser ingresada una solicitud. Se espera a que varias 

solicitudes de una misma región ingresen, para ser cubiertas durante una 

misma inspección o gira de campo, para lo cual es necesario esperar 

hasta seis meses, al menos que el interesado le sea urgente la 

realización de la inspección, en cuyo caso se buscan opciones. 

 

11. Se toman muestras gps para georeferenciación y así determinar su 

localización dentro del perímetro del polígono minero solicitado, 

cumpliendo así con el Artículo 44. 

 

12. Se toman fotografías para posteriores referencias. Se toman muestras 

para ser analizadas en el laboratorio técnico cuando se considere 

conveniente. Se recomienda contar con análisis de laboratorio 

especialmente cuando se trata de proyectos mineros para minerales 

metálicos.  

 

13. En el artículo 53 de la Ley de Minería, literal c), se indica que es causal 

de caducidad disponer de minerales sin la autorización de la DGM. Es 

por tanto indispensable definir con exactitud cuales minerales serán 

objeto del proyecto minero. El término minerales abarca también rocas 

y productos mineros (nombres comerciales), pero debe evitarse 

definitivamente los nombres genéricos y considerar los criterios de la 

SAT en el tema de minerales para exportación. 

 

14. En la resolución del otorgamiento de la licencia de explotación se 

incluye el plazo para el derecho minero. Este plazo es en parte función 
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de las reservas y recursos del yacimiento, por tanto, el potencial minero 

puede servir para aceptar o no el plazo solicitado por el interesado. 

 

15. Cuando una solicitud se localiza en un lugar que causa impacto 

ambiental significativo inminente, es necesario hacerlo del conocimiento 

al interesado y que quede registrado en las actuaciones dentro del 

expediente. Una explotación de arena abajo de un puente es de riesgo 

y seguramente el interesado puede retirarse 100 metros o más para 

evitar posibles daños a las bases del puente. Una operación minera a 

un lado de viviendas, iglesias, infraestructura eléctrica, entre otros debe 

evitarse. No puede ubicarse una operación minera cerca de un lugar 

recreativo o de nacimientos de agua. 

 

16. Regreso a la oficina. 

 

17. Elaborar informe técnico con opinión técnica recomendando la 

viabilidad del proyecto. Se indica si el frente de explotación se 

encuentra dentro de los límites territoriales del área solicitada, el 

nombre correcto de los minerales objeto de la explotación y el plazo 

adecuado para el otorgamiento de la licencia. Se entrega el formulario 

del vl y se adjunta el vc. Se traslada esta papelería para firma del jefe 

del DDM. 

 

18. Jefe del departamento firma el informe de la inspección. 

 

19. Se elabora el dictamen del DDM para anexarlo al expediente 

incorporando la opinión técnica del informe de inspección. 

 

20. Traslado del expediente al DGL. 
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Análisis catastral 

 

Procedimiento: análisis catastral. 

 

Propósito: actualizar el Catastro Minero Nacional. 

 

Alcance: mantener en el CMN los polígonos de todas las solicitudes de licencia 

minera que se encuentran en trámite, i.e. desde su ingreso hasta su 

otorgamiento o rechazo, así como de todas las licencias mineras vigentes, i.e. 

desde el otorgamiento hasta que sean caducadas o extingan. 

 

Responsabilidades: el Jefe del área de Catastro es el responsable directo. 

 

Procedimientos: 

 

1. Ingreso del expediente proveniente del Departamento de Gestión Legal. 

 

2. Registro del expediente en la BD del Departamento. 

 

3. Traslado al área de Catastro para análisis y evaluación del estado actual 

del trámite. 

 

4. Se ingresan las coordenadas del polígono minero que corresponde al 

expediente. 

 

5. Determinar si las coordenadas vienen definidas en la proyección 

geográfica UTM tal como lo indica el artículo 29 de la Ley de Minería. 

Debe ubicarse sobre las cuadrículas UTM 15P y 16P, i.e. sobre las 

zonas (husos) 15 y 16 y sobre la zona P. Las coordenadas deben estar 
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definidas en el sistema de coordenadas UTM recomendablemente en 

NAD27. 

 

6. Se abren las capas de solicitudes y licencias para determinar traslapes 

entre polígonos. 

 

7. Se abre la capa de áreas protegidas que es brindada por el CONAP, 

para verificar traslapes con áreas protegidas. 

 

8. Se calcula la extensión del polígono minero en el sistema métrico como 

lo indica el artículo 6 del Reglamento a la Ley de Minería, y que los lados 

estén orientados norte -sur. 

 

9. Se abre la capa política para determinar sobre cuales municipios tendrá 

influencia el proyecto minero, de acuerdo a la extensión territorial del 

polígono minero presentado. 

 

10. Se elabora el dictamen catastral con la información recabada en los 

pasos anteriores. 

 

11. Se traslada al Jefe para revisión y firma, con lo cual se tiene el dictamen 

catastral elaborado, firmado e incorporado al expediente, por tanto, se 

termina con el presente procedimiento. 
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2. Servicio Geográfico Militar 

 

Derivado del proceso de reestructuración y reorganización que viene 

realizando el Ejército de Guatemala, y tomando en cuenta el objeto, fines y 

atribuciones que desarrolla esta Dependencia Militar, el alto Mando del Ejército 

de Guatemala, determina procedente transformar su denominación de 

Departamento, a la categoría de Servicio, y en Acuerdo Gubernativo No. 621-

2003, acuerda que con fecha 31 de julio de 2003, se transforma la 

denominación del Departamento Geográfico Militar, por el de: Servicio 

Geográfico Militar, canalizando todo lo relativo a sus funciones y para el 

cumplimiento de su misión, a través de la Jefatura del Estado Mayor de la 

Defensa Nacional, debiendo reformar su reglamento contenido en Acuerdo 

Gubernativo No. 439-99 de fecha 25 de junio de 1999.  

 

Actividades relevantes con instituciones del estado y privadas: 

 

 Se genera información con las Brigadas de Campo que permita elaborar 

mapas de riesgo orientados en la prevención y reducción de desastres 

naturales, para facilitar el enlace con CONRED, en la anticipación de 

tales acontecimientos, proyectados a beneficiar a la población y a 

nuestro país.  

 

 Se mantiene estrecha comunicación con otras instituciones de Gobierno, 

como: La Coordinadora Nacional para la Reducción de Desastres 

(CONRED), Instituto Nacional de Estadística (INE), Instituto Nacional de 

Sismología, Vulcanología, Meteorología e Hidrología (INSIVUMEH), 

Aeronáutica Civil, Instituto Geográfico Nacional (IGN), Ministerio de 

Agricultura, Ganadería y Alimentación (MAGA), Universidades de la 

ciudad capital y Municipalidad de Guatemala, para intercambiar 
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experiencias e información por medio de convenios de cooperación, en 

apoyo del avance tecnológico de la cartografía de nuestro país.  

 

 Se promueve la celebración de Acuerdos y Convenios de Cooperación 

con Instituciones que tienen relación con la ciencia cartográfica a fin de 

contribuir al esfuerzo integral de la Nación y desarrollo de la misma.  

 

 Se coopera con las unidades de ayuda humanitaria, en los ejercicios 

nacionales e internacionales en la prevención y reducción de desastres 

naturales, antropogénicos y epidemiológicos, a fin de proteger la vida 

humana y mitigar los efectos del fenómeno. 

 

Actividades relevantes del servicio geográfico militar Sección Operacional:  

 

Encargada de elaborar los diferentes programas y planes de trabajo, a corto, 

mediano y largo plazo y velar su fiel cumplimiento, de acuerdo a las funciones 

de sus diferentes negociados, que se mencionan a continuación:  

 

 Negociado de catastro: evalúa, planifica y desarrolla estudios catastrales 

y registrales de las propiedades que se encuentran bajo responsabilidad 

del Ministerio de la Defensa Nacional. 

 

 Negociado de inteligencia cartográfica sobre el terreno: evaluar, analizar 

y estudiar los diferentes objetivos de interés que se encuentran sobre la 

superficie del terreno en toda la república, para tener una mejor visión de 

estos y elaborar posteriormente los respectivos álbumes, como 

complemento para coadyuvar con el negociado de S.I.G. para la 

elaboración del mapa serie militar de los 259 cuadrángulos a escala    

1:50 000. 
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 Negociado de brigadas de campo: realizar el trabajo de campo, 

actualizando todos los objetivos que son de interés nacional y militar de 

los 259 mapas topográficos a escala 1:50 000 del país y generar la base 

de datos digital para la elaboración del mapa serie militar para uso del 

Ejército de Guatemala. 

 

 Negociado de sistemas de información geográfica: recibir el trabajo 

realizado por las brigadas de campo y elaborar el mapa escala 1:50 000 

serie militar en formato digital, a través del programa ArcView y ArcGis, 

con la secuencia de pasos siguientes: 

 

o Ingresar un mapa civil base (imagen satelital o escaneada). 

o Recibir el trabajo de clasificación de campo que realiza el 

negociado de "brigadas de campo"  

o Proceso de gabinete (revisión y corrección). 

o Incorporación de los datos militares en el programa de ArcView y 

ArcGis (geoposicionados en campo por el sistema GPS). 

o Elaboración de la base de datos (cuadro informativo). 

o Reproducción de los mapas militares digitales.  

o Almacenamiento y distribución a requerimiento de los comandos 

militares. 

 

Asimismo, el negociado de SIG, elabora mapas temáticos que se 

procesan a requerimiento con información de los comandos y dependencias 

militares, muchos de ellos son utilizados por este servicio en apoyo para la toma 

de decisiones del Alto Mando del Ejército. 

. 

 

 




